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1Getting Started
Before You Begin 

Before installing Crystal Reports, you must have Microsoft Windows, Version 
3.1 or higher, Windows for Workgroups, or Windows 95 installed on your com-
puter. Consult the Microsoft User’s Guide for instructions on installing these 
programs.

Use the DOS DISKCOPY command to make a copy of the original Crystal 
Reports disks (see your DOS manual for instructions). Store your original disks 
in a safe place and use the copies to install the program.
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Installing Crystal Reports

Follow the procedure below to install Crystal Reports.

Step Action 

1. Insert the Crystal Reports Program disk in the appropriate floppy disk 
drive.

2. Make certain that the Windows Program Manager is active. When it is, 
select the File menu, and then select the Run command from that 
menu. 

" In Windows 95, use the Taskbar/Start/Run  option.

3. When the Run dialog box appears, type the following: A:SETUP (if 
your Crystal Reports Program disk is in drive A:) or B:SETUP (if your 
Crystal Reports Program disk is in drive B:). 

4. Select OK or press ENTER to call up the Crystal Reports installation 
program. The Installation Options dialog box appears.

During the install procedure, you will be given the choice to have the Setup pro-
gram do an Automatic installation or a Custom installation. If you select Auto-
matic, Setup installs all of the Crystal Reports files to your hard drive. If you 
select Custom installation you will be given the opportunity to select which 
components of the Crystal Reports application files are installed on your sys-
tem.
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Upgrading from a Previous Version

If you are upgrading to Crystal Reports 4.5 from a previous version (3.0, 4.0, 
Crystal Reports for Visual Basic, etc.), the installation routine ensures that 
there will be no conflict between different versions of the program running on 
the same machine. When it finds a previous version of Crystal Reports on your 
system, the Setup application:

� Installs Crystal Reports 4.5 to the directory you specify.

� Installs the new CRPE.DLL into the WINDOWS\SYSTEM directory.

� Installs the PD*.DLLs, VX*.DLLs, and several other DLL files required by 
Crystal Reports into the Windows\Crystal directory.

� Finds any previous versions of these DLLs and moves them to the \Win-
dows\Crystal directory and changes their extensions from *.DLL to *.old. If, 
for some reason, you need to use the older versions of the files later on, 
you only need to rename them with the original .DLL extension.

� Installs any common third party DLLs such as CTL3DV2.DLL or WBTR-
CALL.DLL to the WINDOWS\SYSTEM directory.

This upgrade procedure makes it unnecessary to change your 
AUTOEXEC.BAT file.
User’s Guide 8
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Installing on a Network Workstation

If you are operating a network workstation that runs Windows locally, and Crys-
tal Reports is already installed on your network, you do not need to install Crys-
tal Reports to your workstation. Instead, you must run the workstation setup 
application that was installed with Crystal Reports.

Workstation setup (SETUP.EXE) is installed in the CRW\WKCSETUP directory 
on the network drive on which Crystal Reports was installed. Follow the proce-
dure below to set up your workstation.

Step Action

1. From Program Manager, Select File/Run . 

Response : The Run dialog box appears.

2. In the Run dialog box, select the drive and directory in which Worksta-
tion setup resides and run the SETUP.EXE application. 

" In Windows 95, use the Taskbar/Start/Run  option.

3. Follow the directions on screen to set up your workstation.

Workstation setup configures your workstation and copies several files to your 
local drive. When Workstation setup is finished, you can access Crystal 
Reports as you would any other application on your network.  

" If you are installing Crystal Reports on a stand alone machine, you may 
want to perform a custom installation instead of a complete installation. A 
complete installation will install the Workstation install files which are not 
needed for a stand alone machine. These files will take up 5790K of mem-
ory. If you convert to a workstation at a later time, you can once again per-
form a custom installation and install only the Workstation install files.
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Starting Crystal Reports

Before you start Crystal Reports 4.5 for the first time, be sure to open and 
review the Readme Help file. This Help file contains important information 
about running Crystal Reports in certain environments, distributing applications 
that access the Crystal Reports Print Engine, the most recent updates or 
changes to the Crystal Reports documentation, and many more items of inter-
est important to running the application successfully.

To start Crystal Reports from Windows, select the group window that holds the 
Crystal Reports icon.

� If you’re using a mouse, double-click the Crystal Reports icon to start the 
program.

� If you’re using the keyboard, use the arrow keys to select the icon and then 
press ENTER.

You can also start Crystal Reports from within Windows by double-clicking on 
the file name CRW.EXE in the File Manager (Explorer in Windows 95).

Configuring Crystal Reports to work like you do

Crystal Reports lets you customize many of the program’s default settings to fit 
the way you work. These settings can affect:

� Your working environment

� The way you select databases

� SQL and ODBC access

� The way various data types are formatted

� The fonts you use for fields and text.

To change your default settings, select File/Options  and the Options dialog 
box appears. Then you can select the tab appropriate to the option you want to 
change, as in the examples below. With the options feature these changes are 
easy to make.
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Configuration examples

When configuring Crystal Reports you may want to specify the default data 
directory that is used when creating new reports, and what kinds of databases 
will be listed in the Choose Database File dialog box whenever it appears. For 
complete descriptions of all configuration options, search for File Options com-
mand in Crystal Reports Help.

Specifying a default data directory

Follow the procedure below to specify a default data directory.

Step Action

1. Select the Database tab in the Options dialog box. 

Response : Database options appear.

2. Specify your default directory using one of the following methods:

� Type the full path in the Data Directory box (C:\CRW for example)

� Click the Browse button, make your selection using the Set Direc-
tory box when it appears. 

3. Click OK when finished to return to Database options.

Specifying databases in the Choose Database File dialog 

When you specify the kinds of databases to be listed in the Choose Database 
File dialog box, you limit the kinds of files listed. You may choose to do this 
when you are only working with one or two kinds of databases and you want 
only those kinds to be available in the File Name scroll box. Follow the proce-
dure below to specify the kinds of databases listed in the Choose Database 
File dialog.

Step Action

1. Select the Database tab in the Options dialog box. 

Response : Database options appear.
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2. In the Database Selector edit box, type in the filename extensions for 
the kinds of databases you want listed in the Choose Database File 
dialog box. 

3. Click OK when finished to return to Database options.

" When entering filename types (*.db ;*.ddf ; *.ovd , etc.) in the Data-
base Selector box you must: place an asterisk before the exten-
sion, and a semicolon between file types. 

Specifying a Data Dictionary as your primary data source

To specify a Data Dictionary as your primary data source requires you to:

� Select Crystal Dictionary as your primary data source, and then

� Select the specific dictionary you want to use as a default.

This requires you to work with two of the Option tabs: New Report  and Data-
base . Follow the procedure below to select Crystal Dictionaries as your pri-
mary data source.

Step Action

1. In the Options dialog box, select the New Report tab. 

Response : New Report options appear.

2. In the ‘Prefer to create new Reports From:’ section, select Crystal Dic-
tionaries.

3. Select the Database tab. 

Response : Database options appear.

4. In the Default Dictionary section, Click the Browse button. 

Response : The File Open dialog box appears.
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5. Select the Crystal Dictionary you wish to use as the default (pro-
samp.dct, for example) and Click OK when finished to return to Data-
base options.

6. Click OK again to return to the program.

Now, whenever you begin a new report, the program takes you directly to your 
default dictionary.

" If you deactivate the Report Gallery using the Use Report Gallery for New 
Reports switch on the New Reports tab, the program will take you directly 
to your default dictionary each time you begin a new report.

Specifying the default view when previewing your report

The default view is the view that Crystal Reports will use when you view your 
report in the Preview Window. After the report has been displayed in the 
default view, you can select a different view if necessary. Follow the procedure 
below to specify the default view used when you preview your reports.

Step Action

1. Select the Layout tab in the Options dialog box. 

Response : The Layout options appear with Preview Pages options in 
the lower left hand corner of the tab. The options are Fit Size , Fit 
Width , and Fit Page .

2. Select one of the three choices to specify the default view you want 
Crystal Reports to use when you view pages in the Preview Window.

3. Click OK to return to the program.

Now each time you view a report in the Preview Window Crystal Reports will 
start with the option you selected.
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Specifying the default fonts for each section of your report

Follow the procedure below to specify the default fonts for each section of your 
report.

Step Action

1. Select the Font tab in the Options dialog box. 

Response : Font options appear with two vertical rows of buttons; one 
row for changing Default Field Fonts, and the other row for changing 
Default Text Fonts.

2. Click the button corresponding to the section you wish to change the 
default font for. 

Response : The Font dialog box appears.

3. Select the desired font, style and point size to be used as the default, 
and Click OK when finished to return to Font options.

" For each section that you want to change the default font for, 
repeat steps 2 and 3 above.

4. Click OK again to return to the program. 

Now each time you use a Field Font or a Text Font that you changed the sec-
tion default for, the font you selected will be used in that section. All the fields 
and text you place in each section of your report will appear using the default 
fonts you specified for that section.

Specifying a SQL/ODBC Server as your primary data source

To specify a SQL/ODBC Server as your primary data source you must:

� Set the Prefer to Create new reports from SQL tables option

� Select the Server Type
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� Select the Skip Server Type Dialog

� Enter the Server Name, Database, and User ID.

This requires you to work with two of the Options tabs: New Report  and SQL. 
Follow the procedure below to specify a SQL/ODBC Server as your primary 
data source.

Step Action

1. Select the New Report tab in the Options dialog box. 

Response : New Report Options appear.

2. Select Prefer to create new reports from SQL Tables.

3. Select the SQL tab in the Options dialog box. 

Response : SQL options appear.

4. Use the Server Type drop down edit box to select the Server Type. 
Click the Server type you will be using as your primary data source. 

Response : The data source appears in the edit box.

5. Toggle the Skip Server Type Dialog checkbox on. 

Response : Now, when creating a new report from the selected server, 
the Server Type Dialog will not be shown before you log onto the 
server.

6. Position the mouse pointer inside the Server Name edit box. Click 
once, and enter the Server name.

7. Position the mouse pointer inside the Database edit box, Click once, 
and enter the Database name.

8. Position the mouse pointer inside the User ID edit box, Click once, and 
enter your User ID.

9. Click OK to return to the program.
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You can turn off Use Report Gallery for new reports after specifying a SQL/
ODBC Server as your primary data source. If you do, when you begin a new 
report you will bypass the Report Gallery and go straight to the SQL dialog box. 
To turn off Use Report Gallery, follow the procedure below:

Step Action

1. Select the New Report tab in the Options dialog box. 

Response : New Report options appear.

2. Turn off “Use Report Gallery for new reports” by Clicking on the check-
mark.

3. Click OK to return to the program.

" If the checkmark is not visible in the checkbox, Use Report Gallery 
for new reports is already off.

Now when you select File/New Report , or the New Report button on the but-
ton bar, you go straight to the login dialog box on the server you selected. 
Enter the correct user ID and password to log onto the server.

Specifying a report template as your primary data source

Follow the procedure below to specify a report template as your primary data 
source.

Step Action

1. Select the New Report tab in the Options dialog box. 

Response : New Report options appear.

2. Select Prefer to create new reports from Other Reports. 

3. Click OK to return to the program.
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Now when you select File/New Report , or the New Report button from the but-
ton bar, the Select Report Template dialog box appears, listing report tem-
plates. Select the report you want to use as a template, and Click OK to open 
the template.

Specifying formatting field default settings

The default settings will be used for formatting fields when you begin a new 
report. You can specify the default settings that you will use for most of your 
reports. Follow the procedure below to specify the default settings Crystal 
Reports uses for formatting fields.

Step Action

1. Select the Fields tab in the Options dialog box. 

Response : Field formatting options appear.

2. Select the field type you want to change formatting options for. 

Response : A dialog box appears with formatting options for the field 
type.

3. Make the changes you want to the default settings in the dialog box, 
and Click OK to return to the Options Dialog box.

" For each field type you want to change default options for, repeat 
steps 2 and 3 above.

4. Click OK to return to the program.

Sample application - printing dates in your report in a certain 
format

As an example, if you want dates in your report to be printed in the Day/Month/
Year format and you want duplicated dates not to be printed, you simply do the 
following:

1. Select the Fields tab in the Options dialog box. 

Response : Field formatting options appear.
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2. Click the Date button. 

Response : The Format Date dialog box appears with Date formatting 
options.

3. In the Use Windows Default Format checkbox, toggle the check mark 
off. 

This will enable you to set a new date format to be used in your 
reports.

4. Toggle the checkmark on in the Suppress if Duplicated checkbox. 

Response : Now, when the date on a previous line is duplicated, that 
date will not be printed.

5. Select the DMY option in the center of the dialog box. This will print 
dates with Day/Month/Year formatting, for example, 1/3/95. At the bot-
tom of the Date format box the program displays a sample of the 
selected Date format. Click OK to return to the Options dialog box.

6. Click OK to return to the program.

Now when you have Date fields in your report, they will be printed with Day/
Month/Year formatting, and duplicated dates from previous lines will not be 
printed.
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What’s New in Crystal Reports 4.5 

There are many new features in Crystal Reports 4.5. The major changes that 
have been implemented are described below.

32-bit technology and Crystal Reports

You can now run a 32-bit version of Crystal Reports under Windows NT and 
Windows 95. Most 16-bit reports can be run in the 32-bit versions of Crystal 
Reports depending on the datasource.

User interface 

To reduce screen crowding when you have multiple open reports, Crystal 
Reports uses a single dynamic window for each report. Tabs in the upper left 
hand corner of the window enable you to toggle easily between the Design win-
dow and the Preview Window display. When you send a report to the Preview 
Window, the Preview tab is visible and is selected. You can Click on the Design 
or Preview tab to toggle between the Design and the Preview Windows.

Formatting 

Take advantage of 12 basic styles, or totally advanced graphing with over 80 
styles and editing control in the 16-bit version. Control every aspect of graphs 
in a report. It’s a snap to rotate a graph, changing its perspective, or adjust font 
size or colors. Graphs are easy to insert, and get updated whenever data is 
refreshed. Graphing options can be controlled at runtime, and you can now drill 
down directly on graphs to view detailed data.

" Graph work created in 16-bit can be read and printed in 32-bit.

Data analysis 

� Export in Excel 5.0 format
In Crystal Reports, you can now export information directly to Excel 5.0 for-
mat.
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� Reporting with Lotus Notes
Crystal Reports now give you the ability to create reports importing Lotus 
Notes (via ODBC) and  to export to the Lotus Notes format. (16-bit versions 
only)

� Improved MS Access Support
Crystal now offers better reporting with support for Access OLE objects. 
Report on the information you want, including Access Pictures fields and 
OLE fields. Save time and effort by using Access queries to generate 
reports.

Data handling 

Report Options saved with report

The new File/Report Options  command enables you to save a number of 
option settings with your report. This can make it easier to deploy reports 
across machines and throughout an organization.

New developer resources

� Print Engine DLL in 32-bit
Now access the full power of Crystal Reports in 32 or 16-bit technology so 
you can develop and report in any Windows environment. There is full 
compatibility between both technologies, allowing you to create applica-
tions that are truly cross-platform.

� Full Featured OLE Control
Crystal now has a new OCX with over 80 properties for full access to the 
Crystal Print Engine DLL. The new tabbed interface makes it really easy to 
navigate around the properties page. You now have numerous report inte-
gration options including the OCX, the Crystal VBX, the Delphi VCL or the 
MFC. Development has never been easier.

� Reporting from the NT event log
Use Crystal Reports to report on the Windows NT event log. Monitor and 
analyze workstation or system related activity. An IS favorite!
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� Delphi VCL
Now you can add reporting to your Delphi applications. Crystal's VCL 
allows you to take advantage of 89 properties for maximum control and 
runtime flexibility.

� Borland Database Engine (IDAPI) and Support for Paradox 5.0
Crystal Reports now supports the Borland Database Engine for faster 
reporting performance from dBASE and Paradox 5.0.
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Crystal Reports 4.5 New Feature List

The following tables show what features are available in the various versions of 
Crystal Reports 4.5, and are subject to change.

Further, the table uses the following key:

� Prf. 32
Professional (32-bit)

� Prf. 16
Professional (16-bit)

� Stnd. 32
Standard (32-bit)

� Stnd. 16
Standard (16-bit)

� One Asterisk (*)
32-bit ready. Requires component not currently available from third party 
vendor.

� Two Asterisks (**)
Paradox via ODBC.

New 4.5 Features Prf. 32 Prf. 16 Stnd. 32 Stnd. 16

OLE Control (OCX) >80 >35 >35 >35

32-bit Print Engine DLL >80 >80 >35 >35

Drilldown on graphs Yes Yes Yes Yes

Graphing customization * Yes * Yes

Export to Lotus Notes 
data

No Yes No Yes

Delphi Control (VCL) No >89 No No

Reports from the NT 
Event Log (NT Only)

Yes No Yes No
User’s Guide 22



Getting Started
Crystal Reports 4.5 New Feature List1
Improved MS Access 
support

Yes Yes Yes Yes

Export to MS Excel 5.0 
format

Yes Yes Yes Yes

Report Options saved 
with report

Yes Yes Yes Yes

Downward compatibility 
with reports

Yes Yes Yes Yes

PC Data Access Prf. 32 Prf. 16 Stnd. 32 Stnd. 16

ASCII Yes Yes Yes Yes

ACT! 2.0 No Yes No Yes

Btrieve (all indices, 
requires DDF’s)

No Yes No Yes

Clipper (NYX) Yes Yes Yes Yes

dBASE (NDX, MDX, 
Visual dBASE and 
QBE) (QBE16-bit only)

Yes Yes Yes Yes

FoxPro (IDX, CDX, 
Visual FoxPro)

Yes Yes Yes Yes

Microsoft Access (1.0 -
2.0) and Access Que-
ries

Yes Yes Yes Yes

Microsoft Excel Yes Yes Yes Yes

Paradox (3.5 - 5.5)** Yes Yes Yes Yes

Lotus Notes No Yes No Yes

New 4.5 Features Prf. 32 Prf. 16 Stnd. 32 Stnd. 16
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SQL Data Access Prf. 32 Prf. 16 Stnd. 32 Stnd. 16

Borland Database 
Engine (IDAPI)

* Yes No Yes

ODBC Yes Yes No No

Gupta SQL Base * Yes No No

IBM DB2/2 No Yes No No

MS SQL Server Yes Yes No No

Oracle * Yes No No

Scaleable SQL * Yes No No

Stored Procedure sup-
port

* Yes No No

Ability to sort data on 
SQL Server

Yes Yes No No

Case sensitive SQL 
data

Yes Yes No No

Ability to convert data-
base drivers

Yes Yes Yes Yes
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Quick Start 

If you are an experienced Windows user who wants to get right into the pro-
gram, follow these steps to set up a report for the first time.

Step Action

1. Start Crystal Reports by double-clicking on the Crystal Reports icon in 
the Program Manager, or in Windows 95, select the Crystal Reports 
item from the Crystal Reports Folder on the task bar. 

" In Windows 95, Crystal Reports may also appear in an open folder 
on the Desktop shell when it is installed.

2. Select File/New/Report . 

Response : The Report Gallery appears.

3. Select one of the eight Expert icons to build a report with the help of an 
Expert, select the Another Report icon to use a template for building 
your report, or click Custom to build a custom report. If you click Cus-
tom, the Report Gallery expands, and you can then select a Report 
Type and Data Source for your custom report.

Response : If you have selected Custom and have selected a Report 
Type and Data Source, the Choose Database File dialog box appears.

4. When the Choose Database File dialog box appears, select the first 
database you want to activate for your report and click OK when fin-
ished.

Response : The Crystal Reports Report Design window appears with 
Title , Page Header , Details , Page Footer  and Summary  sections set 
up on your report template. The sections are all blank initially. You cre-
ate your report by inserting and formatting items in each of these sec-
tions.   
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The Insert Database Field dialog box appears on screen with the 
Design window. This dialog box displays a list of all of the fields in the 
active database. To speed the entry of multiple fields, the box remains 
on screen until you click the Done button. You can move the dialog box 
to a new location if you wish.

5. Select the field(s) you want to appear on the report. You can select and 
place them one at a time, or you can use the SHIFT-CLICK combination 
to select a number of contiguous fields or the CTRL-CLICK combination 
to select fields from the list at random. With the cursor on one of the 
selected fields, click the left mouse button. While keeping it depressed, 
drag the selected field(s) to the point in the Details section where you 
want the first field to appear.

6. Release the mouse button to place the field(s). If you placed multiple 
fields, they will appear next to each other in the order they appear in 
the Insert Database Field dialog box. The program marks the position 
of each field with a rectangular box. The characters in the box indicate 
whether the field is text (xxx...), number (555...), currency ($555...), 
date (YYYY-M...), or Boolean (T/F). The number of characters in the 
box indicates the number of characters allowed for the field in the data-
base. Note also that the program automatically places field titles in the 
Page Header section.

7. To create a report title, select Insert/Text Field , type in the information 
you want to appear, click Accept when finished, and position the field 
where you want it in the Title section. You can also insert database 
fields or special fields in that section from the Insert menu.

8. To see how your results will print, select Print Preview from the File 
menu. You can fine tune your report in the Preview Window if you wish 
while seeing the results on actual report data. You can also close the 
window and continue working on your report in the Report Designer. 
The funtionality is the same in both places.

9. If you want to:

� Change the placement or width of a field.

� Format the field.

� Insert a subtotal or grand total for a field.

� Delete a field.
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� Click the field box for that field. Black handles appear on the right 
and left sides of each selected field.

" You can select multiple fields at once using a SHIFT-CLICK combi-
nation, or by selecting Edit/Select Fields . If you use Edit/Select 
fields , you use the crosshair cursor to surround the field(s) of 
interest in a selection rectangle (lasso). 

� To change the placement of the field, drag the field box to its new 
position using the mouse or the arrow keys.

� To change the width of the field, drag the right or left handle using 
your mouse or use a SHIFT-ARROW combination on your keyboard.

� To format or subtotal the field, click the right mouse button while 
the cursor is inside the field. A pop-up menu appears listing your 
various options.

� To change the font, select Change Font  and refine your selec-
tion using the Font dialog box when it appears.

� To change the format (alignment within field, number, cur-
rency, and date display, etc.) select Change Format  and 
refine your selection using the Format dialog box when it 
appears.

" Many of the font and formatting options are now available on 
the Format bar just below the Button bar.

� To insert a subtotal, select Insert/Subtotal  and refine your 
selection using the Insert Subtotal dialog box when it appears. 
In this dialog box you select the field and the condition that 
triggers a new subtotal whenever the field’s value changes, 
and you select the sort direction: Ascending (A to Z, 1 to 9) or 
Descending (Z to A, 9 to 1). The program creates a new sec-
tion to hold the subtotal.

" The program automatically sorts the data (based on the field 
that triggers the subtotals) before it subtotals. You don’t have 
to manually enter a subtotal sort. 
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Quick Start1
� To insert a grand total, select Insert/Grand Total . The pro-
gram creates a new section to hold the grand total.

� To delete the field, select Delete Field .

10. If you want to create a formula to make data calculations or compari-
sons, select Insert/Formula Field . Enter a name for your formula in 
the Insert Formula dialog box, and the formula itself in the Formula 
Editor when it appears. Enter fields, operators, and functions by select-
ing them from their respective scroll lists. You can get complete infor-
mation on each available Function and Operator via the Help button, 
and you can check your formula syntax via the Check button. Entering 
a formula is similar to entering a formula in a spreadsheet cell. When 
finished editing, select Accept and place the formula just like you do a 
database field.

11. To add a graph, select Insert/Graph/Chart .

12. To insert a spreadsheet, picture, or other OLE object that you can edit 
in its native application from Crystal Reports, select Insert/Object .

13. To change the sort order, select Report /Sort Records . Select the 
field(s) you want Crystal Reports to use for sorting the report data.

14. To change the sort and group by field, select Report /Change Group . 
Select the group section of interest from the list that appears in the Edit 
Group Section (sections) dialog box, and select the new “trigger” field 
from the Edit Group Section (edit) dialog box when it appears.

15. If you want to limit your report to specific records (for example, the 
records of California customers that have YTD sales greater than 
$10,000), click the first field on which you want your selection to be 
based (in this case the State field) and choose Select Records Expert 
from the Report menu or the right mouse button pop-up menu. Answer 
the questions that appear in the Select Records Expert dialog box and 
click OK when finished.

16. When finished, print your report by selecting File/Print/Printer .

That’s it. It’s that easy to build a report with Crystal Reports. To practice using 
Crystal Reports by completing step-by-step lessons, proceed to Chapter 4, 
“Tutorial—Movie List.” To read about Crystal Reports concepts and procedures 
in greater detail, see Chapter 3, “Using Crystal Reports.”
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About Crystal Reports 

Crystal Reports is a powerful yet easy to use program for creating custom 
reports, lists, and labels using data from your existing databases. The program 
works by establishing connections with one or more of your databases. Using 
these connections as conduits, Crystal Reports draws in the values from data-
base fields you select and uses them in the report, either in their original form 
or as part of a formula that generates more sophisticated values.

Crystal Reports was designed to work with all kinds of data: numbers, cur-
rency, text, dates, and boolean (Yes/No) fields. It has a wide range of built-in 
tools that you can use to manipulate that data to fit your needs. Using these 
tools, you can:

� Make calculations and comparisons of data values.

� Calculate subtotals, and grand totals of field values.

� Calculate group averages, count the records in a group, and test for mini-
mum and maximum values.

� Test for the presence of specific values.

� Present data only if certain conditions are met.

� Evaluate logical relationships between values.

� Convert data from one type to another.

� Merge text with other text.

� Merge text with data field data.

� Perform numerous other useful, data-related activities.

You can place the data wherever you want it on the report, and highlight it with 
special fonts and font sizes. With Crystal Reports, your reports can be as sim-
ple or as complex as your needs demand.
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Once you have designed a report (or modified one of the sample reports 
shipped with Crystal Reports), you can use it as a template to create other sim-
ilar reports. You can then use the template as a starting point for your new 
report, making only those changes necessary to fit your needs. This feature 
can save you considerable time over creating a new report from scratch.

If you can imagine a report, you can probably create it using Crystal Reports, 
and save a lot of time and headaches in the process.

Use as a print engine with Visual Basic, C, and dBASE 

Crystal Reports can also be used as a print engine to print reports from within 
your C, Visual Basic, and dBASE application. In fact, it can be used as a print 
engine by any development tool that can call a DLL. See Chapter 3 in the 
Developer’s Reference, “The Crystal Reports Print Engine,” for complete 
details.

Why Crystal Reports 

Crystal Reports was created to allow technical and non-technical users to cre-
ate customized reports quickly and easily, from a variety of databases, under 
Microsoft Windows. While database programs often include their own report 
writers, they typically require extensive knowledge of the database they come 
with. Crystal Reports, instead, was designed to be used by anybody. It includes 
tools that can be used by:

� Businesses, and Administrative organizations

� Schools

� Clubs, Sports teams or leagues

� Collectors

� Libraries

� Professionals

� Individuals

� Anyone who has a need to retrieve database data and present it in a list, 
report, or label format.

And, Crystal Reports was designed to get you up and running quickly, even if 
you're not a computer expert.
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How Crystal Reports prepares reports 

Crystal Reports prepares reports by reading data in the database files you 
have selected and making that data available for use in your report.

� If you wish to use data in a single data file, you simply choose that file 
when you create the report.

� If you wish to use data in multiple data files, you need to select the files and 
also to indicate the field or fields in each file that Crystal Reports is to use 
to match data. For example, you may wish to create a report that draws 
data from both your customer database and your invoice database. The 
customer database contains personal information on each customer; the 
invoice database contains information on invoices and payments. To use 
the two databases effectively, Crystal Reports needs to know how to match 
invoice and payment data in the one database to the appropriate customer 
in the other. The linking field might be a field called CustNumber in both 
databases, or, it could be a field named CustNumber in one database and 
a field named Account in the other. Once the linking field is identified, Crys-
tal Reports matches up the data.

" Crystal Reports does not write data to your original data files. Your original 
files remain unchanged using Crystal Reports, no matter how much you 
might manipulate the data you select.

Things you can do with Crystal Reports 

The term report writer doesn't completely describe Crystal Reports' functional-
ity. Crystal Reports creates attention-getting management reports with ease, 
that's true. But it has many other uses not often suggested by the term report 
writer. Below are some examples of the projects you can complete with Crystal 
Reports.

� Lists and reports
You can create simple columnar lists from a single database or you can 
create a report that includes data from different sources, that subjects the 
data to extensive calculations, that merges text with data, and that high-
lights key data with display fonts and other character attributes. (See 
Chapter 3, “Using Crystal Reports,” and Chapter 4, “Tutorial—Movie List,” 
of this manual, and Private Tutor.)
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� Cross-tabs
You can create cross-tab reports that enable you to make comparisons 
and identify trends in a hurry. (Search for cross-tab in Crystal Reports Help 
and Private Tutor.)

� Graphs/Charts
You can create graphs and charts in a variety of formats to help you 
present elements of your report in a more visual manner. (Search for 
graphs and charts in Crystal Reports Help.) 

� Label-type items
You can create mailing labels with your data, and you can also create 
name tags, rotary file cards, disk labels, and other similar label type items 
that are available for dot matrix or laser printers. (Search for mailing labels 
in Crystal Reports Help and Private Tutor.)

� Form letters
You can create customized form letters that simply draw data from a data-
base for an address and salutation, or you can create sophisticated letters 
that include different blocks of text depending on relationships found in the 
data. (Search for form letters in Crystal Reports Help.)

� Preprinted forms
You can create reports (invoices, etc.) that print directly on preprinted 
forms. (Search for preprinted forms in Crystal Reports Help.)

� Data analyses
You can analyze mountains of data in multiple databases to identify nee-
dle-in-a-haystack items. You can assign priority numbers to alternatives or 
flag the items of greatest interest.

� Invoices
You can create custom invoices to be printed as a batch on specific dates, 
or you can construct a point of sale system that generates an invoice on 
demand, once the appropriate data is entered. (Search for invoices in 
Crystal Reports Help.)
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� Instructions
To create an addendum to an invoice, you can have Crystal Reports gen-
erate personalized instruction lists or print personalized sell-up sugges-
tions based on the specific items ordered.

� Job descriptions
You can have Crystal Reports generate personalized job descriptions 
based on the job number to which a person is assigned.

Additional things you can do

Within a report, Crystal Reports gives you the ability to:

� Calculate data
You can perform simple arithmetic on your data, or you can perform com-
plex statistical, financial, or scientific calculations. This allows you to 
present data in its final form and not in a form that requires further manipu-
lation once the report is in hand. (Search for calculated data fields in Crys-
tal Reports Help.)

� Compare data
You can compare one data field value to another, or you can compare the 
calculated value of a complex calculation to the calculated value of another 
complex calculation. This allows you to include data in your report only if a 
certain condition is met (a is greater than b, c is not equal to d, etc.). 
(Search for comparison operators index in Crystal Reports Help.)

� Search for specific values
You can search for specific data in your report by using the search feature 
in Crystal Reports. (Search for Search command in Crystal Reports Help.)

� Drill Down
You can see the details behind the summarized values in summary reports 
using the Drill Down feature. (Search for drill down in Crystal Reports 
Help.)

� Test for logical relationships
You can test to see if a group of conditions is met. Using such a test (cre-
ated with the logical operators and, or, and not) you can create complex, 
multi-faceted sets of conditions to pinpoint data for inclusion into your 
report. (Search for the operator names in Crystal Reports Help.)
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� Convert data
You can convert numbers to dollar amounts, numbers to text, or numbers 
written as text to numbers. You can also convert values with decimal 
places to integers. This conversion ability gives you great flexibility in the 
data you can use in formulas or calculations. (Search for convert in Crystal 
Reports Help.)

� Combine data with freeform text
You can combine data from data fields with freeform text to create sen-
tences that can be personalized and customized, or to flag, introduce, or 
label data. (Search for form letters in Crystal Reports Help.)

Easy to use features of Crystal Reports

Crystal Reports has been designed with your needs firmly in mind. You get 
power, but you also get ease of use and flexible distribution:

� Fine tune your report using actual data  
You can adjust spacing, fonts, and field sizes while working on actual data. 
You can regroup your data and add summaries and see the changes as 
they take place. And you can do all this without having to rerun your report 
after every change. It's an efficient process. (Search for Preview Window in 
Crystal Reports Help.)

� Reformat your report with the Click of a button  
You can change fonts, font size, and weight, realign data, modify number 
formats, and make a number of other formatting changes from the Format 
bar. This boosts your efficiency and makes it easier for you to experiment 
with formatting changes. Additionally, you can use the Auto Arrange button 
to automatically adjust the spacing of fields on your report. (Search for for-
mat bar in Crystal Reports Help.)

� Edit graphics, charts, and other objects in their native applications 
Since Crystal Reports is an OLE 2.0 container application, you can insert 
OLE objects (pictures, graphs, spreadsheets, etc.) in your report. You can 
set them up so they update whenever the original is changed, and you can 
edit the objects in their native applications simply by double-clicking the 
object. (Search for OLE in Crystal Reports Help.)
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� Create executable reports  
You can create executable versions of your finished reports. This enables 
others to read your reports with the click of an icon, even if they don't have 
Crystal Reports on their systems. (Search for compile report command in 
Crystal Reports Help.)

� Export reports  
You can export your finished reports to a number of popular spreadsheet, 
and word processor formats, and into a number of common data inter-
change formats as well. This makes the distribution of information easier. 
For example, you or your colleagues may want to use report data to project 
trends in a spreadsheet package or enhance the presentation of data in a 
desktop publishing package. (Search for export command in Crystal 
Reports Help.)

� Send your reports via E-Mail 
You can distribute your reports quickly and easily by delivering them via e-
mail. Electronic distribution maximizes efficiency by eliminating print 
queues and reducing printer traffic. (Search for email, sending report via in 
Crystal Reports Help.)

Databases that work with Crystal Reports   

Crystal Reports can build reports using the standard data files generated by 
dBASE (III, III+, IV, V), dBASE for Windows, Paradox (up to and including ver-
sion 5), Paradox for Windows, FoxPro (2.0, 2.5), Clipper, Btrieve (5.0-6.5, 
through the use of .ddf (dictionary) files, Excel, and Microsoft Access (1.0-2.0). 
The program can also work with ASCII data if you define the field lengths using 
the ODBC Administrator that is installed when you install the program. Since 
many programs can export data in dBASE format (.dbf files) or ASCII format, 
you will find that you can use Crystal Reports to create reports for virtually any 
database. Crystal Reports Professional Edition works with many of SQL and 
ODBC databases as well. (Search for databases that work with Crystal 
Reports in Crystal Reports Help.)

" In the 32-bit version of Crystal Reports 4.5, Btrieve files are only supported 
in Windows NT. Paradox databases are not supported in the 32-bit version 
of Crystal Reports 4.5. ACT files are not supported in the 32-bit version of 
Crystal Reports 4.5.
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The Crystal Reports window 

The Crystal Reports window is clean and easy to understand:

Figure 2-1. The Crystal Reports window

� The Menu bar appears just below the Title bar

� The Button bar appears just below the Menu bar

� The Format bar appears just above the Status bar

� The Status bar appears at the bottom of the window.
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The Menu bar 

The Menu bar is Crystal Reports' command center. Each option on the menu 
bar calls up a drop down menu of commands that you can use to create, mod-
ify, print, and save your reports. 

� File.  The File menu includes commands you can use to open, close, and 
save files, save files under a different file name, and create new reports, 
mailing labels, and cross-tabs. It also includes a command you can use to 
exit Crystal Reports. Additionally it contains commands that enable you to 
preview and fine tune your report before printing, to export your report to a 
disk file in a variety of formats, to send your report to a printer, to print the 
report definition (a report describing your report), to change page margins 
and label layout, and to select a printer if you want the report to print on 
something other than the default printer. One remaining command enables 
you to configure Crystal Reports to your specifications. (Search for File 
Menu commands index in Crystal Reports Help.) 

� Edit. The Edit menu allows you to modify aspects of your report. The menu 
includes commands you can use to edit formulas, text fields, summary 
fields, OLE Objects, and graphs, to review the data in a selected field, to 
edit and delete group sections, and to activate the field-selection “lasso.” It 
also contains commands for cutting, copying, and pasting text, and for 
pasting OLE objects and their associated links. (Search for Edit Menu com-
mands index in Crystal Reports Help.)

� Insert . The Insert menu is the central menu you use for creating reports. 
The menu includes commands you can use to insert database fields, text 
fields, formula fields, subtotals, grand totals, summaries (counts, averages, 
etc.), group sections, print date, page number, record number group num-
ber fields, graphics, lines, boxes, graphs and OLE objects. (Search for 
Insert Menu commands index in Crystal Reports Help.)
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� Format. The Format menu includes commands for changing the look of 
the elements in your report. It includes commands for changing fonts, and 
formatting fields, report sections, graphics, lines, and boxes. The menu 
also provides commands for adding field borders, background color, and 
drop shadows for your fields and for changing line height. (Search for For-
mat Menu commands index in Crystal Reports Help.)

� Database. The Database menu is used to select and delete tables for use 
with your reports, to change the alias you use to identify a table, and to link 
and unlink tables. It has commands for logging onto and off SQL and 
ODBC servers, for showing and editing SQL queries, and modifying 
parameters for stored procedures. It also has a command, Set Location, 
for directing Crystal Reports to look for tables in new locations. Two verify 
commands can be used to adapt your reports to minor changes in table 
structure. (Search for Database Menu commands index in Crystal Reports 
Help.)

� Report . The Report menu includes commands that let you select the 
records or groups to be included in your report, select the order in which 
report data is to be sorted (by record or by group), to modify the report title 
or add comments to the report, and to specify a print date for your report. It 
has commands for updating the data used in a report and for gathering all 
the files you need for distributing your reports. It contains one additional 
command for creating an executable version of your report that you can 
share with others that don't have Crystal Reports. (Search for Report Menu 
commands index in Crystal Reports Help.)

� Window. The Window menu includes commands that let you rearrange 
icons and windows. It also lists the report windows that are open and 
includes a command that lets you close all report windows at once, if 
desired. (Search for Window Menu commands index in Crystal Reports 
Help.)
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� Help. The Help menu includes commands that take you to Crystal Reports' 
main help index and search facility and that provide information on using 
the help system. It has commands for registering your version of Crystal 
Reports, for calling up technical information about your computer system, 
for creating a technical support request, and for using the Crystal bulletin 
board efficiently. The menu also has commands that provide information 
on Crystal Reports LANPAKS, the Professional version of the program, 
and Upgrade Express, the most efficient way to stay on top of program 
upgrades. One final command gives you information about the Crystal 
Reports version you are using. (Search for Help Menu commands index in 
Crystal Reports Help.)

The Button bar 

Crystal Reports groups several commonly used commands on a Button bar 
that remains on screen at all times (unless you choose to turn it off using the 
File/Options  command). Each command is represented by an individual but-
ton, and each button displays a graphic that visually describes the command. 
You activate Button bar commands by clicking the appropriate button one time 
with the left mouse button. 

The Button bar eliminates some of the steps needed to activate the included 
commands, and it can thus greatly speed your work in creating reports. Each 
command available via the Button bar is discussed in Crystal Reports Help. 
(Search for button bar.) The buttons on the button bar perform the following 
functions:   

Create a new report. Open an existing report.

Save the report. Change from the Design window 
to the Preview Window.

Refresh the report data. Zoom report.

Print report to a printer. Export report to a file.

Send the file to E-Mail. Launch report to an Info Server.

Undo last change. Select fields.
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For additional information on these buttons, search for button bar in Crystal 
Reports Help.

The Format bar 

The Format bar enables you to select many popular formatting options with the 
click of a button or a selection from a drop-down list. You simply select the data 
you want to format, then click the appropriate list option or button to format the 
data you selected.

Two drop down lists appear at the left side of the Format bar. 

You use these for selecting new fonts and font sizes if you want to use some-
thing different than the default. To make a selection from either box, click the 
arrow to reveal your options and then click the option you want.

The buttons on the Format bar perform the following functions: 

Insert a database field. Insert a text field.

Insert a formula field. Insert a summary field.

Set record selection crite-
ria.

Set record sort order.

Visually link tables. Search for specific values.

Insert a Chart/Graph. Draw a line on the report.

Insert a picture. Draw a box on the report.

Changes the selected data to 
boldface.

Italicizes the selected data.
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The Status bar 

The status bar at the bottom of the report window displays valuable information 
to help you use Crystal Reports more efficiently:

� Button bar functions. When the cursor is over a Button bar button, the 
Status bar displays a short description of the button's function.

� Menu command descriptions. When you highlight a menu command, the 
Status bar displays a short description of the command. To highlight a 
menu command, click the menu name and move to the command using 
the DOWN ARROW key.

� Current selections. When you select or place a graphic, field, text field, 
graphic line or box, special field, or formula, the status bar displays the 
name of the item selected. It displays:

� The file name for a graphic 

Underlines the selected data. Increases the font size one 
point each time you click the 
button.

Decreases the font size one 
point each time you click the but-
ton.

Aligns the selected data flush 
left.

Centers the selected data. Aligns the selected data flush 
right.

When a number field is selected, 
places a currency symbol with 
the number.1

When a number field is 
selected, places a thousands 
separator in the number.1

When a number field is selected, 
places a percentage sign with 
the number.

Adds one decimal place to a 
number.

Subtracts one decimal place 
from a number.

Applies a style.

Arranges field spacing automati-
cally.

1The program refers to your 
settings in the International sec-
tion of the Windows Control 
Panel.
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� The alias and field name for a field 

� The text in a text field 

� The word Line for a line and Box for a box

� The field type for special fields (PrintDate, RecordNumber, etc.) 

� The formula name for a formula.

� Graphic coordinates. When you select a field or create a bit-mapped 
graphic, a graphic box, or a graphic line, the program displays the coordi-
nates of the object measured from the top left corner of the page. Two 
numbers are used, separated by a colon. The first number describes how 
many inches from the left page margin the graphic is. The second number 
describes how many inches from the top margin the graphic is. For more 
information about the Status bar search for status bar in Crystal Reports 
Help.

Right mouse-button capabilities   

When you are working in the Design window, you can speed up your work con-
siderably using Crystal Reports' right mouse button capabilities. When the cur-
sor is positioned on a report element (a field, a group field, a formula, etc.) and 
you click the right mouse button, Crystal Reports displays a pop-up menu right 
next to the element. Unlike Crystal Reports' standard menus that group com-
mands by function (editing, inserting, etc.), these pop-up menus are element-
specific: that is, they contain only those commands from Crystal Reports' pri-
mary menus that are available for use with the selected element. 

The pop-up menus are valuable because:

� They display the name and source (alias) of the element at the top of the 
menu so you can identify the elements on your report with a single mouse 
click.

� They appear right next to the selected element making them quicker and 
easier to access than Crystal Reports' main menus.

� They contain only the commands you need; you don't need to search for 
commands on a more comprehensive menu.

� They make it easier to learn Crystal Reports because: 
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� They eliminate the need to remember where to find a command, and

� Because you're dealing with only a compact list of commands, they 
make it easier to pick the right one, and

� They spotlight the things you can do with an element making it an easier 
system to use when you are under pressure or distracted.

Follow the procedure below to use right mouse button menu.

Step Action

1. Position the cursor on the element of interest. 

2. Click the right mouse button.

Response : The pop-up menu appears.

3. Select the command of interest from the pop-up menu. These options 
work exactly like the corresponding options that appear on Crystal 
Reports' primary menus.

For information on using any of these menu options, search for the option 
name in Crystal Reports Help.

" If you have swapped left/right mouse buttons via the Control Panel, the left 
mouse button will activate the pop-up menus.

Crystal Reports cursors 

Crystal Reports uses a number of different cursors in its operation:
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The Arrow cursor is the pri-
mary cursor. You will use this 
cursor everywhere but where 
you can type text. The cursor is 
used for making menu selec-
tions, selecting options from 
dialog boxes, working with 
scroll bars, etc. 

A Double-Arrow cursor is a 
resizing cursor. The cursor 
changes to one of a number of 
different double- arrow cursors 
whenever it is over a resizing 
handle on a bit-mapped 
graphic, a graphic box, a 
graphic line, or a field. 

The I-beam cursor is active 
whenever you are working in 
the text entry sections of the 
Design window, the Formula 
Editor, and some of the dialog 
boxes. The I-beam cursor is 
the cursor you use to select 
report elements, and to set the 
position of the insertion point. 

The Pencil cursor is a drawing 
cursor. It appears whenever 
you select Insert/Box  or 
Insert/Line . The point of the 
pencil marks the spot where 
the drawing begins and is used 
to define the size and shape of 
the object drawn.

The Drag (or Stop) cursor. This 
cursor appears whenever the 
item you are dragging is over 
an area in which it cannot be 
dropped. 

The single-unit Drag and Drop 
cursor is available whenever 
you are dragging a single item 
over an area where it can be 
dropped.

The multi-unit Drag and Drop 
cursor is available whenever 
you are dragging multiple items 
over an area where they can 
be dropped.

The Tiny Hand cursor is avail-
able only in the Help facility. 
The Arrow cursor changes to 
the Tiny Hand cursor whenever 
it is positioned over text or a 
graphic that you can use to 
jump to another position in the 
Help system.

A Section Sizing cursor. The 
cursor changes to the section 
sizing cursor whenever it is 
positioned over one of the lines 
dividing report sections. Using 
this cursor you can drag a sec-
tion boundary line to expand or 
reduce the size of a section. 

The Insertion Point identifies 
the location for entering text. 
This cursor is available in the 
text entry sections of the 
Design window, the Formula 
Editor, and some of the dialog 
boxes. You set the insertion 
point by positioning the I-beam 
cursor and then Clicking. 
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The Hourglass cursor is the 
cursor that appears whenever 
Crystal Reports is processing a 
command you have selected. 
Whenever the hourglass is visi-
ble, you cannot select any 
other commands or proceed 
further with your report.

The Rectangle cursor is the 
cursor you will use for placing 
fields and formulas in the 
Design window. This rectangle 
is a graphic approximation of 
the field and formula markers 
Crystal Reports uses to repre-
sent fields and formulas in the 
Designer.

The Crosshair cursor is the 
cursor that appears when you 
choose Edit/Select Fields  or 
you click the lasso button. You 
use this cursor for lassoing or 
marqee selecting fields.

The Drill Down cursor appears 
when you have a summary 
report opened in the Preview 
Window. Click this cursor on 
the summary field that you 
want to drill down on.

When you place the normal 
cursor on the positioning wand, 
it changes to the Grabbing 
Hand cursor. Use this cursor to 
move the positioning wand, 
and thus the field you have 
selected on the report page.
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Crystal Reports Design window 

The Crystal Reports Design window is where you will insert and format data to 
create a report. 

Figure 2-2. The Crystal Reports Design window

The Design window does not have its own menu. Instead, the commands from 
the Crystal Reports menu remain visible and are active for the Design window.

The Design window has scroll bars at the bottom and along the right hand 
edge. These scroll bars help you to reveal parts of the report that aren't imme-
diately showing in the window.

The Edit box 

The large white area of the Design window is the Edit box, the facility where 
you actually build your report. The horizontal lines in the Edit box separate the 
report sections. As you add additional sections to your report (as you add sub-
totals, for example), the program will add additional lines to help keep you ori-
ented.
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Report section names 

The gray area to the left of the Edit box gives you additional information to help 
you put data and objects where you want them on your report. The horizontal 
lines extend into the gray area further defining the sections, and the program 
identifies each section with a name or an abbreviation for the section name. As 
you add additional sections, the program identifies those as well. (Search for 
Design window in Crystal Reports Help.)

Scroll bars 

You can use the scroll bars in several ways:

� You can click on one of the scroll arrows to move the document in small 
increments in the direction the arrow is pointing.

� You can position the pointer on a scroll arrow and hold down the left 
mouse button to scroll the document continuously in the direction the arrow 
is pointing.

� You can click on the scroll bar to scroll the window in window-height or win-
dow-width jumps. 

� You can drag the button on a scroll bar to the point in the document to 
which you want to scroll.

Single window display

To reduce screen crowding when you have multiple open reports, Crystal 
Reports uses a single dynamic window for each report. When you open a 
report, the Design tab is visible and is selected in the upper left hand corner of 
the window. When you send a report to the Preview Window, the Preview tab is 
visible and is selected. You can click on the Design or Preview tab to toggle 
between the Design and the Preview Windows.
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Resizable dialogs with memory

You can resize the Insert Database Field and Insert from View dialog boxes to 
better fit your needs. This can be especially helpful: 

� When you have longer field names than fit the default dialog box, or

� When you want a longer list of fields to appear on the screen at one time. 

Additionally, the program remembers the dialog box size and location and dis-
plays the dialog box as you left it when you next create a report.

Ruler

Crystal Reports makes a ruler and a positioning wand available in both the 
Design window and the Preview Window.

Figure 2-3. The Crystal Reports ruler

The ruler provides a visual reference for positioning and resizing fields, graphs, 
lines, boxes, and bitmaps. The increments on the ruler are based on your mea-
surement settings in the International section of the Windows control panel. 
The ruler also enables you to change page margins while immediately seeing 
the results of your changes on the report itself.

� The ruler is like a number line in arithmetic; it has positive numbers above 
zero and negative numbers below zero.

� The negative numbers appear only when you are using the ruler to 
reset the left page margin. 

� The zero (0) mark on the ruler defines the left page margin. The right 
end of the ruler defines the right page margin.

The positioning wand appears just beneath the ruler whenever you select 
one or more objects in your report. 
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� If you select a single object in your report, the wand duplicates the position 
and width of the selected object.

� When you move the wand, the program moves the selected object to 
the wand’s new position.

� When you resize the wand, the program resizes the selected object to 
the wand’s new width.

� The Status bar at the bottom of the screen displays the right and left 
coordinates of the object as you modify its size and/or position.

� If you select multiple objects in your report, the bar duplicates the distance 
from the left edge of the leftmost object to the right edge of the rightmost 
object.

� When you move the wand, the program moves the selected object(s) 
to the wand’s new position. 

� You cannot resize fields using the wand when you have multiple 
objects selected.

� The status bar does not display coordinates when you have multiple 
objects selected.

You can use the ruler and positioning wand in the Design window, the Pre-
view Window, or both. To turn the ruler and positioning wand on and off, 
use the “Show Ruler...” switches in the Layout tab of the File Options dia-
log box. You access this dialog box using the File/Options  command. 

You can perform the following actions using the ruler and positioning wand:

� Change page margins

� Resize objects

� Move objects

" Search for ruler  in Crystal Reports Help.
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Snap to Grid

Crystal Reports allows you to specify how you want to use the grid. In the File 
Options dialog box on the Layout tab you can toggle on the checkmark in the 
Snap to Grid check box to activate Snap to Grid. Toggle the checkmark off to 
deactivate Snap to grid. By default, the option is toggled on. Select File/
Options  to open the File Options dialog box.

Using the Grid 

In previous versions of Crystal Reports, a fixed size, invisible grid was present 
to help align your data. This version of Crystal Reports allows you to change 
the size of the grid, make the grid visible or invisible, and choose whether or 
not fields snap to the grid. Grid options are explained in the discussion of the 
Layout tab in the File/Options  dialog box. You can also call up individual grid 
options when you click the right mouse button when your cursor is positioned 
on the Format bar or the Ruler. (Search for grid in Crystal Reports Help.)
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Messages 

The system displays a variety of messages to indicate error conditions or a 
potential problem. Each of these messages carries with it brief instructions for 
resolving the situation.

The messages fall into three basic categories:

� Windows Error Messages. These are messages from Windows itself. 
They indicate a problem interacting with the Windows environment. For fur-
ther information on these kinds of messages, please refer to the Microsoft 
Windows User's Guide or other pertinent information.

� Crystal Reports Error Messages. Crystal Reports error messages indi-
cate a problem interacting with Crystal Reports. For a complete list and dis-
cussion of Crystal Reports error messages, search for error messages in 
Crystal Reports Help.

� Check Formula Warnings. Crystal Reports issues Formula Compiler 
Errors whenever it detects a data or syntax error in a formula you are creat-
ing. These errors can be issued when you ask Crystal Reports to check a 
formula (prior to accepting it), or ask it to accept a defective formula.

As a guide to resolving the problem, when you select OK in the message 
box, Crystal Reports automatically places the cursor at the point in the for-
mula where it detected the error.

For a complete list and discussion of Formula Compiler Errors, search for 
error messages in Crystal Reports Help. 
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Getting Help with Crystal Reports 

Crystal Reports offers a comprehensive help system to support you during 
every step of the report development process. 

The help system is easy to use. If you've used help systems in other Windows 
programs (or in Windows itself, for that matter), you probably know enough to 
begin using the Crystal Reports help system without further study. If you need 
help understanding the Windows help system, see the documentation that you 
received with Microsoft Windows.

The program offers two kinds of help: context sensitive  help and indexed  
help.

Context sensitive help    

Context sensitive help gives you immediate help with a screen element of inter-
est (menu command, dialog box, etc.). The program takes you directly to the 
help information you seek without the need to traverse the indexing system.

" To get help on a specific menu command, click the menu name and then 
use the DOWN ARROW key to highlight the command of interest. Once the 
command is highlighted, press F1.

Indexed help 

Indexed help takes you to the help indexing system, a hierarchy of indexes 
which is designed to help you target your topic of interest. Using the indexing 
system, you can select a broad topic of interest from the first index and then 
narrow your selection using the next index that appears, then the next, etc.
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Help features 

The Help system is full of useful information. Here is just a sampling of things 
you will find there:

� Sample code for making calls to the print engine from your C, dBASE or 
Visual Basic application. Using the Edit capabilities built into the Windows 
help facility, you can cut this code and paste it as ASCII text into any editor 
that supports Windows cut and paste procedures. (Search for copying 
sample code from help system.)

� Full documentation of the Crystal Class Library, a C++ class library addition 
to the Microsoft Foundation Class Library. Use the class definition in the 
Crystal Class Library to access the Crystal Reports Print Engine from your 
C++ application. (Search for class library help.)

� Full documentation for the Crystal Custom Controls, a VBX and OCX you 
can use when working with Visual Basic. (Search for custom control, crys-
tal.)

� Explanations of error messages and formula compiler errors. (Search for 
error messages.)

� Runtime information so you know which files to include when you include 
the Crystal Reports print engine with your application. (Search for runtime 
file requirements.)

� Tips and Tricks: dozens of helpful hints for working with Crystal Reports. 
(Search for tips and tricks.)

� Formulas for study: a series of complex formulas that showcase the use of 
Crystal Reports functions, operators, and formatting language in solving a 
number of real-world reporting problems. (Search for formulas in action.)

� Sample formulas: a number of topics contain sample formulas that can be 
cut and pasted directly into the Formula Editor to save you time. (Search 
for copying, sample formulas from help system.)
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� Formula functions and operators: a complete and detailed list of all func-
tions and operators you can use when creating formulas. (Look for the 
Functions and Operators topics in the Reference section of the Help Sys-
tem Contents.)

� Dissections of Visual Basic and dBASE sample applications included with 
the program. (Search for Sample application.)

The Help system is a storehouse of information that can make your reporting 
more productive and enjoyable. A comprehensive indexing system and hun-
dreds of search terms provide you a variety of avenues for finding the help you 
need, right from your computer. Once you see what's in the help system, we're 
confident you'll return to it often.

Private Tutor - your personal instructor 

Private Tutor is a personal instructor that walks you step-by-step through doz-
ens of processes you might want to use when building a report. Unlike the Help 
system that gives you an answer and then returns you to the program, Private 
Tutor stays with you until you've finished the job. It's a special level of support 
that we're confident you'll use again and again.

Calling up Private Tutor 

To call up Private Tutor, you can select the Private Tutor option from the Crys-
tal Reports Help menu, click the Private Tutor icon from the main Help index, or 
click the Private Tutor button from any Help topic. 

Private Tutor windows

The Private Tutor system uses two sets of windows:

� Step-by-step instructions always appear in a narrow window that is fixed 
on the right side of your screen. Because the window is narrow, you have 
plenty of room to work on your report while Private Tutor remains on 
screen. Should you ever require more room, you can either minimize Pri-
vate Tutor temporarily or move the Report Window itself.

� Concepts are always explained in large windows that provide room for 
graphics. Private Tutor uses graphics liberally to help to clarify the theory 
behind many of the report-building processes. 
User’s Guide 54



Introduction
Getting Help with Crystal Reports2
Using help while in Private Tutor

If you want to call up the Help system while using Private Tutor, no problem. 
click the Help button in the Private Tutor window and the program takes you 
directly to the main help index. To leave the Help system, click the Private 
Tutor button in any Help window and the program returns you to the instruc-
tions you were using when you left Private Tutor.

About this manual 

The manual is broken into six chapters:

� Chapter 1, Getting Started. Getting Started shows you how to install 
Crystal Reports on your system. It also includes a Quick Start section for 
those in a hurry to get the program up and running.

� Chapter 2, Introduction. Introduction gives you a brief overview of Crystal 
Reports. It familiarizes you with the Crystal Reports screens, using the 
mouse, error messages, and the help facility.

� Chapter 3, Using Crystal Reports. Using Crystal Reports is a chapter 
that leads you, conceptually, through the process of creating a report with 
Crystal Reports. It suggests a methodology for creating reports starting 
with nothing more than a one sentence statement of purpose for the report. 
The chapter also gives you a “feel” for the various program capabilities.

� Chapter 4, Tutorial. Tutorial is a hands-on chapter that leads you, step-
by-step, through the creation of comprehensive sample reports using Crys-
tal Reports. 

� Chapter 5, Formulas. Formulas is a comprehensive presentation of for-
mula topics. The chapter presents specific instructions for performing a 
variety of formula related activities, both simple and complex.

� Chapter 6, Using Crystal Reports with SQL and ODBC. Using Crystal 
Reports with SQL and ODBC explains the Crystal Reports tools available 
for working with data accessed via ODBC, and, if you have the Profes-
sional Edition of Crystal Reports, data accessed via SQL.
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� Appendix A, How to Get Technical Support. How to Get Technical Sup-
port describes the various ways you can get technical support for Crystal 
Reports if you need it.

The manual assumes that you understand the basic concepts and usage of 
Microsoft DOS or PC-DOS, Windows 3.1 or higher, Windows for Workgroups, 
or Windows 95. If you feel that you need additional information on any of those 
subjects, please consult the manuals that came with the software in question.

The manual also assumes that you will be using a mouse in the creation of 
your reports. While the manual occasionally indicates keyboard methods for 
using the program, the manual is generally mouse-oriented since most Win-
dows users have a mouse.

Special notations used in this manual 

The following notations are used throughout this manual:

� Delete means the DEL key on your numeric keypad.

� Escape  means the ESCAPE or ESC key on your keyboard.

� Enter  means the ENTER, RETURN, or CR key, depending on which of these 
keys appears on your keyboard.

� Click  means to click the left mouse button one time.

� Double-click  means to click the left mouse button twice, in quick succes-
sion.

� The term Cursor Keys  means the PG UP, PG DN, and ARROW UP, ARROW 
DOWN, ARROW RIGHT, ARROW LEFT, HOME, and END keys on your numeric 
keypad.

� Ctrl+Key , Shift+Key , and Alt+Key are examples of the notation for two 
key combinations. They mean to press the first key in the combination 
(CONTROL, SHIFT, or ALT), and, while keeping it depressed, to press the 
second key in the combination (designated as Key ).
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� Text enclosed in double brackets (for example, «information» ) is intended 
to expand or explain the information that it follows.

� Field names in formulas are italicized .

� Insert/Formula  means to select the Insert/Formula .

� Drag , when used in talking about field boxes, means to position the cursor 
on a field box, depress the left mouse button, and keep the button 
depressed while moving the field to a new position.

� Drag , when used in talking about text, means to depress the left mouse 
button and, while it is depressed, move the I-beam cursor across the text of 
interest to highlight and thus select it.

� Computer type  indicates data that you are to enter text using the com-
puter keyboard. It is also used to show example formulas.
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Overview

The purpose of this chapter is to suggest a structured approach to preparing 
reports with Crystal Reports. The approach includes the following elements: 

� Deciding on the content of your report. 

� Developing a prototype on paper. 

� Setting up the prototype using Crystal Reports. 

� Manipulating the data with formulas and functions. 

� Grouping, summarizing, and sorting your data. 

� Editing and formatting the data. 

� Adding graphic enhancements and OLE objects. 

� Specifying the records/groups to be included in the report.

� Printing the finished report.

This is not a hands-on chapter, but an important introduction that can make 
your report creation more efficient and more satisfying. The chapter has been 
designed to provide you with a conceptual understanding of Crystal Reports as 
well as a brief introduction to Crystal Reports' powerful features. 
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Deciding on the Content of Your Report 

Before you do anything else, you should outline the information you want your 
report to provide. Use the following list of questions as a guide:

1. What is the overall purpose of the report? 

2. Who is going to read the report? 

3. What is the report title going to be? 

4. What information do you need besides the title to identify the report? 

� Where is that information to come from? 

� If the information exists in a database, what types of fields is the data 
stored in: number, text, etc.?

5. What identifying information do you want at the bottom of each page? 

� Where is that information to come from?

� If the information exists in a database, what types of fields is the data 
stored in: number, text, etc.?

6. What specific data do you want to appear in the body of the report? 

� Where is that data to come from? 

� Does that data exist in data fields or does it need to be calculated from 
data field values? 

� What kind of fields is the data stored in: number, text, etc.? 

� Do you want to show totals? 

� What kind?

� What do you want to total?

7. What information, if any, do you want flagged on the report? How do you 
want it flagged? 

8. What information do you want highlighted in some way so that it really 
stands out? 
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9. Do you want the report to be based on all records in the database or only 
on specified records? 

What is the overall purpose of the report?

Reports are management tools. Their purpose is to help individuals quickly 
grasp the essential elements and relationships found in raw data so they can 
make effective decisions. For a report to be effective, it has to present the right 
data in a logical way. If it presents the wrong data or if it presents the right data 
in a haphazard manner, the report may slow the decision making process or 
even encourage incorrect decisions.

A good starting place in the development of a report is to write out the purpose 
of the report in a sentence or two. The purpose statement helps you focus on 
your primary needs, and it gives your report both a starting point and a goal. 
Below are some examples of purpose statements: 

� The purpose of this report is to show monthly and year-to-date sales by 
sales rep, compare this year's numbers to last year, and flag reps who are 
seriously deficient. 

� The purpose of this report is to show sales activity for each item in inven-
tory, and to suggest reorder quantities based on that activity. 

� The purpose of this report is to calculate bowling averages and handicaps 
for each member of the bowling league. 

Clarifying the purpose of the report before you start is a critical step in the over-
all process. A report without a clear purpose is like a meeting without a clear 
agenda; it rambles and accomplishes little. 

Who is going to read the report?

A single report is often used by many individuals. A detailed, company-wide 
sales report, for example, may be used by sales reps, the regional sales man-
ager, the national sales manager, and the Chief Operating Officer (COO). 
User’s Guide 60



Using Crystal Reports
Deciding on the Content of Your Report3
Each of these individuals will be interested in different aspects of the report. 

� A sales rep will use the report to evaluate his/her individual sales perfor-
mance and to compare that performance to that of other reps in the region. 

� The regional sales manager will use the report to evaluate the reps in his/
her region and to compare the region's performance to that of other 
regions. 

� The national sales manager will use the report to evaluate the performance 
of his/her regional managers and to compare overall sales to the current 
sales forecasts. 

� The COO will use the report to evaluate the performance of the Vice Presi-
dent of Marketing and the sales department as a whole, and to project 
such things as manufacturing needs, warehouse locations, etc. 

Since each of the users of the report has different interests, it is important to 
plan the report so it includes the information each of the users is looking for. 

What is the report title going to be? 

Write out a working title for your report. You may decide to change it later, but 
at least you will have a title to use when creating your prototype report.

Header information 

What information do you need besides the title to identify the report? Are you 
going to include identifying information in addition to your report title? You may 
wish to include the current date, information on who prepared the report, a 
block of text to describe the purpose of the report, the range of data covered, 
etc. If you are going to include such information, write it down so you can use it 
in preparing your prototype. 
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Header information sources 

Where is that information to come from? The information can come from a vari-
ety of sources, depending on the kind of information you plan to use. For exam-
ple, the current date can be inserted using the Crystal Reports Insert/Special 
Field/Print Date Field  command. Information on who prepared the report 
might be drawn from individual data fields in the database(s) used. (If it is to be 
drawn from a database, what database? Or, what combination of databases?) 
A block of text can be created and entered on the face of the report itself. As 
you begin to think of where the information is to come from, you begin formally 
structuring the report. 

Data types in the header 

If the information exists in a database, what types of fields contain the data: 
number, text, etc.? Crystal Reports uses different rules for working with differ-
ent types of data. You will find it helpful later if you note the data type of each 
piece of data you plan to draw from a database.

Footer information 

What identifying information do you want to appear at the bottom of each page 
(page number, report name, author's name, Confidential, etc.)? 

Footer data sources 

Where is that information to come from? 

Data types in the footer 

If the information exists in a database, what types of fields is the data stored in: 
number, text, etc.? 

Report body data 

What specific data do you want to appear in the body of the report? 
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When you think of a report, it is probably the body of the report that you think 
of. The body should contain all the data that you need to fulfill the statement of 
purpose you wrote for the report. It should also contain all of the data needed 
by the various users that you have identified. You might find it helpful to list first 
the basic data that is required to fulfill the purpose statement, and then list the 
more specific kinds of data needed by the various users. 

Body data sources 

Where is that data to come from? This step requires you to look at the available 
databases. Crystal Reports allows you to combine data from different data-
bases to create your reports, so you have a great deal of flexibility in your work. 

� Much of the data in a typical report will be taken directly from data fields. 
Which data fields will you be using and where are they located? 

� Other data will be calculated based on data fields. Which data fields will be 
used in the calculations? 

� Still other data will be input directly into the report (headings, text blocks, 
etc.). Which data will you enter directly on the report, without drawing it 
from data fields? 

Existing or calculated? 

Does that data exist in data fields or does it need to be calculated from data 
field values? 

Some report information can be drawn directly from data fields (sales informa-
tion, for example); other information will have to be calculated based on data 
field values (sales commission, for example, based on the relationship of sales 
to quota). In your planning, it can be helpful to segregate or flag data that 
needs to be calculated from that which can be used directly. 
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Data types in the body 

What kinds of fields contain the data: number, text, etc.? While it is important to 
understand data types for all data you will be using, it is of critical importance 
that you know the data type for data fields that will be used in calculations. 
Functions and operators work with specific kinds of data, so it's important to 
know the data type to know which functions and operators you can use in your 
calculations. 

Groups 

Do you want your data organized into groups? How do you want it grouped? By 
customer? By date? Or by other criteria?

Group values

Do you want to show a subtotal at the end of each group? A count? An aver-
age? Crystal Reports allows you to specify several kinds of group values. 

Group value positions 

Where do you want the group values to appear. With the group data? With the 
group data but on a page separate from other groups? Only at the bottom of 
the page? Crystal Reports gives you all of these options. 

Grand totals, grand total averages, etc. 

Do you want to total (or average, count, or determine the maximum or mini-
mum value included in) all the values in any column on your report? Crystal 
Reports allows you to do this and place the grand total (or the grand total aver-
age, grand total count, etc.) at the bottom of the selected column. 
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Flags 

What information, if any, do you want flagged on the report? You may want to 
call attention to some data by flagging it on your report. For example, non-mov-
ing inventory items are often flagged on inventory reports so they can be given 
special attention. 

If you want any information flagged, identify the information and the parame-
ters for flagging. Using the inventory report example, you might want to flag 
each item that has shown no activity during the last month, during the last three 
months, or during some defined period. 

Flag options 

How do you want it flagged? You may want to flag items with an asterisk or 
some other symbol, or you may want a word to appear as a flag. In any case, 
you should write out flagging instructions so they are handy. 

Highlights 

What information do you want highlighted in some way so that it really stands 
out? Crystal Reports gives you the opportunity to underline report elements, or 
to change the fonts or font size or color used for specific report items. It allows 
you to put borders around items and to draw lines and boxes to break your 
report into sections, set off headings, etc. All of these formatting tools can be 
used to highlight key data on a report. If you have data that you want high-
lighted, you should write down highlighting instructions so they are handy 
too.Record or group selection 

Do you want the report to be based on all records or groups in the database or 
only on specified records or groups? Crystal Reports gives you the opportunity 
to base a report on all records in a given database, or on a limited set of 
records from the database. Using Crystal Reports you can select records 
based on simple date ranges or comparisons, or you can create complex for-
mulas to identify the records to be included. Take a few minutes to determine 
the records needed for your report and list the criteria to be used for selecting 
those records.
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Sorting

Do you want your data sorted based on record or group values? Crystal 
Reports gives you both alternatives. 
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Developing a Prototype on Paper 

Graphic designers generally begin their work on a magazine cover, brochure, 
or display advertisement with a rough pencil sketch. They often use boxes, cir-
cles, or other symbols to represent the graphic elements they intend to include 
in the final product, and they often use lines or scribbles to represent text. 
Doing the rough design on paper, in pencil, helps them create a look for each 
page. It helps them find a balanced way of positioning the various elements 
before they begin working with sophisticated graphics tools. We think you will 
find a similar exercise helpful in designing your Crystal Reports reports. 

While a paper prototype is useful regardless of your expertise with Crystal 
Reports, it is particularly valuable when you are first learning to use the Crystal 
Reports program. With the paper prototype at hand, you can put your full effort 
into learning and using the Crystal Reports commands instead of trying to 
design and learn at the same time. 

To design a paper prototype with Crystal Reports: 

� Get paper of the size you'll be using for your finished report. 

� Position your title and other descriptive header information, using boxes or 
lines to represent report elements. 

� Position your footer information. 

� Review the page for balance. 

� Look at the information you intend to include in the body of your report. 

� Count the number of fields you will be using and estimate the appropri-
ate spacing between fields. 

� Use rectangles to pencil in the fields using your estimated spacing.

� Change the spacing if you need to. 

� Decide on a logical sequence for presenting the data of the report. 

� Label the fields to indicate that sequence. 

� Use small boxes to indicate group values and totals. 

� Place random flags in the column where you want the flags to appear. 

� Darken any elements you want highlighted so they stand out from the rest 
of your prototype. 

� Review your finished product for look and balance, and make changes as 
needed. 
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Setting up the Prototype Using Crystal Reports 

Once you have completed your paper prototype, it is a straightforward process 
to recreate that prototype in the computer, using Crystal Reports. Before you 
do, it is important to understand how Crystal Reports' report editing process 
works. 

" This section assumes that you are new to Crystal Reports and that you 
plan to build a simple report using data from a single database. No 
advanced topics are covered in this section. 

When you click on the Tables icon to create a new report from the Report Gal-
lery or one of the Report Experts, Crystal Reports displays the Choose Data-
base File dialog box.

Figure 3-1. Choose Database File dialog

You use this dialog box to select the database file(s) that contain the data you 
want to use in your report. You will first select the directory and, once in the 
directory, you can select the database file you identified earlier in Deciding on 
the content of your report.

Crystal Reports also lets you build reports from Data Dictionaries and Report 
Templates. Both of those subjects are covered immediately after the next sec-
tion (Aliases). 
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Aliases    

For a variety of reasons, database names and locations get changed. Many 
times this is not a problem, but if you have created a report using fields in for-
mulas, changing the name or location of the database after you have created 
the formulas could be a real problem. Crystal Reports would look for formula 
fields under the old database name, and if the database had its name changed, 
the program wouldn't find the fields and thus couldn't use the formulas. 

Crystal Reports avoids this kind of problem by using aliases. Aliases are point-
ers, programming devices that tell Crystal Reports where it should currently 
look for a database field. Now, if you change the name or location of the data-
base (via the Database/File Location  command, page you simply reset the 
pointer (tell the alias about the change). The name of the alias doesn't change, 
so your formulas are not affected. Crystal Reports looks to the alias for a loca-
tion as always, goes to the new location for the field, and runs the formula with-
out a problem.

You accept the default alias or create a new one whenever you activate a new 
database for your report. You reset the alias pointers whenever you change the 
name or location of the database. Crystal Reports uses the database file name 
(without the extension) as a default alias. Thus, the database customer.dbf 
would generate the default alias customer. (For more in-depth discussions of 
aliases, search for alias in Crystal Reports Help.)

Crystal Reports uses the following syntax for fields used in formulas: 

{file.fieldname}

We will use the same syntax throughout this manual when identifying fields in 
formulas. 
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Experts

You can use Crystal Reports Experts to help you create reports as quickly as 
possible. When you select the New Report button (or File/New/Report ), the 
Report Gallery appears. In the Report Gallery you will find a series of icons rep-
resenting the different types of experts that are at your disposal. 

Figure 3-2. The Report Gallery and Expert icons

Just click on the icon for the type of report you want to create. When the appro-
priate Expert dialog box appears, follow the steps outlined in the dialog box 
tabs.

If you want to simply build a new report based upon one that already exists, 
click the Another Report icon. The program will make a duplicate of the original 
report, which you can modify however you please to create your new report.

If you want to build a report from scratch, click the Custom button in the Report 
Gallery. Several Report Type and Data source icons will appear at the bottom 
of the Report Gallery; click the icons that are appropriate to your needs. 

Figure 3-3. Report type and Data Source icons
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The program will take you to a dialog box allowing you to select the data you 
need. Since building reports from scratch is the easiest way to learn about all 
the powerful features of Crystal Reports, this is the method we will discuss in 
the manual.

Data Dictionaries   

Instead of directly selecting a database for building a report, you may be able 
to select a Data Dictionary if your company uses Dictionaries. A Data Dictio-
nary is a one-stop, ready-to-use source of data that can be created using the 
Professional Edition of Crystal Reports. 

Data Dictionaries let you concentrate on the things that are important to you. 
They let you get out the reports you need in a hurry without your having to 
wade through extraneous information or deal with the complexities of locating 
and linking tables. 

There is nothing technical about using a Data Dictionary. The Dictionary 
Builder in your organization (usually the IS department or some other computer 
professional) does all the technical work for you. The builder:

� Gathers together tables, links, formulas, graphics, and/or report templates, 

� Selects the data that is important to you, and 

� Organizes (and renames it, if necessary) to make it easy to understand 
and to use. 

You get a Dictionary that contains only that data that's important to your spe-
cific needs. 

With a Dictionary, instead of searching multiple databases, struggling with 
links, building formulas from scratch, locating graphics, and decoding cryptic 
field names, you simply: 

� Select the pieces that you want, and 

� Build your report. 

It couldn't be easier. 
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Once you've selected your Data Dictionary, you select items for your report 
from the Insert From View dialog box.

Figure 3-4. Insert From View dialog

For more information on this dialog box, search for Insert from View in Crystal 
Reports. If you have the Professional Edition of Crystal Reports and want to 
learn more about creating Data Dictionaries, search for Data Dictionaries in 
Crystal Reports Pro Help.

Report templates    

Instead of starting from scratch when building a report, you might find it easier 
to begin with a template from a similar report that you created earlier. 

A template is a copy of a report. It contains all of the data, links, formulas, and 
graphics that your original has, but it isn’t tied to your original report in any way. 
It’s a separate entity. When you modify a template, your original report remains 
unchanged. 

Templates boost your efficiency. Use them whenever you think they can save 
you time. Here are some of the times templates will be useful: 

� When you need to create a new report with a different grouping or different 
record selection than an existing report, 

� When you need to create a series of reports, each a little different than the 
last, 
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� When you need to reconstruct a report based on an earlier time period 
using the same report structure you use today, and/or

� When you need to create an entirely new report based on a set of data-
bases that are linked in another report. You can create a template and 
delete the fields from the Design window without disturbing the underlying 
links. Then, without relinking, you can build your new report in a hurry. 

You'll probably find many other times that report templates will be useful. 

When you decide to build a new report based on a report template, you click on 
the Another Report icon in the Report Gallery. When the File Open dialog box 
appears, select the report of interest from that dialog box (search for File Open 
dialog box in Crystal Reports Help). The program opens the Design window 
with the template already in place. You don't need to select databases unless 
you want to add to those already activated. All you need to do is add, delete, 
and rearrange report elements until your new report is the way you want it. For 
more information on creating a report from a report template, search for Report 
Templates in Crystal Reports Help.

The Design window 

Once you select your database, Crystal Reports displays the Design window. 
You use this screen to insert and format data. 

Figure 3-5. The Design window
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When you open a new report, Crystal Reports automatically creates five sec-
tions in the Design window: 

� A Title section  - this section is generally used for the report title, and other 
information you want to appear at the top of the first page.

� A Page header section  - this section is generally used for field headings 
and other information that you want to appear at the top of each page. 

� A Details section  - this section is the body of the report. The bulk of your 
report data will generally appear in this section. 

� A Page footer section  - this section usually contains the page number 
and any other information that you want to appear on the bottom of each 
page. 

� A Summary section  - this section allows you to include a summary at the 
bottom of your report. You can choose to print the summary on only the 
first page, or on all pages.

Each section is separated by a section marker which displays the section 
name. 

� You build your report by inserting data fields, formulas, and other report 
elements (record counts, record numbers, etc.) in the Details section of the 
Designer. You use the Insert menu, in most cases, to select or create the 
elements you want to insert on the report. The Design window uses rectan-
gular element markers to indicate the size, position, and data type of the 
report elements you have inserted. 

� You add subtotals (and other group values) by selecting a field to subtotal 
and then telling Crystal Reports the conditions that are to generate a new 
subtotal or group value (change of customer number, change of sales rep, 
etc.) Crystal Reports creates group value sections as needed and places 
the group value in the section. Again, Crystal Reports uses rectangular 
field boxes to represent the group values. 

� You insert grand totals in the Grand Total section. This section appears 
when you select the field to total and then select Insert/Grand Total . Crys-
tal Reports uses a rectangular field box, this time to identify the field in the 
Grand Total section of the Design window. (Search for Insert Grand Total 
in Crystal Reports Help). 
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� You can add freeform text anywhere on the report by positioning the text 
cursor in the section in which you want the text to appear, typing in the text, 
and then using the TAB key to move it into position. You can also type free-
form text in a text field; this allows you to avail yourself of additional format-
ting options (alignment, hide options, etc.). 

Auto-scrolling capabilities   

The Design window has auto-scrolling capabilities. That is, whenever the cur-
sor hits one of the edges of the Design window when you are placing, resizing, 
or moving a field or drawing a graphic line or box, the Designer automatically 
scrolls to reveal more workspace (if more is available). 

Resizing sections   

The Design window first appears with default section sizes. You can expand or 
reduce report sections in one of three ways. 

� Dragging the lines that separate the sections. When you position the I-
beam cursor over one of those lines, the cursor changes to a double-arrow 
resizing cursor. Once that cursor appears, you can resize as needed.

" If you have fields in the section you want to resize, the program keeps 
the section large enough to hold the fields. For example, if you have 
three lines in a section with a field on each line, the program won't let 
you drag-resize the section smaller than three lines.

� Pressing the ENTER/BACKSPACE key. The ENTER key adds a line below the 
insertion point and the BACKSPACE key deletes the current line as long as 
the line is empty. If the line isn't empty, it moves the insertion point to the 
line above it. click the I-beam cursor to set the insertion point and use 
ENTER or BACKSPACE as needed.

� Using the Right mouse-button menu. To do this, place the cursor over the 
gray area at the left of the Design window or Preview window that corre-
sponds to the section you want to resize. Then click the right mouse-button 
and click Add Line to add a blank line to the bottom of the section. Click 
Delete Last Line to delete the bottom line in the section (provided the line is 
empty). 
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A word about databases, records and fields 

Before we go any further, a discussion of databases, records, and fields is in 
order. 

A record is the basic building block of a database. Each record contains data 
about a single entity (a customer, an order, etc.), and each database contains 
at least one record. The data in each record is stored in fields (holding spaces). 
Each field holds one piece of data known as a value. The database from which 
you will create a report is a collection of related records. A customer database, 
for example, is a collection of records that each contain data on a single cus-
tomer. 

Records and fields in row/column reports 

Think of the data in a database as being stored in horizontal rows and vertical 
columns.

The table above shows field values for four records from such a database (in 
this case a customer database).

� Each row represents one record. All of the data in that row is about a single 
customer, but the data is broken into three distinct pieces: customer num-
ber, first name, and last name. Each of those pieces represents a value 
found in a field on that record, the CustNumber, Fname, and Lname fields 
respectively (as indicated by the column headings). 

� Each column represents one field. All the data in a given column repre-
sents the values that appear in that field on each of the records in the data-
base. 

CustNumber Fname Lname

01034456 Bill Brown

01034457 Jane Doe

01034458 Bob Jackson

01034459 Mary Jones
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The structure of a row/column report corresponds to the structure of a data-
base with rows representing individual records and columns representing indi-
vidual fields.    

Data being used in a row/column 
report. Each row is a record and 
each column is made up of values 
from one field from multiple 
records.
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Records and fields in data block reports 

Some reports don't follow the row/column format, however. Some group 
related data in data blocks. A mailing list, for example, typically uses several 
rows for each record: a row for the company name, a second row for the street 
address, a third row for the city, state and ZIP code, etc. In such a report all the 
data for a given customer in the list appears in a block. Each block represents 
a single record even though the data in the block spans several rows.

Data being used in a data block 
report. Each customer entry is a 
record consisting of several fields.
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Records and fields in cross-tab reports 

 Cross-tab reports follow the row/column format but with a different twist. In a 
cross-tab report, the values from a single field are distributed among a number 
of columns with a value from that field appearing at applicable row/column 
intersections. For example, a report might have one customer for each row in 
the report and one part for each column. In such a report, the summarized field 
value (typically the quantity ordered or the dollar value ordered) appears at 
those row/column intersections that define customer purchases. Thus, in one 
compact report, an individual can rapidly compare customers and their order-
ing habits for specified parts. 

In this spreadsheet-like report:

� Each report row represents a single database record, 

� Each column represents some of the values from a single database field,

� The total at the bottom of each column represents the total of all the field 
values in the column,

� The total at the end of each row represents the total of all the field values in 
the row, and 

� The total at the lower right-hand corner of the report represents the total of 
all the field values in the entire report. 

Data being used in a 
cross-tab report. The 
report shows values from 
a single field (the 
summarized field) at 
row/column 
intersections. This makes 
it easy to make 
comparisons and spot 
trends.
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Data types    

The data type of a field, (string, number, currency, date, Boolean, or memo) 
determines the type of information that can be stored in that field and which will 
print in the report column. 

Fields of each data type display on your screen like this: 

Formatting, and record and group selection 

While formatting, and record and group selection will be covered in depth later, 
there are a few things about those subjects that are worthwhile to cover here: 

� Currency, date, and Boolean fields are shown above in the default format. 
This format is used for both the element markers (in the Design window) 
and for the report elements themselves (in the report). If you want your 
data to appear in a different format on your report, you can make the 
desired changes using the Format/Field  command. (Search for Format 
Field command in Crystal Reports Help).     

" The characters in the element markers change to reflect font changes 
and many formatting changes (alignment, etc.).

� The width and position of a field (when you place it in the Design window) 
determines the initial spacing between fields and the order in which the 
fields will print across the report page. 

XXXXXXX String - for example, a company name, account 
description or customer name.

$5,555,555.55 Currency (Paradox/Btrieve files only) - for example 
$500.00 or $50,000,000.00.

5,555,555.55 Number - for example 120 or 5555.

DATE/TIME Date - for example Oct 10 90.

YES/NO Boolean (YES/NO) data fields - for example, the result 
of a formula which compares a customer's credit limit 
to see if it is greater than $5000 and prints YES if the 
credit limit is more than that amount; NO if it is less 
than that amount.

XXXXXXX Memo a paragraph describing a piece of property, 
comments regarding a job applicant, a summary of a 
movie plot, etc. 
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� When you insert a data field in your report, Crystal Reports assumes that 
you want to pull data from all the data records in the selected database. To 
limit the records (or groups of records) used in your report, you need to tell 
Crystal Reports how to identify the records or groups of records you want 
to include. Using Edit Record Selection Formula or Edit Group Selection 
Formula on the Print menu, you can build the selection formula that fits 
your needs. (For more information, search for Edit Record Selection For-
mula and Edit Group Selection Formula in Crystal Reports Help.)

The Preview window    

When you want to preview your report before printing, use the program's Print 
Preview option. When you select this option, the program gathers the data, 
makes the necessary calculations, and displays the report in the Preview win-
dow on electronic “paper.” With the data in place, you can review the spacing 
and formatting of your report and see the actual results of all your summaries, 
formula calculations, and record and group selections. 

Fine tuning your data 

In true WYSIWYG fashion, you can also work directly on this live data, fine tun-
ing it until the report has the exact look and feel you want. You can: 

� Change fonts 

� Move and resize columns 

� Refine selection formulas 

� Add subtotals, sorts and grouping conditions 

� Select multiple fields using the SHIFT-CLICK combination or the lasso

� Move fields from one report section to another 

� Hide sections that you don't want to print 

� Format individual field types 

� Change the active printer 

� And more, all without leaving the Preview window. 

The Crystal Reports menus (both menu bar and pop-up), the Button bar, and 
the Format bar remain active, giving you essentially the same functionality you 
have when working with a template in the Design window. The Design window 
and the Preview window are tied together internally. Any changes you make in 
one are reflected in the other. 
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A different look and feel 

Working in the Preview window has a different look and feel than working in the 
Design window. 

Each field in a database contains dozens, hundreds, or even thousands of val-
ues, depending on the number of records in the database. When you place a 
field in the Design window, a single field box represents all those values. When 
you select the field, sizing handles appear on the box and the box changes 
color. 

In the Preview window, however, you are working with actual data. Instead of a 
field box representing many field values, the values themselves appear. When 
you select a field, a sizing box appears around every value from the field 
selected. Likewise, when you select a summary field, a sizing box appears 
around every related summary value. While the look and feel is different, the 
process of building and modifying a report is the same in both the Design win-
dow and the Preview window. You should find it easy to work with your reports 
in both places. 

No need to rerun the report 

When you print your report to the Preview window, the program retrieves the 
required data from the specified database(s). Depending on the size of your 
database(s) and the complexity of your report, this retrieval process can take 
anywhere from a few moments to an hour or more. If the retrieval process 
takes a long time, you clearly don't want to repeat it more often than necessary. 
The fine tuning capability in the Preview window was designed with this in 
mind. Here's how it works. 

Let's assume that you create a report that includes fields A, B, and C. When 
you call up the Preview window, the program retrieves the data in fields A, B, 
and C from the active database(s) and holds it temporarily with the report. As 
long as you're working with the retrieved data, you can manipulate it in any 
number of ways and the program will never have to go back to the database. 

If you want to add additional data once you're in the Preview window, however, 
you force the program to run the report once again. It has to go back and 
retrieve the original data as well as your new requirements. 
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Procedures that force the program to rerun the report include: 

� Adding databases, tables, links, or fields that weren't in the original report, 

� Adding formula fields referencing fields that weren't in the original report, 
and 

� Revising record selection criteria to include records not already included in 
your report. 

With some simple planning you can avoid these revisions and the extra pro-
cessing time they entail. 

1. Build your original report with all of the records, fields, and formulas that 
you think you might possibly need. This causes the program to retrieve all 
of the necessary data the first time it runs the report. (If you don't include 
everything in your final report, you've lost nothing.) 

2. Rework the report in the Preview window until you get it the way you want 
it. Since you brought in all the data the first time, there's no need for the 
program to go back and get it again. 

You can force the program to go back and get fresh data any time you want by 
using the Report/Refresh Report Data  command or by Clicking the Refresh 
(lightening bolt) button in the Preview window. 

Don't get carried away and try to include every possible database, field, and 
link. At some point your initial processing time penalty can outweigh any poten-
tial time savings you are seeking.

Drill down

Crystal Reports allows you to drill down to find the details behind summarized 
data. Follow the procedure below to drill down on a summary report.

Step Action

1. Open your report. The report must contain at least one summary field.

2. In the Design window, make sure the Details section is hidden.
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3. Print the report to the Preview window. 

Response : A summary report will appear showing summarized values 
for each group and a single Report tab appears at the top of the win-
dow. Since the details are hidden, a drill-down cursor replaces the nor-
mal arrow cursor. You use this new cursor for drilling down to get the 
details behind any group summary.

4. To drill down on a particular group, double-click any of the fields in the 
group of interest using the drill down cursor. 

Response : The program displays the details behind the group sum-
mary (a group details report) and it creates a new tab at the top of the 
window for the group you’re working with.

5. To drill down on another group, click the Report tab to return to the 
Summary report and repeat Step 4 for the new group.

Each time you drill down on a group, the program creates a new tab for that 
group. You can move to any detail report or return to the summary report sim-
ply by Clicking the tab for the report of interest.

If the program creates too many tabs to fit in the Preview window, it activates 
the two scroll buttons in the top right-hand corner of the window. You can use 
these buttons to scroll through the tabs to find the report that you want.

 When you close the summary report, you close all the detail reports as well.

The Record Counter 

When you're working in the Preview window, the Record Counter changes to 
let you know that you're working with existing data. 

When Crystal Reports displays a report in the Preview window, it sets the first 
column in the Record Counter to n of N, indicating 

� The number of records n that have been selected out of 

� The number of records N that have been read. 
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Saving your data with the report 

The program gives you the option of saving only the report definition or saving 
your data with the report as well. 

� If you save only the definition: 

� Your report will require less disk space (enough for the definition only), 
however, 

� You will need to rerun the report before you print it. 

� If you save your data with the report: 

� Your report will require slightly more disk space (enough for the report 
definition and the compressed data), however, 

� You won't need to rerun the report before you print it. 

If the report can run quickly, saving the data with the report may not be impor-
tant to you. But if your report takes time to run, you may find the Save Data with 
Closed Report option a real convenience. 

" Saving data with your report is also a good idea if you want to save the 
data for reference later. For example, if you run a report on a weekly basis, 
you might want to save the data with the report each week. With the data 
saved, you can make historical comparisons easily, working with the actual 
data that existed at the time each report was created.

When you open a report that you have saved with the data, the report template 
appears in the Design window followed by the Preview window displaying 
actual report data. The Date and Time displayed in the Preview window identi-
fies the data used in the report. 

Building your prototype 

Your main steps to build a report are: 

1. Select the database(s) you wish to use in your prototype report. 

2. Enter and position the data fields, text, and titles you want included in the 
title, header, footer, body, and summary of your report. 
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3. Print your report to the Preview window and review your work. 

4. Make whatever changes are called for. 

5. Insert your totals, subtotals and other group fields. 

6. Enter and position any formula fields that will calculate or manipulate data 
or create flags. 

7. Print your report to the Preview window and review your work. 

8. Format the report elements that you want to stand out in some way from 
the others. 

Selecting the database(s) 

Use the File/New Report  command to begin creating your report. When the 
Report Gallery appears, click Custom to build a custom report. When you click 
Custom, the Report Gallery expands, and you then select a Report Type and 
Data Source for your custom report (database, Data Dictionary, etc.) and the 
category of report you want to create (columnar report, cross tab report, etc.) 
Your selection here leads you to a dialog box from which you can select the 
first data source you wish to use. (For more detailed information, search for 
Selecting a database in Crystal Reports Help.)

� If you select a Data Dictionary as your data source, you select a view and 
then build your report using the report elements included in that view. 

� If you select a database as your data source and you want to activate addi-
tional databases as well, you use the Database/Add Database to Report  
command (search for Add Database to Report in Crystal Reports Help). 
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Visual linking

Use Visual Linking to link two or more databases together. When you select 
Database/Add Database  to Report from the menu, and select a second data-
base, you identify the linking fields in one database and drag it to the compan-
ion fields in the other to complete the link. (Search for Linking Databases in 
Crystal Reports Help).

Figure 3-6. Sample Visual link

Entering and positioning data fields 

You enter and position data fields using the Insert/Database Field  command 
(search for Insert Database Field in Crystal Reports Help). This command 
takes you to a dialog box that lists available fields in the selected database. 

" When you create a new report and select your first database, the program 
automatically displays the Insert Database Field dialog box, ready for you 
to use for selecting fields. When you select a Data Dictionary as your data 
source, the program displays the View Insert dialog box from which you 
can pick the various elements you want to appear on your report. 

You make your selections from the list, and then you: 

� Drag and drop each field onto your report, or 

� click Insert (or double-click the field) and place it using a rectangular place-
ment cursor. 
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You can also select multiple fields from the list and drag and drop them on the 
report at one time. When you do, the fields will appear in the report side-by-
side in the same order they appeared in the dialog box.

Making changes   

You move a database field in one of three ways: 

� Dragging it to a new position with the mouse, 

� Selecting it and using the arrow keys, or 

� By selecting the field and moving the bar on the ruler that corresponds to 
the selected field. 

You can move a field within its originating section or to other sections of your 
report if you wish. (Search for moving fields in Crystal Reports Help). You 
delete a field by selecting it and then pressing the DELETE key. 

Notes

To select multiple fields at one time, press the SHIFT key and, while keeping it 
depressed, click the various fields you want to select. Handles will appear on 
each field selected. When finished, you can move or delete the selected fields 
as a group, change the font, field formatting, etc. 

You can also select multiple fields, or individual fields for that matter, by sur-
rounding the fields in the selection 'lasso.' You activate this lasso via the Edit/
Select Fields  command or by clicking the lasso button on the button bar. (For 
further information on the selection lasso, search for Select Fields in Crystal 
Reports Help.)

Still another way to move objects is by using the positioning wand in Crystal 
Reports. 
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Follow the procedure below to move an object using the positioning wand.

Step Action

1. Click on the object(s) you would like to move.

Response : A wand with arrows on either side appears directly below 
the ruler.

2. Move the cursor directly over the wand until it becomes a Grabbing 
Hand cursor.

Figure 3-7. The Grab Hand cursor

3. Drag the positioning wand to the desired position. Use the increment 
marks on the ruler and/or the Status bar coordinates at the bottom of 
the screen as guides for making the exact placement.

Adding text 

You can add text to your report by typing it at the text cursor and then moving it 
into place. You move the I-beam cursor to the line on which you wish to enter 
text and click the left mouse button to set the text cursor at the left edge of the 
Design window. Then you simply type in your text, move the I-beam cursor in 
front of it, and push it into position using the TAB key or SPACE BAR. You can 
also add text by inserting text fields and positioning them as you would any 
other field (see Inserting Text in Private Tutor). 

Entering field titles 

By default, Crystal Reports automatically inserts a field title whenever you 
insert a new field or formula field. The title is a text field that can be edited. The 
left edge of the title field is aligned with the left edge of the field it identifies. To 
turn this feature off, select the Layout tab in File/Options  and toggle the Show 
Field Names checkbox off.
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Entering a chart/graph

Crystal Reports offers you several formats and options for adding charts to 
your reports. You can select the Type of chart, the Layout of the chart, the Text 
to be used in the chart and Options for the chart. The charting feature and 
charting options are available from both the Design window, and the Preview 
window.

To insert a Chart/Graph, select Insert|Graph/Chart , or click on the Graph/
Chart button on the button bar. The Graph/Chart Expert dialog box appears 
with the Type tab selected.

Figure 3-8. The Graph/Chart Expert dialog

" For the Chart feature to be available, you must have a report open in either 
the Design window, or the Preview window, and a summary field in the 
report. If there is no report open, Crystal Reports will not insert a chart 
when you select the chart feature.

Click on the Type of chart that will illustrate your data best. Click OK and Crys-
tal Reports inserts the chart in your report and returns you to the report with the 
chart selected and resizing handles visible. You can now move the chart any-
where in your report, and resize the chart if necessary. (For more information 
about graphs and charts, search for Graph Command in Crystal Reports Help.)
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Placing totals, subtotals, and other group values 

You place grand totals by selecting the numeric or dollar field you want to total, 
and then selecting Insert/Grand Total  (search for Insert Grand Total in Crystal 
Reports Help). 

You select group values (subtotals, group averages, group counts, etc.) by first 
selecting the field you want grouped. Then you select the kind of group value 
you want, using the Insert/Subtotal or Insert/Summary  commands (search 
for Insert Subtotal or Insert Summary in Crystal Reports Help). You select the 
kind of group value you want (if you selected Insert/Summary ). Then you 
select the field that the program uses to sort and group your data by and the 
sort direction. 

Moving group values 

You move a subtotal or summary by dragging it to a new position with the 
mouse, or by selecting it and moving it with the arrow keys, or by selecting it 
and moving the bar on the ruler that corresponds to the selected field. You can 
move subtotals and summaries only within their originating sections, or from 
the group footer section to the group header section for the subtotal or sum-
mary of interest. 

Arranging data automatically 

When you place a field on your report, Crystal Reports allocates a space equal 
to the field width as specified in your database. Often that field width is far 
larger than the values that actually appear in each of the fields. For neat look-
ing reports, it is often necessary to resize the fields so the space allotted more 
closely matches the size of the field values. Once you've resized the fields you 
often need to reposition them for proper balance. 

To save you time, Crystal Reports 4.5 includes an “Auto Arrange” capability 
that: 

� Adjusts the spacing between fields, 

� Repositions the fields, and then 

� Centers your report on the page, automatically.
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Follow the procedure below to use this capability.

Step Action

1. Create your report as you normally would.

� Select and position report fields.

� Build and place report formulas.

� Group and summarize the data the way you want it.

2. Click the Auto Arrange button, located at the bottom of the Design or 
Preview window.

Entering formulas 

You enter formulas using the Insert/Formula  command (search for Insert For-
mula in Crystal Reports Help) That command calls up the Formula Editor. 
Using the Formula Editor, you build your formula using fields, functions, and 
operators, and check your work using the built in formula checker. 

Formatting 

You can change the font or point size using the Format/Font  command. You 
can change the alignment and printing characteristics of field data using the 
Format/Field  command, and you can change the conditions that trigger subto-
tals, add page breaks, suppress blank lines, hide selected sections, etc. using 
the Format/Section  command. (For more information on these commands, 
search for Format Font, Format Field, and Format Section in Crystal Reports 
Help). 

Once you have built a prototype report, you have a working model that you can 
customize to meet your specific needs. 
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Manipulating Data with Formulas and Functions 

Crystal Reports uses formulas and functions to help you create reports more 
quickly and easily. It uses them also to allow you to do the kind of “number 
crunching” and data manipulations that are necessary for advanced reporting.

Formulas 

A formula is a set of instructions that may be used to calculate information you 
can't obtain directly from database data fields. For example: 

� A database record may have a Qty1  field and a Qty2  field but no field that 
sums both quantities. If you want the sum of these two fields to appear on 
your report, you need a formula that adds the value in one field to the value 
in the other. 

� A database record for a sales rep may contain the field GrossSales  and 
you want to use 120% of that gross as the sales quota for the following 
year. To accomplish this you need a formula that multiplies GrossSales by 
120%.

� A database record for a one product company may contain a field Reve-
nue  that expresses total dollar sales for the year. You're interested in 
determining the number of units sold based on an average price of $49.95 
per unit. To accomplish this you need a formula that divides Revenue by 
$49.95.

All of these examples require simple formulas: {file.Qty1} + {file.Qty2} , 1.20 * 
{file.GrossSales} , and {file.Revenue}/49.95  respectively. These formulas all 
use Crystal Reports operators (+, * [multiply], / [divide]) and they're all easy to 
create and understand. 

But not all of your information needs can be reduced to simple formulas; some 
needs require extensive calculations or manipulations. For example: 

� You want to determine your average monthly unit sales for the last year, 
rounded to the nearest unit. 

� You want to convert ounces of inventory to pounds and ounces, and have 
it appear in the format x pounds y ounces . 
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The formulas required to accomplish these activities require a fair amount of 
data manipulation: rounding, averaging, converting numbers to text, calculating 
remainders, etc. While some of the manipulations (averaging, calculating 
remainders) can be done using Crystal Reports operators alone, others can't 
be done without the use of functions. And even the ones that can be done with-
out functions can be done more quickly and efficiently with them. (For addi-
tional information on formulas, see Chapter 5, “Using Formulas,” of this manual 
or search for Formulas in Crystal Reports Help.)

Functions 

A function is a preset procedure or subroutine used to evaluate, make calcula-
tions on, or transform data. For example: 

� The NumericText function evaluates the contents of a text field to see if it is 
a number, and 

� The UpperCase function transforms all lowercase characters in a string to 
uppercase. 

When you specify a function, Crystal Reports performs the set of operations 
built into the function without you having to specify each operation separately. 
For example: 

� The Average function sums a list of values and divides the sum by the 
number of values in the list. 

� The DayOfWeek function extracts the day component of a date, deter-
mines the day of the week the date falls on, and converts the day of the 
week to a number (1-7) where Sunday is the first day of the week. 

By performing multiple operations with a single command, these kinds of func-
tions are a kind of shorthand that make it easier and less time consuming for 
you to create reports. But not all functions involve lengthy calculations; some 
simply allow you to do things that you couldn't do easily without them while oth-
ers take the drudgery out of report creation. For example: 

� The ToNumber function converts a number that has been stored as text, to 
a number that can be used in calculations, and 

� TrimRight removes all the spaces to the right of a string of data stored left-
justified in a database. 
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How functions are used 

Functions are used in formulas. In fact, a single function and it's required argu-
ment(s) may be the entire formula. For example,

Abs ({file.TestResult})

is a perfectly acceptable, stand-alone formula for calculating the absolute value 
of the field TestResult. 

Function syntax 

Each function comes with its own set of usage rules (syntax). These rules must 
be followed for the function to perform correctly. If they are not, Crystal Reports 
displays a Formula Compiler Error message.

As an example, the correct syntax for using the Average([array]) function is:

Average ([array])

where array is an array of constants, field values or calculation results, sepa-
rated by commas. 

Translated, this means that to use the Average([array]) function correctly, you 
should enter: 

Average 

followed by a list of numeric values, separated by commas, with the list of val-
ues enclosed in brackets, and with the array enclosed in parentheses. Thus:

Average ([1,2,3,4,5]) 

is an example of the correct way to use the Average([array]) function.
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If you try to use the function:

� Without separating the values by commas,

� Without enclosing the values in brackets, 

� Without enclosing the array in parentheses, 

� While including any unnecessary characters, or 

� With values that are not numeric.

Crystal Reports won't accept the formula and will display a Compiler Error mes-
sage identifying your error. (For additional information on functions, search for 
Functions in Crystal Reports Help.)

How formulas and functions are entered 

Formulas and functions are entered via Crystal Reports' Formula Editor.

Figure 3-9. The Edit Formula dialog
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The Formula Editor is a dialog box that contains all the tools you need to create 
and check the correctness of formulas. Using the Editor, you:

� Assign a name to your formula, 

� Enter the formula, 

� Check it to make sure you have entered it correctly, and then 

� Accept it for use in your report. 

When you accept it, Crystal Reports places the formula in your report in the 
position you selected for it. Then, when you print the report, Crystal Reports 
prints the results of the formula instead of the formula itself.

The Fields box 

You can enter fields into your formulas in two ways: via the Fields box, or man-
ually.

� To enter a field via the Fields scroll box, you move the I-beam cursor to the 
place you want to insert the field and click the left mouse button to set the 
text cursor at that point. Then you locate the field you wish to insert from 
the Fields scroll box list.

� Fields already in use in the report are grouped at the top of the list; 
other available fields follow. 

� Formulas you have entered are listed next, their names preceded by 
the @ sign.

� All other fields available in the active databases are listed last, grouped 
by database.

Select a field. Crystal Reports inserts the selected field (complete with the 
required syntax elements) at the text cursor.

" You select an item from the Formula Editor scroll boxes (Fields, Func-
tions, or Operators) by double-clicking it, or by Clicking it once to high-
light it and then clicking the Select button at the bottom of the Editor to 
complete the selection process.
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� To enter a field manually, you locate the text cursor in the appropriate posi-
tion and type in the field name as you would any text. 

� The correct syntax for a database field name is: 

{file.fieldname} 

If you: 

� Don't include the file name,

� Leave out the separating period, or 

� Fail to surround the expression in braces, 

Crystal Reports will generate a Formula Compiler Error message detailing 
your error.

� The correct syntax for a formula field is:

{@formulaname}

Operators and Functions boxes 

You can also enter operators and functions into your formula in one of two 
ways: manually or via the Operators and Functions scroll boxes. 

� To enter an operator or function manually, you locate the text cursor in the 
appropriate position and type in the operator or function as you would any 
text. 

� To enter an operator or function via the lists in the Functions and Operators 
scroll boxes, you set the text cursor where you want the entry to appear in 
the formula. 

Then you select the item of interest from the scroll box lists. Crystal 
Reports inserts the selected item in your formula, complete with any paren-
theses, brackets, or commas required.
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Notes

For an array of items, only the first comma is included. As you enter additional 
items into an array, you will need to type in commas to separate the items.

You can resize the Formula Editor’s Fields, Functions and Operator boxes to 
suit your needs. Simply place your cursor over the edge of one of the boxes 
until the normal cursor turns into Double-cursor , click on the box, and drag it 
to the desired size.

Order of precedence 

When entering formulas that contain different kinds of operators, it is important 
to consider order of precedence, the order in which Crystal Reports performs 
the operations in your formula. 

You learned simple order of precedence in high school math: when performing 
calculations, do multiplication and division first, then addition and subtraction. 
Thus:

5 + 10 X 3 = 35

The calculation 10 x 3 is performed first to get 30. 30 is then added to 5 to 
arrive at the final answer.

Now, if your intention is to add 5 to 10 and then multiply the sum by 3, you have 
to modify the order of precedence with parentheses. You can do that thus:

(5 + 10) x 3 = 45

It's clear that parentheses have a higher precedence than the add, subtract, 
multiply, and divide operators. They redirect the order of calculation.

You learned all of this in school and Crystal Reports follows the same rules of 
precedence. But Crystal Reports uses many additional operators, and it's 
important for you to understand the precedence Crystal Reports assigns to 
each so you can write your formulas to perform as expected.

� In the following list, Crystal Reports performs the top level operations first, 
then the second level, then the third, and so forth.
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� When it encounters two or more operations that are on the same level, it 
performs them left to right. 

For a complete discussion of precedence (with examples), search for Order of 
precedence in Crystal Reports Help.

Using dates in formulas 

Crystal Reports includes many useful functions for including dates and date 
ranges in formulas; you can learn more about those functions by searching for 
Functions in Crystal Reports Help. At this point, however, it's useful to know 
how to enter any date into a formula. 

You enter a date simply by entering the Date function (manually or via the 
Function button) and then providing the date of interest in the parentheses that 
follow in the form YYYY,MM,DD (1992,01,01 = January 1, 1992). 

The Formula checker 

The Formula Editor also contains a formula checker which checks the syntax of 
your formula. If the syntax is incorrect, the formula checker points out the loca-
tion of the problem and tells you what the problem is. You activate the formula 
checker by selecting the Check button. Crystal Reports also checks the for-
mula automatically when you choose Accept. 

Level 1 Parentheses, Array, IfThenElse

Level 2 Call, Subscript

Level 3 Identity, Negate, Dollar, Not

Level 4 Multiply, Divide, Percent

Level 5 Add, Subtract

Level 6 To

Level 7 Less than, Greater than, Greater than or equal, Less 
than or equal, In

Level 8 Equal, Not equal

Level 9 And

Level 10 Or
User’s Guide 100



Using Crystal Reports
Manipulating Data with Formulas and Functions3
When debugging formulas, especially if you have entered them manually, look 
carefully for the following: 

� Missing quotation marks around text strings, 

� Missing database name accompanying field names,

� Missing braces around database name/field name combinations,

� Missing closing parentheses to match opening parentheses, 

� Case differences (the Formula Checker is case sensitive), 

� If-then-else formulas that use different data types for the then and else 
actions, and

� Using X instead of * for multiplication.

The Formula Editor is easy to use and can be called up by selecting Formula 
from the Insert menu.

Developing complex calculations with formulas 

Crystal Reports allows you to combine fields, functions, and operators to cre-
ate complex calculations and manipulations of data. For example, to test the 
drawing power of two different offers, you can use a single Crystal Reports for-
mula to send one offer to all customers with an even customer number and a 
second offer to all customers with an odd customer number. You can do some 
remarkable manipulations using Crystal Reports formulas.

Building formulas for complex calculations is an advanced topic. To see sev-
eral examples of formulas created in Crystal Reports, please refer to the For-
mulas in Action topic in Crystal Reports Help. This topic presents a number of 
complex formulas that combine multiple functions and operators to solve real-
world reporting problems.
User’s Guide 101



Using Crystal Reports
Grouping, Summarizing, and Sorting your Data3
Grouping, Summarizing, and Sorting your Data 

Crystal Reports allows you to group, summarize, and sort your data to achieve 
the reporting results you want.

Grouping the data 

A group is a set of records that are related to each other in some way. In a cus-
tomer list, for example, a group could consist of all those customers living in the 
same ZIP code, or in the same state. In a sales report, a group could consist of 
all the orders placed by the same customer, or all of the orders generated by a 
specific sales rep. 

Breaking data into groups (and then doing something to evaluate the group 
data, if you wish) is a key part of effective reporting. In fact, it's what separates 
a report from being just a presentation of raw data, and makes it a valuable 
communication tool instead. Crystal Reports allows you great flexibility in 
grouping data. It also gives you the ability to create a number of different kinds 
of group values.

Group values 

A group value is the value generated as the result of an evaluation, a tally, or a 
calculation performed on data from a single group. A subtotal is one kind of 
group value; it is the sum of all of the values from a single field, from all the 
records in a group. In a sales report, for example, if you subtotal sales by sales 
rep, Crystal Reports gathers all the records that belong to the sales rep and 
totals the sales amounts from all the records. In a group average, Crystal 
Reports averages the values in a group of records; in a group count, it counts 
the values in a group of records, etc. Group values are important tools for cre-
ating powerful reports. Crystal Reports gives you several alternatives for work-
ing with group data. It enables you to:

� Calculate the sum of values. 

� Calculate the standard deviation or variance of the values.

� Average the values. 

� Count the values.

� Determine the highest value.

� Determine the lowest value in the group.
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Grouping data with Crystal Reports 

While there may be many data fields on a report, there is typically only one field 
for which you are interested in grouping the data. In a sales report, for exam-
ple, it would probably be the field listing the amount of sales; in a commission 
report, it would probably be the field listing the amount of commission, etc. To 
group data you first select the field you want to group together.

Once the field is selected, you select the action you want to take on each group 
of data from that field:

� If you want to simply group the data and take no further action, you can 
select Insert/Group .

� If you want to subtotal it, you can select Insert/Subtotal . 

� If you want to average, count, or determine the maximum or minimum 
value, you can select Insert/Summary .

Subtotals and summaries make up the category of group fields (search for 
Insert Group, Insert Subtotal, and Insert Summary in Crystal Reports Help.

" The Insert/Subtotal  command is simply a shortcut for setting up a sum-
mary that adds the values in each group.

Once you have selected the group field and the action, you select another field 
(a sort and group by field) that triggers a grouping whenever its value changes. 
In grouping your data by state, for example, you would use the state field to 
create a new group (and generate a group value if selected) whenever the 
state changes. Likewise, the ZIP code field would trigger a grouping whenever 
the ZIP code changes.

Once you've made these simple selections, Crystal Reports does the rest. 
Your data will be grouped, and the group value (if you have selected one) will 
be calculated and will accompany each group.
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Summarizing the data 

Crystal Reports provides three easy-to-use summarizing options:

� Grand Total. A grand total adds all values in a field for the entire report 
and prints the sum on the last page.

� Subtotal. A subtotal is a partial total, a total of a specific, limited group of 
data in a field.

� Summary. A summary summarizes field data from a specific, limited group 
of records. It can total the data like a subtotal, but it can also average the 
values, count the values, or determine the highest or lowest value in each 
group or field.

All of these options are available on the Insert menu.

The summarizing process 

The process of summarizing the data on your report follows these steps:

1. Selecting the number or dollar field you want to summarize.

2. Selecting the summarizing option you want from the Insert menu.

3. Finally, if you select Subtotal or Summary as a total type, the process will 
also include the following step:

4. Selecting the data field that triggers a new subtotal/summary whenever its 
value changes.

Selecting a field to total 

To select the field you want to summarize, you click on it with a mouse. Crystal 
Reports puts handles on the selected marker to highlight it as selected.

Selecting a total type 

To select a total type, you select it from the Insert menu or pop-up menu.
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Selecting a field to trigger a new subtotal 

If you select Subtotal or Summary as a total type, Crystal Reports asks you to 
indicate the field that is to trigger a new subtotal/summary whenever its value 
changes.   

" For additional information on subtotaling and summarizing data, please 
see Private Tutor.

Sorting 

There is a logic to the way values are arranged when they appear in a column 
on your report. Initially, they are arranged in the same order as the data 
appears in your database. But data can be sorted in a variety of ways:

� A mailing list, for example, could be sorted in ascending order, on the ZIP 
code field; that is, the customers would be sorted so that those with the 
lowest ZIP codes would appear first and those with the highest ZIP codes 
would appear last. 

� It could also be sorted in ascending alphabetical order, on the last name 
field; that is, customers with last names beginning with A would appear first 
and those with last names beginning with Z would appear last. 

� It could also be sorted by street address or customer first name if you had 
some practical reason for doing so. 

Crystal Reports gives you the opportunity to change the existing sort order 
using the Report/Record Sort Order  command. (Search for Record Sort 
Order command in Crystal Reports Help.) 

Sorting by record 

When you use the Report/Record Sort Order  command, Crystal Reports asks 
you to select two things:

� The field you want your sort to be based on (sort field), and

� The sort direction.
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Sort field 

A sort field is a field that determines the order in which data appears on your 
report. Crystal Reports sorts field data using Windows' sort comparison algo-
rithms, and it uses rules specific to the Country you select in the International 
section of the Windows Control Panel.

You can use any field as a sort field. A field's data type determines the method 
in which the data from that field is sorted: 

Text  

Text fields are sorted in the following manner:

� One character values are sorted so that blanks have the lowest value, then 
punctuation, then numbers, then uppercase letters, and finally lowercase 
letters. 

� Then two character values are sorted, then three, etc. using the same 
rules. As a result:

� “BOB” comes before “bob”, 

� “123” comes before “124”, 

� “ “ (blank) comes before “a”, and 

� “aa” comes before “aaa” 

Dollars  

Dollar fields are sorted in numeric order.

Number  

Number values (120, or 5555) are sorted in numeric order.

Dates  

Date fields are sorted in chronological order.
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Booleans

Comparison fields are sorted so that false values come first, then true. 

When you select a sort field, Crystal Reports sorts the values from that field.

Sort direction 

Direction refers to the order in which the values are printed, once sorted. 

� Ascending order means smallest to largest, 1 to 9, A to Z, False to True.

� Descending order means largest to smallest, 9 to 1, Z to A, True to False.

� Specified order means user-defined.

� Original order means how data is currently organized in the database.

For further information on sort direction, refer to Crystal Reports Help.

Single field sorts 

Single field sorts are sorts in which all the data in the report is sorted based on 
the values in a single field. Sorting an inventory report by stock number and 
sorting a customer list by customer number are examples of single field sorts. 

Multiple field sorts 

In multiple field sorts, Crystal Reports first sorts the entries (alphabetic or 
numeric) in the first field selected, putting them in ascending or descending 
order as specified. Then it sorts any entries in the second field that can be 
sorted without disturbing the sort order of entries in the first field. It then sorts 
any entries in the third field that can be sorted without disturbing the sort order 
of the entries in the first two fields. It follows the same pattern for sorting addi-
tional fields.
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Sorting groups 

Crystal Reports allows you to change the order in which groups appear on your 
report. You can:

� Base the sort on any group (subtotal or summary) in your report, and

� Sort your report so that group field values appear in ascending, descend-
ing, specified or original order.

You change the sort order using the Report/Group Sort Order  command. 
(Search for Group Sort Order command in Crystal Reports Help). When you 
sort by group, nothing happens to the sort order of the records within a group; 
only the relative positions of the groups themselves change.

" For additional information on sorting and examples of single field, multiple 
field, and group sorts, please see Private Tutor.
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Editing and Formatting the Data 

Crystal Reports makes it easy to edit and format your data. The editing/format-
ting process follows these steps:

1. Selecting the data you want to edit or format.

2. Selecting the editing or formatting action you want to take place. 

3. Entering the specifics of the action in the dialog box/editor if/when it 
appears.

Selecting the data 

To select the data element you want to edit or format, you click on it with your 
mouse. Crystal Reports draws handles on the element marker to highlight it as 
selected.

Selecting the action 

Once the element is selected, you select the editing or formatting action from 
the Edit or Format menus. For example:

� To change the font used to print the data, select Font from the Format 
menu,

� To hide the field when printing, select Field from the Format menu, or

� To modify a formula, select Formula from the Edit menu.

For detailed instructions on making these changes, search for Format Font, 
Format Field, and Edit Formula in Crystal reports Help.
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Entering the specifics

In those cases where a dialog box or editor appears after you've selected an 
action, you enter the specifics of that action in the window that appears. For 
example:

� In the Font dialog box, you enter the font and point size you wish to use, 
and indicate whether you want the data to appear in boldface or italics, or 
whether you want it to be underlined or overprinted with the strikeout char-
acter, and

� In the Formula Editor, you make the changes you want to the formula that 
appears, check those changes if you wish, and accept the revised formula 
when you're finished. 

Crystal Reports takes it from there and performs the action you selected.

" In some cases you have to specify a second action to complete the editing 
change desired. For example, to move some text in your report, you first 
cut the text from its current position, and then you paste it in its new posi-
tion. In such a case you select the data and then the action (Cut) to cut the 
text to the clipboard. Then you mark the new position using the insertion 
pointer and select Paste to insert the text in the new position.
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Adding Graphics and OLE Objects   

Crystal Reports enables you to add a number of graphic enhancements to your 
reports. You can add: 

� Lines and boxes to group or separate your data, to emphasize items, or to 
create simple graphic designs, (Search for Insert Line command and Insert 
Box command in Crystal Reports Help.)

� Borders and colors to clarify or call attention to individual report elements 
and to make your report more visually pleasing, (Search for Format Border 
and Colors command in Crystal Reports Help.)

� Bit-mapped graphics to display your company logo, product pictures, or 
other artwork, and

� OLE objects to embed or link images and data from spreadsheets, paint 
programs, graphing programs, and other OLE 1 and OLE 2 object applica-
tions. Once you have placed an OLE object, you can edit it in its originating 
application simply by double-clicking the object. 

Add the graphics and OLE objects you need. With some careful planning and 
some creativity, you can make your reports more pleasing to read and you can 
deliver your data with more impact. (See Topics on Graphics and OLE in Pri-
vate Tutor)
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Specifying Records/Groups to be Included 

When you select a field to appear on your report, Crystal Reports, by default, 
prints field values from every record in the selected database. But in many 
cases you may not want to include all the values, but only a specific range of 
values. For example, you may want to include only a specific group of custom-
ers or a specific range of account numbers out of the total number of values in 
the database. Or you may want to include values from only those records that 
fall within a particular date range. With Crystal Reports this is easy. The pro-
gram includes a number of commands on the Report menu for restricting your 
report to specific records or groups of records: 

� Select Records Expert . This option allows you to limit your report to spe-
cific records or groups that fit a condition or conditions you specify. It auto-
matically builds a selection formula using your responses to dialog box 
questions. If you have a record highlighted when you call up this com-
mand, the dialog box comes set for selecting records. If you have a group 
highlighted, the dialog box comes set for selecting groups. This option 
requires no knowledge of the Crystal Reports formula language. (Search 
for Select Records command in Crystal Reports Help). 

� Edit Selection Formula/Record. This option also allows you to limit your 
report to specific records that fit a condition or conditions you specify. It 
takes you to the Formula Editor where you can manually build a record 
selection formula to fit your needs. This command is intended for users 
who are familiar with the Crystal Reports formula language. (Search for 
Edit Record Selection Formula in Crystal Reports Help).

� Edit Selection Formula/Group. This option also allows you to limit your 
report to specific groups of records that fit a condition or conditions you 
specify. It takes you to the Formula Editor where you can manually build a 
group selection formula to fit your needs. This command is intended for 
users who are familiar with the Crystal Reports formula language. (Search 
for Edit Group Selection Formula in Crystal Reports Help).

You select the command, specify the records or groups of records you want 
included, and your report prints using only the selected records or groups.
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Printing the Finished Report 

When you want to print your report or when you want to see what your report 
will look like when printed, you can use the six printing options:

� Printing your report using a subset of the data. When designing the report 
you can print only a page or two of data to see how the report looks and 
then print the full report when everything is ok. (Search for Preview Sample 
command in Crystal Reports Help.)

� Printing to the printer for hard copy output. (Search for printing your report 
in Crystal Reports Help.)

� Previewing and fine tuning your report in the Preview window. (Search for 
printing your report in Crystal Reports Help.)

� Printing to a disk file for use with other applications or to E-mail to someone 
else. (Search for printing your report in Crystal Reports Help.)

� Printing the report definition. (Search for printing the report definition in 
Crystal Reports Help.)

� Printing your report to an executable file. (Search for executable file in 
Crystal Reports Help.)
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Distributing Reports

Crystal Reports uses a variety of different files to create reports to your specifi-
cations. The files are determined by your reporting requirements.

When you want a report to run on another machine that doesn't have Crystal 
Reports installed, it is necessary for you to supply all of the files that are 
required to run the report. Crystal Reports 4.5 Distribute Reports capabilities 
makes it easy for you to assemble all of the appropriate files.

Distribute Reports is available two ways: 

� Linked to the Report/Compile Report command  
When you compile a report for distribution, the program asks you if you 
want to distribute the report once it's compiled. If you do, it calls up the 
Report Distribution Expert when the compiling is complete.

� As a stand-alone menu command (Report/Report Distribution Expert) 
Whenever you want to distribute a saved report, you can call up the Report 
Distribution Expert to pull together the files you need to distribute with the 
report.

The Report Distribution Expert asks you what reports you want to distribute, if 
you want to include database files and formatting DLL's, and where you want 
the distribution files sent. Then, when you tell it to build, it builds a list of all the 
required files for your review. You review the list, remove the files you don't 
want to distribute, add any additional files that the distribute report processor 
hasn’t determined to be necessary but you would like to ship, and then send 
the selected files (including your report[s]) to your distribution destination. It's a 
very simple procedure.

The Distribute Reports expert: 

� Ships data with the report if required 

� Compresses the component files, and 

� Builds a setup.exe file.
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The user can use the setup.exe file to install the report(s) you're distributing. 
The user runs setup.exe like any other setup program. Crystal Reports decom-
presses the files, installs them where the user wants them, and even creates 
an icon for calling up the report.

You can use the Distribute Report Expert whenever you: 

� Compile reports.

� Save reports to a disk file for distribution.

� Send a report to a network drive so many people can use it.

� Ship reports with an application you develop using the Crystal Print 
Engine.

It's a valuable tool for anyone who creates reports for others. 
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4Tutorial—Movie List
Overview

The following tutorial has been designed to give you confidence when creating 
your first reports with Crystal Reports. 

You begin by learning the basic concepts - calling up a database, placing some 
fields on your report, and understanding the grid that controls the placement of 
report elements.

You will also learn how to: 

� Navigate that grid using both the mouse and the keyboard.

� Move and delete fields. 

� Get the data fields lined up the way you wish. 

� Display your report to the Preview Window so you can fine-tune your work.

� Summarize data.

� Limit the records you want included in the report.
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Notes to consider

For the purposes of standardizing this tutorial over the widest variety of com-
puter systems, we recommend that you activate the PostScript printer driver 
before you begin. You can activate that driver via the Printers icon in the Win-
dows Control Panel. If you don't have the PostScript driver installed on your 
system, Click the Add Printer button in the Printers dialog box and install a 
PostScript printer from the list that appears. If you don't have a PostScript 
printer, you won't be able to print your tutorial reports on paper, but they should 
print to the Preview Window just fine.

This tutorial assumes you are familiar with Microsoft Windows and uses con-
ventional names and procedures common to the Windows environment. If you 
are not familiar with Windows, you may have trouble understanding basic pro-
cedures such as scrolling and clicking. Please refer to the documentation that 
came with Microsoft Windows for further explanation of these procedures.

The term Click used throughout this tutorial, unless otherwise stated, means to 
press down on the left button on your mouse or trackball, then release the but-
ton. Drag means to press down on the left mouse button and hold the button 
down while you move the mouse.

The Times New Roman font has been used in creating the report in this tuto-
rial. If that font is not available to you, you can use any font you choose. Be 
advised, however, that field size, field spacing, and screen displays will be dif-
ferent with a different font. In this tutorial we use 10 point Times New Roman 
for standard report data. 

Make sure that the default font for all report sections is set to 10 point Times 
New Roman before beginning this tutorial. For instructions on doing this, 
search for Font Options in Crystal Reports Help. 
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Movie List Report

An example of a basic business report is a Movie list; a list of Movie titles and 
related information. 

� We're going to learn first how to create a rows and columns list, with one 
movie (record) per row.

� Then we're going to see how to convert that list into a different format, with 
all of the data about each movie grouped in a block, similar to a mailing 
label.
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Getting Started

This section introduces you to the Crystal Reports environment and shows you 
how to begin putting together a simple report. In this section, you'll learn about:

� Crystal Reports' screen, Menu bar, Button bar, Format bar, and Status bar,

� The Design window and how it's designed for ease of use,

� The field box that Crystal Reports uses in the Designer to represent fields 
and formulas, 

� The grid that helps you place report elements with precision, and

� The concept of “snapping to grid.”

You'll also learn how to:

� Activate a database for use in the report,

� Select fields from the activated database,

� Place report elements where you want them to appear on a report, and

� Reposition report elements to fit your needs.

We'll begin at Crystal Reports' main screen.
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Crystal Reports' main screen 

Use the procedure below to use Crystal Report’s main screen.

Step Action

1. Double-click the Crystal Reports icon.

Response : The Crystal Reports' window appears. You'll see the Crys-
tal Reports title bar at the top of the screen, the Menu bar below it, the 
Button bar immediately below the Menu bar, and the Format bar and 
the Status bar at the bottom of the screen.

" If you have not yet registered your copy of Crystal Reports, the 
Registration screen will appear before the Crystal Reports window. 
Follow the directions on the Registration screen to register your 
copy of Crystal Reports. Registering your software provides you 
with Customer Support from qualified technicians when needed 
and free information about upgrades in the software.

The Menu bar along the top of the screen contains all of the com-
mands you need for creating your reports. 

2. Click on each of the menu names in turn to get a brief overview of the 
menu options. You will note that most of the menu items are grayed-
out because they are inactive when you are not creating or editing a 
report.

3. Now click on the File menu. 

Response : When the menu appears, New is highlighted. 

Action : Press the DOWN ARROW key on your keyboard once to highlight 
Open. Look down at the right side of the Status bar, and you'll see a 
few words telling you what the Open command does.

4. Using the DOWN ARROW key, move the highlight down the list of com-
mands on the File menu. You'll see each command described on the 
Status bar when it is highlighted.
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" The Status bar does not give descriptions of the New and Print 
commands on the File menu since each of these commands 
opens a submenu with several related commands grouped 
together. The commands on the submenus, however, are 
described in the Status bar when each is highlighted.

5. Now click on the Help menu and look at the first few commands avail-
able there. These commands give you access to Crystal Reports 
extensive on line Help file. 

" If you need more information about a particular feature or proce-
dure in Crystal Reports, you can find it using the on line help.

6. The Help menu also gives you access to Private Tutor. 

Private Tutor can give you step-by-step instructions on how to perform 
a particular procedure while you continue to work on your own report. 
When you select Building a Report from the Private Tutor opening 
screen and the Private Tutor window opens, it appears on the right 
side of your screen on top of your report so that you may follow the 
instructions as you perform the work in Crystal Reports. Be sure to 
select the Learning About Private Tutor option on the Private Tutor 
opening screen to learn more about using Private Tutor with Crystal 
Reports.

7. Click somewhere outside the menu (or on the menu name itself) to 
close the Help menu when you are finished.

8. The buttons on the Button bar each represent one of the most common 
menu commands. Clicking a button has the same effect as selecting 
the corresponding command from the Menu bar. Move the cursor onto 
the Button bar. When you position the cursor on a button, the Status 
bar identifies the button function.

9. The Format bar, at the bottom of the screen, lets you make quick for-
matting changes to fields and text. You use the tools on the Format bar 
to change font, font size, and font style, align fields, and format num-
bers.
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Selecting a database to use 

Follow the procedure below to select a database to use.

Step Action

1. To begin creating your first report, click the New Report button on the 
Button bar. 

Response : The Create New Report Gallery appears. We're going to 
build a report using data stored in a database file. 

Action : To build this kind of report from scratch, click the Custom but-
ton. 

Response : The Report Gallery expands.

The Report Gallery contains a number of buttons. Many of which call 
up Experts that guide you through the creation of specific kinds of 
reports. Since we want to learn reporting concepts here, we’ll skip the 
Experts and build our report from scratch. After you’ve completed this 
tutorial, you may want to build some reports using the Experts to 
decide which method of report construction you’re most comfortable 
with.

Figure 4-1. Create New Report dialog
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2. At the bottom of the Report Gallery, select the Custom Report icon and 
then the Data File icon. You select Data File as your data source 
whenever you want to create a report from a standard database file.

Response : The Report Gallery disappears, and the Choose Database 
File dialog box appears.

Figure 4-2. The Choose Database File dialog

You will use this dialog box to select the database you'll use in creating 
your first report. 

3. Using the File Name and Directories boxes, select the file movie.dbf. It 
was installed in the CRW directory (or other directory of your choice) 
when you installed Crystal Reports. 

4. Click OK to open the file in Crystal Reports. 
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Response : The Choose Database File dialog box disappears and the 
Design window appears in a report window titled Untitled Report #1, on 
a tab titled Design. 

Figure 4-3. The Design window

" Crystal Reports uses an alias name for a database table. An alias is a sim-
ple name used to identify a database for the purposes of the report. Crystal 
Reports is preset to use the default alias (the file name without the exten-
sion) for any active database. For example, YEAR has the alias movie. If 
you have toggled the Use Default Alias checkbox off in the Options dialog 
box, the Alias dialog box will appear here and every time you activate an 
additional database. You can use that dialog box to change the alias for 
the selected database if you wish. For information on aliases, search for 
alias in Crystal Reports Help. For information on using/not using default 
aliases, search for default alias in Crystal Reports Help

About the Design window/report sections 

The Design window is divided into five sections: Title , Page header , Details , 
Page footer , and Summary . As you select elements for your report, you place 
the elements in whatever section of the report you want them to appear. If, at 
any time, you are unsure of the report section you are working in, scroll to the 
left side of the Design window, and review the section names. You'll feel better 
oriented as you work with the program.
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" If you have already activated the Use Short Section Names checkbox in 
the Options dialog box prior to reading this tutorial, the Title, Page Header, 
Details, Page Footer and Summary section names will appear as T, PH, D, 
PF and S respectively. We will learn how to make changes in the Options 
dialog box later. For now, realize that PH on your screen represents Page 
Header, and so on.

The Insert Database Field dialog box appears on screen with the Design win-
dow. 

Figure 4-4. The Insert Database Field dialog

This dialog box appears automatically because it's almost certain you will want 
to insert database fields when you create a new report. 

This dialog box is set to remain on screen until you click the Done button. All of 
the fields available for use in your report are listed in this box. Since you have 
activated only a single database, Movie, only the data fields from that database 
are listed at this time. Note that the alias movie appears at the top of the list to 
indicate the source of the fields that follow.

You can move the dialog box to another location on the screen by clicking on 
its title bar and dragging it to the new location you desire. You can also resize 
the dialog box if you wish, making it easy to see all fields in the database.
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Linking two databases

We need data from two databases to create this report. We’ve already acti-
vated the Movie database. Now we need to activate the Studio database and 
we’ll link the two databases together. When we link, we use a field that is com-
mon to both databases. The program then uses the link to match up records 
from one database with those from the other. The link assures that the data in 
each row of the report refers to the same Movie. Follow the procedure below to 
link two databases.

Step Action

1. To activate the second database, select Database/Add Database  to 
Report. 

Response : The Choose Database File dialog box appears.

2. Select the file studio.dbf. It was installed in the CRW directory (or other 
directory of your choice) when you installed Crystal Reports. Click OK. 

Response : The Visual Linking Expert appears and displays the two 
tables you have selected for your report. 

Action : An arrow should appear between the two tables and should 
point at the MOVIE field in each table. If the arrow does not appear, 
click the Smart Linking button on the Visual Linking Expert. Smart link-
ing decided that the MOVIE field contained similar values in each data-
base and suggested that field as a link. That’s the link we want. Click 
OK to return to the Design window. The Insert Database Field dialog 
box is updated, and now contains all fields from both databases. 

"  If you have disabled the Auto Smart Linking option on the 
File|Options Database tab, the two databases will not be linked 
together (indicated by the absence of the Visual Linking link line) in 
the Visual Linking Expert dialog box. To link the two databases, 
simply Click the Smart Linking button.
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Inserting a database field 

The active database is now a combination of two separate databases that you 
have linked together: a list of movies, studios, and related information. We’re 
ready to create our first report. Follow the procedure below to insert a database 
field.

First, let’s familiarize yourself with the dialog box. Highlight a field name in the 
dialog box by clicking the name once. When you highlight a field name, you 
can review the values for that field, and the field type and size, if you wish, via 
the Browse Field Data button. When you click that button, a scroll box appears 
listing field values for the selected field. When you finish reviewing the data in 
the dialog box, click the Done button to return to the Insert Database Field dia-
log box.

Now that you know how the dialog box works, double-click the field movie. 
MOVIE on the list in the dialog box, and a white rectangle appears in place of 
the arrow cursor. This is how you select a field. Alternative methods for select-
ing fields from the dialog box are to click a field name once to highlight it and 
click the Insert button to complete the process, or to drag and drop a field into 
place on your report, a technique which we will learn a little later.

When the cursor enters the Design window, the rectangular cursor disappears 
and a field box appears beside an arrow cursor. 

� The field box represents the element you have just selected for placement. 

� The size of the field box approximates the size of the field selected. 

Move the field box as far left as you can in the Details section. Note that the 
field box won't go any further left than the dashed gray line at the left of the 
Details section. That dashed line is the default page margin. You cannot place 
any report elements outside that margin. We'll use the default margin settings 
for our report. (For information on page margins, search for Page margins com-
mand in Crystal Reports Help.)

With the field box butted up against the left margin in the Details section, click 
the left mouse button to place it. A box containing Xs appears and a text field 
box containing a column heading (MOVIE) appears in the Page Header section 
directly above the field box. 

" The column heading, by default, is the name of the field selected.
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Your screen should look similar to the following:

Figure 4-5. Untitled Report window

Understanding fields 

Before we go any further, let's take a look at the field you just placed in the 
Details section. 

� First of all, the field box indicates that, when your report is printed, a field 
value will appear where the box is positioned.

� The Xs in the field box (the field picture) indicate that the box represents a 
string field (a field with the data type string). Other data types have different 
field pictures.

� The number of Xs in the field box is the data width, the maximum number 
of characters in the field as defined by the database.

� The width of the field box is the field width (the amount of space allocated 
to the field for printing) or the size of the heading (if it is wider than the 
field).

� You can change this width. Initially it is set to the width needed to display 
the maximum number of characters in the field (using the font selected for 
the field).

� The size of the Xs indicates the point size selected for the characters in the 
field. 
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� The font and style (Bold, Underline, etc.) used in displaying the Xs indicate 
the font and style selected for the characters in the field. We'll learn how to 
make changes to these attributes later in the tutorial.

� The line spacing is adjusted to the point size selected for the characters in 
the field.

Handles, selecting fields 

There is something else about the field box. It has handles (boxes) on its right 
and left edges. (Field boxes always appear with handles when first placed.) 
These handles indicate that the field is selected, and therefore active. To do 
anything with a field (change the font, move it, etc.), you first have to select it.

� Move the I-beam cursor away from the field and click an empty part of the 
window. The handles disappear. 

� Now position the cursor inside the field box and click. 

" The I-beam cursor changes to an arrow cursor when it is inside a field.

� The handles reappear. That's all there is to selecting and deselecting a 
field.

The Design Window grid 

Follow the procedure below to learn more about the Design window grid.

Step Action

1. We'll begin by dragging the field to a new position. To drag a field, 
position the cursor inside the field, depress the left mouse button, and 
keep it depressed as you move the mouse (and thus the field) to a new 
position. 

Response : When you release the mouse button, Crystal Reports fixes 
the field in its new position.
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" The field (column) heading does not move when you move the 
field.

2. Drag the field an inch or so to the right and release the mouse button. 

Response : The field stays where you moved it.

3. Now drag the field to the far right edge of the Details section and keep 
on dragging it even though it looks like there's no place to go. 

Response : The report scrolls automatically if your cursor touches the 
edge of the Design window while you are dragging a field.

4. Drag the field into the Page Header section and release the mouse 
button. 

Response : The field stays there too. With a few exceptions, a field can 
be moved anywhere within a section or into other sections, and it will 
print in its new position in the finished report.

Snapping elements to the grid 

Now that the field is selected, let's take a look at the grid that Crystal Reports 
uses to position report elements. At first, the Design window looks very free-
form. It looks like you can place anything anywhere and hope for good results. 
But that is not the case. Laying out a report is very logical. Let's see how. If you 
have toggled off the Show Grid in Design window checkbox on the Layout tab 
in File/Options , the grid will be invisible in the Design window. However, Crys-
tal Reports will still use the grid even though you can not see it. By default, 
Show Grid in Design window is toggled on.

" The grid size can be changed. Select File|Options, and the Layout tab 
appears in the File Options dialog box. Simply enter the desired grid size in 
inched in the Grid Size edit box. Make sure the Snap to Grid in Preview 
Window and Snap to Grid in Design window checkboxes are toggled on. 
They are located on the Layout tab in File/Options .
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When you moved the field you probably noticed that the field moved in tiny 
jumps. This is because fields and other report elements move on an invisible 
grid. What this means is, you can't place fields hit-or-miss on your report; you 
can only place them in grid locations. However, if the Snap To Grid checkbox is 
toggled off in File/Options  on the Layout tab, you can place fields outside of 
the grid locations. By default, Snap To Grid is toggled on. Crystal Reports is set 
up this way to help you move, resize, and align report elements with ease and 
precision.

Moving elements using arrow keys 

Once a field is selected, you can also move it with the arrow keys on your key-
board. Each time you press an arrow key, Crystal Reports moves the field one 
grid position in the direction of the arrow. You may find that you have better 
control of the fields using the arrow keys to position them instead of the mouse. 
Follow the procedure below to move elements using the arrow keys.

Step Action

1. Try moving the field using the arrow keys. Press the up, down, left, and 
right arrow keys, and watch how the field moves in the Design window. 

Response : If you hold an arrow key down, the field will continue to 
move until you release the key. Notice that the status bar in the lower 
left hand corner of the screen indicates the field position as you move 
the field.

2. Finally, move the MOVIES field back to the left margin of the Details 
section where you originally placed it. 

" The report window does not scroll automatically when you move 
fields off the edge using the arrow keys.
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Moving elements using the positioning wand

Another way to move a field is by using the positioning wand, located directly 
below the ruler. Follow the procedure below to move elements using the posi-
tioning wand.

Step Action

1. To move a field using the positioning wand, select the field. (Make sure 
that the resizing handles appear on the field.)

2. Position the cursor on the positioning wand. 

Response : The cursor changes to a hand cursor.

3. Click and drag the wand to the right or left on the report page. When 
you are satisfied with the placement of the field, release the mouse 
button. 

4. The field appears in the new location on the report page.

" If you have turned off Show Ruler in Design window, or Show ruler in Pre-
view Window, the positioning wand will not be available in the window that 
you have toggled the option off for.

Adding additional fields

Follow the procedure below to add additional fields.

Step Action

1. Let's add two more fields to the report. This time, we'll add them at the 
same time. Go back to the Insert Database Field dialog box. This time, 
click the studio.YEAR field, then press the Shift key on your keyboard. 
Holding the Shift key down, click the studio.COUNTRY field. Release 
the Shift key.
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Response : Notice that both fields remain selected. Use the SHIFT-
CLICK combination allows you to pick a continuous range of fields. You 
can use the CTRL-CLICK combination to pick several fields from the list 
that may not be adjacent to each other.

2. This time, we'll drag the fields onto the Design window and drop them 
in place. Click either of the highlighted field names, and hold the left 
mouse button down.

3. Keeping the mouse button pressed, move the cursor on to the Design 
window. 

Response : The mouse cursor changes to the Drag-and-drop cursor as 
soon as it begins to move.

4. Position the cursor close to the right edge of the MOVIE field in the 
Details section of the Design window (the first field you placed in the 
report). Release the mouse button. 

Response : Both of the fields appear in the Details section on your 
report in the same order they are listed in the Insert Database Field 
dialog box. Field headings also appear in the Page Header section 
above each field. Your screen should now look similar to this: 

Figure 4-6. The Design window

5. Whoa! That's a lot of Xs. To make our work easier, we'll set the field 
boxes to display the field names, and shorten the section names at the 
left side of the report. Select File/Options  from the Menu bar. 

Response : The Options dialog box appears with the Layout tab 
selected. 
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" If you toggled the Show Field Names checkbox on prior to reading 
this tutorial, field names already appear in your field boxes. If so, 
disregard Step 6 below.

6. Click the Show Field Names checkbox to toggle the option on. A check 
mark appears in the checkbox. 

Response : This option replaces the Xs in each field box with the 
actual name of the field.

7. Now, click the Use Short Section Names checkbox to toggle it On. If it 
has already been toggled On, disregard this step. This option will make 
more working room in the Design window for our next step. Click the 
OK button to return to the Design window. Notice that the white work-
ing space in the Design window is expanded.

Selecting multiple fields

Follow the procedure to select multiple fields.

Step Action

1. We need to align the fields next to each other, leaving no excess white 
space, and making sure we have room to fit the rest of our fields in 
place. First we'll deselect the fields so we can work with them individu-
ally. Move the cursor outside of the fields until it changes to an I-beam 
cursor. Click once to deselect all of the fields.

2. Now, hold the SHIFT key down and, in the Design window, click the 
YEAR field and its heading. You have selected both fields at the same 
time.

3. Move both fields to the left until they are touching the right edge of the 
MOVIE field and field heading. You can do this using the arrow keys or 
by dragging either one of the fields with the mouse. Both the field and 
field heading will move to the left at the same time.
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Selecting fields with the Selection tool

Follow the procedure below to select fields with the Selection tool.

1. Now, we'll repeat the process with the COUNTRY field and field head-
ing. This time, though, we'll use a new technique to select the fields.

2. Choose the Select Fields button from the Button bar. 

Response : The mouse cursor changes to the Select cursor 
(crosshair).

3. Move the cursor to the upper left-hand corner of the COUNTRY field 
heading in the PH (Page Header) section. Click and drag the cursor in 
a diagonal direction to the lower right-hand corner of the COUNTRY 
field in the Details section. 

Response : As you drag, a rectangle will appear surrounding the two 
fields.

4. When both fields are enclosed by the selection rectangle, release the 
mouse button. The rectangle disappears, and both the field and field 
heading are selected. This is known as lassoing or marquee selecting 
multiple fields.

5. Finish by moving the COUNTRY field and field heading to the left until 
they are next to the right edge of the YEAR field and field heading, 
then deselect the fields by clicking with the I-beam cursor outside any 
of the field boxes.

Reviewing your work

Follow the procedure below to review your work.

1. With three fields placed and positioned, let's see how your report 
looks. Click the Print Preview button on the Button bar to open the Pre-
view Window.
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Alternatively, you can select File/Print Preview  or click the Preview 
tab next to the Design tab and Crystal Reports opens a Preview Win-
dow displaying your report. 

Figure 4-7. The Preview window

2. Scroll through the Preview Window to see more of your report if you 
wish. 

3. You have the beginnings of a movie list report, but you still have 
another field to add. Note that the arrow buttons in the Preview Win-
dow are all grayed out, indicating that they're inactive, while some but-
tons are darkened, indicating they're active.

Right now, this report is only one page long, and you are currently 
viewing the first page. The arrow buttons in the upper right corner of 
the Preview Window allow you to page forward and backward through 
the report. When there is more than one page to the report, the arrow 
keys will be active.
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Adding the last field

Follow the procedure below to add the last field to your report.

Step Action

1. When you are finished looking at your report, return to the Design win-
dow by clicking once on the tab titled Design in the upper left hand cor-
ner of the Preview Window. 

Response : The Preview Window disappears and the Design window 
appears again.

2. In the Insert Database Field dialog box, click the movie.GROSS field. 

Response : The movie.GROSS field is now highlighted, indicating that 
it is selected.

3. Drag the field into the Design window just to the right of the COUNTRY 
field in the D(etails) section.

Response : Release the left mouse button, and the field appears in the 
D(etails) section with field heading in the PH (Page Header) section. 

Action : You may have to scroll the window to the right to see all of the 
new field. 

4. If there is a gap between the GROSS field and its field heading and the 
COUNTRY field and its field heading, use the selection tool to select 
and move the new field and its field heading so that the left edge of 
each field box touches the right edge of the field box before it.

5.  When you are finished, deselect any active fields by clicking the I-
beam cursor outside any field boxes, and click the Preview tab in the 
upper left hand corner of the Design window to return to the Preview 
Window and look at the placement of your fields.
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Balancing field spacing 

Follow the procedure to balance field spacing in your report.

Step Action

1. The Preview Window is currently in Enhanced Page mode, the default 
mode anytime you open the Preview Window. Click the Zoom button 
on the button bar once.

Response : The screen changes to Fit Width mode. Now we can see 
the entire width of the report in the window at once.

It looks as if there's more than enough white space on this page, and 
you might be fine with the spacing as it stands. But it might be more 
readable if the columns were spread out a little bit. Now you might 
wonder, if the field boxes were all touching each other, where did all 
the white space come from? The white space occurs because the data 
in each of the fields is far shorter than the amount of space allotted for 
that data in the report. There is clearly some excess space that can be 
filled.

2. To fill the space, we're going to resize the fields and field titles. First we 
want to resize the MOVIE field and its matching title. Return to the 
Design window by clicking once on the Design tab. Click the MOVIE 
field. Now, use the SHIFT-CLICK combination to select the MOVIE field 
title in the PH (Page Header) section. Handles appear on both of the 
field boxes.

3. Move the mouse over the handle on the right side of one of the 
selected field boxes. It doesn't matter which field box you choose. 
When the resizing cursor appears (a double-headed arrow), drag the 
sizing handle on the field box to the left about an inch. Both field boxes 
get smaller, and a gap opens up between the MOVIE fields and the 
YEAR fields.

4. Now click the YEAR field and SHIFT-CLICK its field title. Move them to 
the left with the arrow keys until they touch the edge of the MOVIE 
fields.
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" When selecting several fields using the SHIFT-CLICK combination, 
always click the first field in the group you are selecting without 
holding the SHIFT key down. This deselects any previously 
selected fields that you don't want to change. Hold the SHIFT key 
down to select the rest of the fields in the group you are selecting.

5. Click outside the field boxes to deselect your fields. Using either the 
SHIFT-CLICK combination or the selection tool, select the GROSS field 
and its title. With the mouse cursor inside one of the field boxes, drag 
both fields to the right about one and one half inches.

6. Now select the COUNTRY field and its title and drag both fields to the 
right until they're one half of an inch away from the GROSS field and its 
title.

7. Click the Preview tab and review your work again. You may want to 
click the maximize button in the upper right hand corner of the window 
to see more of your report on screen. As you can see, the spacing is 
much better. Now you know how to resize and space fields as needed.

Notice that all of your tools and commands are still available to you in 
the Preview Window. You will find that sometimes it is more convenient 
to work on real data in the Preview Window, while other times it is 
more convenient to work with field boxes in the Design window. 

"  Maximizing the Preview Window is useful for viewing a larger area 
of your report, and you may wish to leave these windows maxi-
mized. The figures used in this tutorial, however, do not show max-
imized windows and will not illustrate the large area visible in a 
maximized window.

Saving your report 

Follow the procedure below to save your report.

Step Action

1. Click Save to save the work you have done on the report to date. 
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Response : Since this is the first time you're saving the report, the File 
Save As dialog box appears now with the directory already set to 
where the database resides.

Action : You can also select File/Save  to save your work to date.

2. Type the report name MOVIES.RPT in the Filename box and click OK. 

Response : Crystal Reports saves your report to the C:\CRW directory 
or the directory you installed Crystal Reports in, and displays the new 
report name on the report window title bar.
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Working with Text and OLE Objects

Text is often used in reports to describe field data and formula results. It is also 
used to title the report, and to provide important header and footer information. 

OLE is a special feature that lets you increase the power of your report by 
inserting data that has been created by another application and lets you edit 
that data from within your report. 

This section shows you how to insert text into your report by typing it in a text 
field, and how to insert and edit a simple OLE object. You'll learn how to:

� Insert text using a text field.

� Change the font and point size of the text.

� Center the text horizontally on the page.

� Insert a Paintbrush graphic as an OLE object.

� Edit the OLE object from Crystal Reports.

We'll begin by inserting a simple report title.

Adding titles using text fields 

Follow the procedure below to add titles to your reports using text fields.

1. The report looks pretty barren without a report title, so it's time for you 
to add one. We'll use a text field to enter and center the report title, and 
we'll do our work this time in the Preview Window. Click the Zoom but-
ton to show your report at the highest magnification, if it is not already 
at the highest magnification. This will make it easier to see our work 
while we add the report title.

" You can also add text to your report by typing it at an insertion 
point placed in the Design window. In this report, however, we 
want to center the report title, and the easiest way to do that is to 
enter the text via a text field.
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2. To create the text field for the report title, select Insert|Text Field or 
click the Insert Text button on the Button bar.

3. Type “Studio Earnings” in the Edit Text Field dialog box when it 
appears, and click the Accept button when finished. 

Response : An empty field placement box and arrow cursor appear.

4. Position the field box in the title section of your report against the left 
margin. The placement box will not go to the very top of the report or 
the very left of the report because of the invisible page margins, but 
position the field as far as you can in the top left corner. Click the left 
mouse button. 

Response : A field box appears displaying the text you just entered.

5. While the field is selected (handles showing), move the cursor inside it 
and click the right mouse button.

Response : A pop up menu appears. 

6. Select Change Font.

Response : The Font dialog box appears. 

Figure 4-8. The Font dialog
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7. We want to set the report title to a larger, bolder version of the active 
font, so click Bold in the Font Style box and 18 (or a point size suitable 
to the font you are using) in the Size scroll box to make your selection. 

Notice that the Sample box in the Font dialog box shows you an exam-
ple of how the text will look. Click OK when finished. Your report title 
resizes to the new font size.

8. To center the Title, we're going to use a Crystal Reports' alignment 
tool. But first we'll need to expand the title field box so it's about the 
same width as the data in your report. To do this, position your cursor 
on the right edge of the Report title field box until you get a double-
arrow resizing cursor. Drag the right edge of the field box until it is even 
with the right edge of the data in the GROSS column in the Preview 
Window. You may need to release the field box, scroll the window to 
the right, then continue expanding the field box until it is even with the 
right edge of the GROSS column. 

9. Scroll to the left edge of the Preview Window when finished. What you 
have done now is created a large field that extends from the left edge 
to the right edge of your report. Now we're going to center align the title 
in that field so it will automatically be centered above your report data.

10. At the bottom of the window is the Format bar. Click the Center align-
ment button to center the report title inside the text field. 

Response : Your report title is centered within the Report Title field.
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Object Linking and Embedding (OLE)

Now that we have a report title, we'll place a logo underneath it. The logo exists 
as a bitmap file that was created in Microsoft Paintbrush, an application that 
came with your Windows system. We could insert the bitmap into our report 
using the Insert Graphic button, but we want to be able to edit the graphic and 
make changes after it is already in our report. To be able to do this, we'll insert 
the graphic as an OLE object.

Object Linking and Embedding (OLE) is a unique feature that allows you to add 
data or images to your report that have been created by an application other 
than Crystal Reports, then be able to modify the data from within your report. 
For example, you may use a program to prepare a document with data relevant 
to a report you created in Crystal Reports. You can include the document in the 
report by inserting it as an OLE object.

If the data in the document changes, it can be opened from Crystal Reports. 
Crystal Reports will open the application that created the object (the document) 
and let you make any necessary changes. Once finished, the document dis-
played in your report can be automatically updated before you return to Crystal 
Reports.

Inserting an OLE object

We're going to add a logo below the report title in our report. First we need to 
make room in the PH (Page Header) section for the logo. Click on the Design 
tab to switch to the Design window.

Step Action

1. In the Design window, move the mouse cursor inside the PH (Page 
Header) section, just above the row of field titles and just below the 
report title field box. When the cursor changes to an I-beam, click 
once. 

Response : The insertion cursor appears next to the left margin of the 
report.

2. Press the ENTER key on your keyboard four times.
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Response : Four new blank lines open up between the report title and 
the row of field titles.

3. Click the Preview tab in the upper left hand corner of the Design win-
dow to see how the report looks now.

4. Select the Insert/Object  command. 

Response : The Insert Object dialog box appears. 

Figure 4-9. The Insert Object dialog

5. The logo already exists on your hard disk as a bitmap file, so we want 
to create an OLE object from this file. Click the Create from File option 
in the dialog box.

Response : In the File text box that appears, Crystal Reports displays 
the path and directory it has been installed in, for example c:\crw\. 

Action : Move the mouse cursor into the File text box, just after the 
second backslash, until the I-beam cursor appears. Click to place the 
insertion cursor at the end of the path statement.

6. Type in the name of the bitmap file, camera.bmp. The final path state-
ment in the File text box should read c:\crw\camera.bmp. Click OK. 

Response : The Insert Object dialog box disappears, and a large box 
appears underneath the mouse cursor.
User’s Guide 145



Tutorial—Movie List
Working with Text and OLE Objects4
" The file camera.bmp is a 16 color bitmap created in Microsoft 
Paintbrush. A second file, camerab.bmp, was created as a gray-
scale image and will print to a printer clearer than the color image. 
If you prefer, use camerab.bmp in the above step instead of cam-
era.bmp.

The large box represents the graphic logo you will place. When it is 
attached to the mouse cursor, the box is called the placement rectan-
gle.

7. Position the rectangle right underneath the report title so that it is cen-
tered with the title. Click the mouse to place the object. 

Response : The logo appears below the title.

8. The logo looks good as it is, but the advantage of OLE is that we can 
edit the object after it has been placed in our report. We don't need to 
change the logo, but it will be helpful to learn how to open the OLE 
object so that it can be edited.

Editing an OLE object

Follow the procedure below to edit an OLE object in a report.

Step Action

1. Open the Edit menu and select Paintbrush Picture Object. The exact 
wording of this command varies according to the type of OLE object 
you have selected and is commonly referred to as simply Edit|Object. 

Response : A submenu appears to the right of the command when it is 
selected.
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2. Choose Edit from the submenu. Since the logo is a bitmap graphic file 
created in Microsoft Paintbrush, Paintbrush opens displaying the logo 
image.

Figure 4-10. Editing a logo in Paint Brush

3. At this point, we could use the tools and commands available in Paint-
brush to make changes to our logo. By choosing the Update command 
from the Paintbrush File menu, we can update the image in our report 
to match the changes we make on the image in Paintbrush. 

4. We don't really need to make any changes right now, so choose the 
Exit & Return to Report command from the Paintbrush File menu. 

Response : Microsoft Paintbrush closes and you return to the Preview 
Window.

" If you would like to learn more about OLE, search for OLE in Crys-
tal Reports Help. If you would like to learn more about the 
Microsoft Paintbrush application, please refer to the documenta-
tion that came with Microsoft Windows.
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Editing text fields 

Follow the procedure below to edit text fields in your report.

Step Action

1. Right now the column headings in your report are a bit cryptic. We 
want to change the headings to make them clearer.

2. In the Preview Window, click the MOVIE column heading, and, with the 
cursor positioned inside the heading field box, click the right mouse 
button. 

Response : A pop-up menu appears next to the field heading.

3. Select Edit Text Field from the pop-up menu. 

Response : The Edit Text Field dialog box appears. The current head-
ing is displayed in the white Enter Text box. 

4. Delete this heading and enter the new heading Film Title:  click Accept 
when finished. 

Response : The heading is changed in the Preview Window.

5. Repeat Steps 2 and 3 to make the following changes:

� Change YEAR to Made:

� Change COUNTRY to Studio  Location :

� Change GROSS to Gross  Earnings :

6. There's nothing special about the titles to make them stand out from 
the field values, so we'll change their color. First we'll select all the 
headings and then we'll make the changes at one time. Use the SHIFT-
CLICK combination to select all of the column headings.
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7. When all of the headings are selected (and with the cursor positioned 
inside one of the heading field boxes), click the right mouse button and 
select Change Font from the pop-up menu that appears. 

Response : This takes you to the Font dialog box.

8. In the Font dialog box, select Navy as the font color from the Color 
drop-down list box. Click OK when finished. 

Response : The selected fields in the Preview Window all turn Navy.

9. As you can see, the Preview Window is just as powerful as the Design 
window, plus, you work with real data while you make changes to the 
report. You will often find yourself “fine-tuning” your report in the Pre-
view Window to maximize the report's impact. For the next step, 
though, we'll return to the Design window. Click the Design tab to 
return to the Design window.

Sorting and summarizing your report

Reports can be grouped and sorted in a variety of ways, for example:

� A movie list can be sorted alphabetically by movie title or chronologically by 
year of release.

� Sorting can be based on values in a single field, or the values in several 
fields.

� The report can display values in ascending order (A to Z, 1 to 9) or 
descending order (Z to A, 9 to 1).

� Sorted data can be grouped and summarized.

Sorting and summarizing tools provide you with a great deal of flexibility for 
customizing your reports.

In this section, you'll learn how to sort and group report data by adding a sum-
mary field, and how to print a hard copy of your report.
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Adding a summary field 

In many reports you need to break your data into groups to make it easier to 
read and to understand. Crystal Reports lets you do this easily. But some 
times, you want to do more than group the data. You want to summarize the 
values in each group (total them, count them, etc.). For example, in a Movie list 
report, you may want to break the data into groups by Studio and then calcu-
late the total earnings for each studio. You do that using a summary field.

With Crystal Reports, we can break our data into groups and add a summary 
field all in one step. For our movie list, we'll create a summary field that groups 
the movies by studio and then totals the earnings for each group.

" When you first put fields on a report, the program looks at the first field you 
added and it presents your data in the same order as the values in that 
field are stored in the originating database.

1. We want the movie list:

� Sorted by Studio, and

� Broken into Studio groups.

2. Then we want the program:

� To total the earnings for each Studio group, and

� To display the total below each group.

� This sounds like we're asking for a lot, but Crystal Reports makes it 
easy.

3. Since we're interested in the total blockbuster earnings for each studio, 
we'll summarize the movie.GROSS field and ask the program to print a 
summary whenever the value in the Studio field changes. Here's how the 
program will process this request:

� It will sort the movie records based on the value in the Studio field,

� Going down the list, it will start a new group every time it comes to a 
new studio, finally,

� It will total the earnings in the Gross field for each group before it starts 
a new group.
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Now that you understand the theory, let's make it happen.

Step Action

1. First, close the Insert Database Field dialog box by clicking the Done 
button at the bottom of the dialog box. That way it is not in our way for 
the next step.

2. Select the GROSS field by clicking its field box in the D(etails) section 
of the Design window, and then click the Insert Summary button. 

Response : The Insert Summary dialog box appears. 

Figure 4-11. The Insert Summary dialog

3. We want a summary operation which totals the earnings for each stu-
dio group. Click the down arrow button attached to the right side of the 
drop-down list box at the top of the dialog box. Select sum from the list 
that appears. This option totals the field values in a list.

4. Notice that the field movie.GROSS is named just below this drop-down 
list box. This means we are going to total gross earnings. 

5. The second drop-down list box asks which field will be used to sort and 
group the report. We want to sort and group our report by Studio, so 
click the down arrow button attached to this list box and select stu-
dio.STUDIO from the list that appears. We'll leave the sort order as 
Ascending because we want the list to appear in alphabetical order by 
Studio. 
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6. Click OK when finished and Crystal Reports groups and summarizes 
your report by Studio. 

Response : Your report should look like this:

Figure 4-12. Sample Movie report

7. Scroll to the left side of the Design window if it is not already visible on 
the screen. 

Notice that two new sections now appear in the Design window: GH1 
(Group Header) and GF1 (Group Footer). This is how Crystal Reports 
shows that the report has been grouped. The new summary field 
appears in the GF1 section, just under the GROSS field.

8. Click outside of the field boxes to deselect the new summary field. 
Click the Preview tab to print the report to the Preview Window. 

Note that the report is sorted based on the studio that made the movie, 
and each group contains only the movies from a single studio group. 
Note too that the total blockbuster earnings appear after each group, 
just below the GROSS field.
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Highlighting the summary field

Follow the procedure below to highlight the summary field in your report.

Step Action

1. Your report is starting to look professional, but let's make that sum-
mary field stand out more and give it a label. Select one of the sum-
mary values in the Preview Window. 

2. When the values are selected, (and with the cursor positioned inside 
one of the selected fields), click the right mouse button and select 
Change Font from the pop-up menu that appears. This takes you to 
the Font dialog box. Change the font color to Navy, using the same 
procedure as you did for the field headings. Click OK when finished. 
The summary fields in the Preview Window all turn Navy.

3. Click the Design tab to return to the Design window. Now we'll add a 
label to the summary field. 

4. Click the Insert Text Field button on the Button bar, type in “Earnings: ” 
in the Edit Text Field dialog box, and click Accept when finished. The 
dialog box disappears, and a field placement box appears under the 
mouse cursor.

5. Position the empty field box to the left of the summary field, (Sum of 
GROSS), in the GF1 section of the Design window and click the left 
mouse button to place it. 

Response : The new text field label appears in your report.

6. With the new label still selected, use the Format bar to change the text 
field's attributes. Click the Bold button on the Format bar, and click the 
Italic button. 
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7. Deselect the text field when finished, and click the Preview tab to 
change to the Preview Window. 

Response : Your data should look similar to this:

Figure 4-13. Sample Movie report

Adding a “Live” group header

To finish up our customer list, we'll add a group header to highlight each group. 
While we could make it so each group has the same header, it will make for a 
better report if the header describes the values in each group. Since we've 
grouped the report by Studio, we'll have the group header display the studio 
name for each Studio group.
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As we saw earlier, whenever you group data, Crystal Reports creates a group 
footer section and a group header section. The sum (summary field) appears in 
the group footer section. By placing the STUDIO field in the group header sec-
tion, the report will Preview Window the appropriate studio name before each 
Studio group. This is called a “Live” header, a header that changes based on 
the value of a field, in this case studio.Studio.

Step Action

1. Click the Design tab to switch to the Design window. Click the Insert 
Database Field button to open the Insert Database Field dialog box.

2. Select the Studio field and drag it into the Design window. 

3. Position the field in the GH1 section just above the MOVIE field. 

4. Release the mouse button to place the field. 

5. Close the Insert Database Field dialog box by clicking Done

6. Use the Format bar to change the group heading to 16 point bold, 
italic, underlined. 

7. Deselect the field, and select the Preview tab to print the report to the 
Preview Window. 
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Response : It should look similar to the following:

Figure 4-14. Design Window

Note how the heading appears above each group section with a studio 
name for each individual group. This is a “Live” header.

Congratulations! You've just completed your first report with Crystal Reports. 
It's a pretty impressive report, and Crystal Reports made it easy to do.

Printing a hard copy 

Follow the procedure below to print a hard copy of your report.

Step Action

1. Save your report by clicking on the Save button, or by selecting File/
Save. 

2. If you want to print a hard copy of your report, click the Printer button 
on the Button bar. 

Response : The Print dialog box appears. 
User’s Guide 156



Tutorial—Movie List
Working with Text and OLE Objects4
3. Select the pages you want to print, the number of copies you want, and 
toggle the Collate Copies box on if you want your copies collated. 

Response : When you click OK, the program prints your report.

" If you don't have a Postscript printer, you won't be able to print this 
report to a printer using the Postscript printer driver.
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Rearranging Data into a Data Block Format

Crystal Reports provides you with incredible control over your data. In this sec-
tion, we take the data that you used for one report and totally rearrange it into a 
data block format. You'll learn how to:

� Insert blank lines,

� Move fields into new positions,

� Delete unneeded fields and sections, and

� Create a formula using the Formula Editor.

By the end of this section, you'll start to understand Crystal Reports' amazing 
flexibility.

Deleting the Group section

We're going to create a different report now, using the same database fields 
currently in our movie list. This time we'll put the movie data into a data block 
format. We won't need the group headings and summary anymore, though, so 
we'll delete the entire group section.

Step Action

1. Switch to the Design window by clicking on the Design tab. Move your 
cursor into the gray area at the left of the Design window.

2. Position the cursor over the GH1 or GF1 section. If you have trouble 
finding the group section with your cursor, move the cursor up and 
down in the gray area and watch the right side of the Status bar. 

Response : The Status bar will read “Group header #1” or “Group 
footer #1” when you are in the right area.

3. Click the right mouse button, and select Delete Section from the pop-
up menu. 
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Response : A dialog box appears asking you to make sure you want to 
delete this section. Click Yes. Both the Group Header and the Group 
Footer are deleted along with the fields in these sections. The Design 
window should look like the following:

Figure 4-15. Sample Design window

Inserting blank lines 

Follow the procedure below to insert blank lines in your document.

Step Action

1. Move the mouse cursor into the gray area to the left of the D(etails) 
section. Click the right mouse button and select Add Line from the pop-
up menu that appears. A blank line opens up at the bottom of the 
D(etails) section. This gives us more room to rearrange the fields into 
our new format.
User’s Guide 159



Tutorial—Movie List
Rearranging Data into a Data Block Format4
2. Repeat the last step one more time to open up one more line in the 
D(etails) section. We will move our fields into these lines in the next 
section of the tutorial. You can also insert blank lines into the Design 
window by moving the mouse cursor over the line separating two sec-
tions of your report (D and PF for example). When the section resizing 
cursor appears (two arrows with a line between), press the left mouse 
button and drag the line up or down to expand or decrease the amount 
of space allotted to a section.

Moving fields to new positions 

In our new report, we want the movie title to appear first, and the year of the 
movie to appear on the same line as the movie title. We want the gross to 
appear last. 

Step Action

1. Select the GROSS field in the Details section. When the handles 
appear, drag the field down to the bottom line in the Details section, 
and then all the way over to the left margin using your mouse. 
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2. Select the COUNTRY field in the Details section. When the handles 
appear, drag the field to the second line of the Details section and then 
over to the left margin using your mouse. Your report should look simi-
lar to the following:

Figure 4-16. Design Window

3. Select the Movie field and the Year field and delete them from the 
Details section. We don’t need them any longer because we are going 
to create a formula that will replace these fields.

Creating a formula

We want the Movie title and the Year of the movie to appear as you might print 
them, in the format Movie, Year. We can do this by creating a formula that adds 
these fields together into the format we want.

Step Action

1. Click the Insert Formula Field button on the Button bar or, select 
Insert/Formula Field . 
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Response : The Insert Formula dialog box appears.

Figure 4-17. Insert Formula dialog

2. Type in “movie, year” in the Formula name text box as the name of 
your new formula. Click OK. 

Response : The Insert Formula dialog box disappears, and the Edit 
Formula dialog box (Formula Editor) appears. The name of your for-
mula appears in the title bar of the dialog box preceded by an @ sym-
bol. Crystal Reports uses the @ symbol to identify formula fields.

Figure 4-18. Edit Formula dialog
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3. In the Functions scroll box in the center of the top section of the For-
mula Editor, scroll down through the functions until you find the Trim-
Right(x) function. 

Response : It appears under the Strings heading in the scroll box. 

" To learn more about the TrimRight(x) function, search for Trim-
Right function in Crystal Reports Help. To learn more about func-
tions, search for Functions in Crystal Reports Help.

4. Click the TrimRight(x) function in the Functions box, and click the 
Select button at the bottom of the Formula Editor. 

Response : The function appears in the Formula text box. You have 
just added this function to your formula. The function needs an argu-
ment though, a field or value to perform an operation on. To help you 
place one, Crystal Reports already put the insertion cursor where the 
argument should appear: between the parentheses.

5. In the Fields scroll box at the top left corner of the Formula Editor, dou-
ble-click the studio.MOVIE field.

Response : “{studio.Movie}”  appears in the Formula text box 
between the parentheses of the TrimRight() function. You may find 
double-clicking to be a faster method of inserting fields, functions, and 
operators in your formulas.

So far, your formula should read TrimRight({studio.Movie}) . The 
TrimRight() function trims any trailing white space off of the right side 
of the field. This means the studio.Movie field values will print in your 
report without any excess white space to the right of them. Anything 
that is printed next to the field will appear right next to the values stored 
in the field, regardless of the length of any of the values.

6. Now, we need to add a comma after the MOVIE field and add the next 
field to our formula. Move the mouse cursor into the Formula text box 
until it becomes an I-beam cursor. Click the I-beam directly after the 
final parentheses of the TrimRight() function to place the insertion cur-
sor there.

7. Type in the following directly after the parentheses:
+ “,” +
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Be sure to put a space directly after the comma inside the quotation 
marks. Don't worry about putting spaces before or after the + signs, 
Crystal Reports ignores them if they are there.

8. Now double-click the studio.YEAR field in the Fields scroll box to add it 
to your formula. “{studio.YEAR}”  appears in the Formula text box.

The finished formula should look like this:
TrimRight({studio.MOVIE}) + “,” + {studio.YEAR}

This formula first trims off any trailing white space from the value in the 
MOVIE field, then prints the MOVIE field value with a comma and a 
space directly after it. The space is followed by the value in the YEAR 
field. The result is a nice format of “movie, year”.

9. Click the Check button at the bottom of the Formula Editor. 

Response : Crystal Reports automatically checks to see if there are 
any errors in your formula. If you've done everything correctly, the pro-
gram displays a message box that confirms that no errors were found 
in your formula. 

Action : Click the OK button in the dialog box to close it. 

" If you get an error, double check to make certain you've entered 
the formula correctly, then try again.

10. Click the Accept button at the bottom of the Formula Editor to accept 
your formula as it appears. 

Response : The Formula Editor closes, and a field placement box 
appears attached to the mouse cursor.

11. Place the field placement box in the Design window in the empty line 
above the GROSS and COUNTRY fields. 
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Response : A field box appears in your report representing the 
@Movie, Year formula and a new field title appears in the PH (Page 
Header) section. Your report should look similar to:

Figure 4-19. Sample Completed Movie Report

Congratulations, you've just added a formula to your report. Formulas are just 
one of the many features that make Crystal Reports so powerful.

Deleting the remaining fields and field titles 

Follow the procedure below to delete remaining fields and field titles from your 
report.

Step Action

1. We don’t need the movie, year field title that came with the formula 
field we just inserted. It is in the Page Header section, on top of the film 
title field. Select the movie, year field title in the Page Header section. 
Handles appear on the field.

2. Press the Delete key on your keyboard to delete the field. 
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Response : The movie, year field title is deleted, and the film title field 
remains in the Page Header section.

3. Using the SHIFT-CLICK combination, select the Movie, Year Made, Stu-
dio Location and Gross Earnings field titles in the Page Header section 
of your report. Handles appear on all fields. 

4. Press the DELETE key on your keyboard. 

Response : All four fields are deleted. 

5. Print the report to the Preview Window to see how your data blocks 
look. 

Figure 4-20. Preview window
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Adding a line between records 

Follow the procedure below to add a line between records in your report.

Step Action

1. One thing is clear: you need a blank line between movie records. To 
add the blank line, move the mouse cursor into the gray area just to the 
left of the column of data in the Preview Window. Make sure the mouse 
cursor is in the D(etails) section of the gray area. If you have trouble 
locating the D(etails) section here, move the mouse cursor up and 
down in the gray area, and watch the Status bar until it reads Details.

2. Click the right mouse button, and a pop-up menu appears.

3. Select Add Line from the pop-up menu. 

Response : A blank line opens up just below each of the values from 
the GROSS field. 

Congratulations! You've totally rearranged the data into a brand new 
report.

Figure 4-21. New report with previous data
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A first look at selecting records

Record selection limits or restricts the records that are to be included in a 
report. For example, if you want to run a report including only Columbia Studios 
movies, you can do this by selecting only Columbia records for your report. In 
this section you'll learn how to:

� Select the records you want included in your report, and

� Save a report including your selection criteria.

We'll begin by entering the selection condition.

Splitting the list via Select Records 

We've decided that it would be helpful for the box office to have a movie list 
that only lists movies from Paramount and Universal Studios. Crystal Reports 
makes it easy to restrict lists like this using the Select Records command. Fol-
low the procedure below t o split the data list by selecting records in your 
report.

To begin, switch to the Design window. Since our list is going to be based on 
whether or not the movie is from Paramount or Universal studios, we'll base 
our record selection on the movie.STUDIO field, and we'll include only those 
records that are for Paramount and Universal movies.

Hiding the STUDIO field

Follow the procedure below to hide the STUDIO field from your report.

Step Action

1. We need to use the STUDIO field to set up a record selection formula 
but it doesn’t currently exist in our report. Open the Insert Database 
Field dialog box by clicking the Insert Database Field button.
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2.  Insert the STUDIO field in the Details section of your report. It does 
not matter where you place the field in the Details section, because we 
are going to hide the field. We don’t want the values in that field to 
appear in the report. 

3. Click Done in the Insert Database Field dialog box to close the dialog 
box.

4. Position the cursor inside the STUDIO field, and click the right mouse 
button once. 

Response : A pop up menu appears. 

5. Select Change Format from the pop-up menu. 

Response : The Format String dialog box appears. 

We'll use this dialog box to change the format of the STUDIO field. If 
the value in this field was a number, the Format Number dialog box 
would have appeared. The dialog box that appears here is specific to 
the type of data stored in the field selected.

Figure 4-22. Format String dialog

6. Click the Hide when Printing checkbox in the dialog box. 

Response : This will hide the STUDIO field when the report is printed 
so that the field values will not appear in the print-out.

7. Click the OK button, and the Format String dialog box disappears. 
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Notice that the field name in the STUDIO field box is grayed out in the 
Design window. This means that the field is hidden. Even though it's 
hidden, we can still select the field and use it to base our record selec-
tion on.

8. Select the STUDIO title in the Page Header section. 

Response : Handles appear on the field.

9. Press the Delete key on your keyboard to delete the field, since we 
don’t want it to appear in our report. 

We only need the hidden field to perform our selection.

Entering your selection criteria

Follow the procedure below to enter your selection criteria.

1. With the cursor inside the studio.STUDIO field again, click the right 
mouse button and choose Select Records Expert from the pop-up 
menu. 

Response : The Select Records Expert dialog box appears.

Figure 4-23. Select Records Expert dialog

Action : Our job in this dialog box is to imagine that we are completing 
the sentence:

Select all records where studio.STUDIO is
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Action :You complete the sentence with the condition you want the 
program to use when selecting records for your report. Since we want 
to create a list that includes only movies from Paramount and Univer-
sal Studios, our condition for the list is that the value in the studio.STU-
DIO field must be one of Paramount or Universal. Right now the 
condition is any value, clearly not a restrictive condition. Click the 
arrow on the right drop-down list box to see what other options you 
have.

2. Since you want only those records where the studio.STUDIO is one of 
Paramount or Universal, select the one of condition. When you select 
it, one appears in the original list box and a new edit box appears 
beside it on the right. The dialog box sentence would now read:
Select all records where studio.STUDIO is one of

All that you need to complete the sentence are the values Paramount 
and Universal. We'll take a quick look at a tool the program includes for 
looking at those values. Click the Browse button and a browse and 
paste dialog box appears.

Figure 4-24. Browse and paste dialog

The title of the dialog box identifies the field you're looking at, stu-
dio.STUDIO. Just below the title, the dialog box displays the data type 
of the field (String) and the field length in characters (20).

3. The scroll box contains a list of actual field values. Paramount appears 
on the list and we know that's one of the values we want to use to com-
plete the sentence. Let's paste that value into the new edit box so we 
don't have to worry about typing it in. Click the Paramount listing to 
highlight it and click Paste Data. 
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Response : The dialog box disappears and Paramount now appears 
below the new edit box.

Figure 4-25. Select Records Expert dialog

4. Repeat steps 3 and 4 above to paste Universal to the edit box. 

Response : Our sentence could now read:
Select all records where studio.STUDIO is one of 
Paramount or Universal.

5. Click OK to return to the Design window. Deselect the STUDIO field by 
clicking anywhere outside the field box. Click the Print Preview button 
so you can review the results of your work. Scroll down through the 
report. Now, only movies by Paramount and Universal studios appear 
in your report.
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6. Click on the report title, then click the right mouse button. You may 
have to scroll to get to the report title. Select Edit Text Field from the 
pop-up menu, and Crystal Reports opens the Edit Text Field dialog box 
with the report title displayed in the Enter Text box. Position the inser-
tion cursor after the final “s”, press the space bar once and then type:
(Paramount and Universal Studios) 

Figure 4-26. Edit Text Field dialog

7. Press Accept to close the dialog box when you’re finished.

8. Save this version of the report without erasing the old report in the pro-
cess by using the File/Save As  command and giving the new report 
the name STUDIO.RPT.

Congratulations! You’ve completely rearranged your report and added selec-
tion criteria to it. More than that, you’ve really learned how to manipulate your 
database data. By now, you have a good idea of the powerful kinds of reports 
you can prepare with Crystal Reports. As you can see, it’s an easy program to 
use.Xs
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Creating formulas in Crystal Reports is much like creating formulas with your 
favorite spreadsheet; the primary difference is that Crystal Reports formulas 
often reference fields instead of spreadsheet cells. Otherwise we think you'll 
find many similarities. This chapter leads you through the following formula cre-
ation topics:

� Inserting text, variables and fields in formulas.

� Inserting operators and functions in formulas. 

� Inserting other formulas in formulas.

� Inserting group field values in formulas.

� Including comments with formulas.

� Deleting formulas from your report.

� Copying formulas from Crystal Reports Help. 

� If-then-else formulas. 

� Multi-condition if-then-else formulas. 

� Concatenated text strings with formulas. 

� Formatting text with formulas. 

� Stacking formulas and fields.

� Order of precedence in formulas. 

� Formula evaluation time considerations.

� Copying formulas from one report to another.

To view a variety of sample formulas, please refer to the Formulas in action 
topic in Crystal Reports Help. Each sample formula demonstrates the use of 
multiple functions and operators working together to solve real-world problems, 
and each formula is discussed in depth. (For detailed descriptions of the indi-
vidual operators and functions, see the Reference section of the Crystal 
Reports Help Contents.)
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Inserting Text and Numbers in Formulas       

You insert text and numbers in formulas by typing them into the formula text 
box.

� Text must be surrounded by 'single' or “double” quotation marks.

� Numbers must be entered without commas (1000000 not 1,000,000).

� You can use the Cut, Copy, and Paste commands with text in the Formula 
Editor.

" Formulas are treated as text by Crystal Reports. The program uses syntax 
items (quotation marks, brackets, parentheses, etc.) to identify the various 
formula components.
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Inserting Fields in Formulas      

You can enter fields into your formulas in two ways: via the Fields box in the 
Formula Editor, or manually.

Inserting fields using the Fields scroll box 

To enter a field via the Fields scroll box, you move the I-beam cursor to the 
place you want to insert the field and click the left mouse button to set the 
insertion point there. Then you locate the field you wish to insert from the Fields 
scroll box list.

� Fields already in use in the report are grouped at the top of the list; other 
available fields follow.

� Formulas you have entered are listed next, their names preceded by the @ 
sign.

� Groups you have entered are listed next.

� Groups that you enter in group sections appear in the following format:

group section:sort and group by field:
summary action/field summarized

� Groups that you enter in the Grand Total section appear in the follow-
ing format:

Grand total:
summary action/field summarized

� All other fields available in the active databases are listed last, grouped by 
database.
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Notes to consider

� In the Edit Formula dialog box the Fields, Functions and Operators boxes 
can be resized to make viewing their contents easier.

� For large Btrieve.ddf files (.ddf files that contain four or more database 
files), Crystal Reports displays the names of the files in the .ddf file, not the 
individual field names. To review the field names in individual files:   

� Select the file of interest from the scroll box in the Fields box. The Formula 
Editor Select button changes to an Open button. 

� Click the Open button and the program lists all of the fields in the selected 
database file immediately after the file name.

� Select the field(s) of interest as you would from any other kind of database 
(.dbf, .db, etc.).

� Click the name of the open file and Click the Close button if you want to 
hide all of the field names once again.

 For additional information, search for Btrieve files in Crystal Reports Help. You 
select an item from the Fields scroll box by double clicking it, or by clicking it 
once to highlight it and then clicking the Select button at the bottom of the Edi-
tor to complete the selection process.

Inserting fields manually

To enter a field manually, you locate the insertion point in the appropriate posi-
tion and type in the field name as you would any text.

� The correct syntax for a database field name is:

{file.fieldname}

� The correct syntax for a formula field is:

{@formula name}

� If you don't include the file name, leave out the separating colon, or fail to 
surround the expression in braces, Crystal Reports will generate a Formula 
Compiler Warning detailing your error.
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Pasting field values into your formula    

Crystal Reports also enables you to paste actual values from selected fields 
directly into your formulas. This can be useful, for example, in cases such as 
these:

{file.STATE} = “WY”
or
{file.ZIP} > “52323" and {file.ZIP} < ”54575”

Instead of having to remember the specific data you want to use to compose 
your condition (“WY”, “52323", ”54575”), you can browse through the first 20 
values for a selected field and paste the value(s) of interest directly into your 
formula.

Follow the procedure below to paste field values directly into your formula.

Step Action

1. In the Fields scroll box in the Formula Editor, highlight the field that 
holds the values you want to include in your formula.

2. Click the Browse Field Data button at the bottom of the Formula Editor. 

Response : A dialog box appears with a scroll list of values for the 
selected field.

3. Highlight the value of interest and click the Paste Data button or dou-
ble-click the value of interest. 

Response : Crystal Reports pastes the value selected at the insertion 
point in your formula.
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Inserting Operators in Formulas       

You can enter operators into your formula in one of two ways: via the Opera-
tors scroll box in the Formula Editor, or manually.

Using the Operators scroll box 

To enter an operator via the list in the Operators scroll box, you set the inser-
tion point where you want the entry to appear in the formula. 

Then you select the operator of interest from the scroll box list. Crystal Reports 
inserts the selected operator in your formula, complete with any parentheses, 
brackets, or commas required.

" For an array of items, only the first comma is included. As you enter addi-
tional items into an array, you will need to type in commas to separate the 
items.

Inserting operators manually

To enter an operator manually, you locate the insertion point in the appropriate 
position and type in the operator as you would any text. 
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Inserting Functions in Formulas       

You can enter functions into your formula in one of two ways: via the Functions 
scroll box in the Formula Editor, or manually.

Using the Functions scroll box 

To enter a function via the list in the Functions scroll box, you set the insertion 
point where you want the entry to appear in the formula. 

Then you select the function of interest from the scroll box list. Crystal Reports 
inserts the selected function in your formula, complete with any parentheses, 
brackets, or commas required.

" For an array of items, only the first comma is included. As you enter addi-
tional items into an array, you will need to type in commas to separate the 
items.

Inserting functions manually

To enter a function manually, you locate the insertion point in the appropriate 
position and type in the function as you would any text. 
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Inserting Other Formulas in Formulas       

Just as you can enter database fields in formulas, you can enter other formulas 
in formulas too. Crystal Reports performs the calculations in the referenced for-
mula, and then it uses the value returned by the referenced formula in the 
same way it uses any other value. For example, the formula:

1*(2+4*6/3-7*12-8) +2*(2+4*6/3-7*12-8) +3*(2+4*6/3-7*12-8) 
+4*(2+4*6/3-7*12-8) = -820

includes the expression (2+4*6/3-7*12-8) repeated many times.

If you had created a formula for the repeated expression (@F = (2+4*6/3-7*12-
8)) and then referenced that formula instead of entering the expression itself, 
you would get the same result.

1*{@F}+2*{@F}+3*{@F}+4*{@F} = -820

Every time Crystal Reports sees the formula @F, it performs the @F calcula-
tions and returns the value -82, just as the expression underlying the formula 
(2+4*6/3-7*12-8) returns the value -82.

Inserting other formulas from the Fields box 

To enter a formula via the list in the Fields scroll box, set the insertion point 
where you want the entry to appear in the formula. 

Select the formula of interest from the scroll box list (formulas appear in the list 
with @ signs preceding their names). Crystal Reports inserts the selected for-
mula in your formula, complete with the required braces.

Inserting other formulas manually

To enter a formula manually in a formula, set the insertion point where you 
want the entry to appear. Type in the formula name using the syntax {@for-
mulaname} .

" A formula cannot reference itself. You cannot reference any formulas that 
do not appear on the list in the Fields box.
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Inserting Group Field Values in Formulas      

You can enter group field values in formulas in one of two ways: via the Fields 
box, or manually.

" Due to the syntax complexity for some group fields, it is highly recom-
mended that you enter group fields by selecting them from the field list.

Inserting group field values from the Fields box 

To enter a group field via the list in the Fields scroll box, set the insertion point 
where you want the entry to appear in the formula. 

Select the group field of interest from the scroll box list. Group fields appear in 
the list in a format similar to this:

Group footer #1:file.fieldname
Action of fieldname

Crystal Reports inserts the selected group field in your formula, complete with 
the required braces, commas, condition fields, date fields, conditions, etc.

Inserting group field values manually

Follow the procedure below to enter a group field manually.

Step Action

1. To enter a group field manually in a formula, set the insertion point 
where you want the entry to appear.

2. Select the function from the Functions list that matches the group field 
you want to insert. Crystal Reports inserts the function and all the 
required syntax items (parentheses, commas, etc.). The insertion point 
is automatically set for entering the first field.

3. Select the first field from the fields list. Crystal Reports enters it at the 
insertion point, complete with braces.
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4. Set the insertion point after the comma.

5. Select the second field from the fields list. Crystal Reports enters it at 
the insertion point, complete with braces.

6. If your sort and group by field is a date field, set the insertion point 
between the opening and closing quotation marks.

7. Type in the date condition (daily, weekly, monthly, etc.).

Your finished group field should have the following syntax:

� For a group triggered by a number, dollar, or string condition: 
Action({file.field}, {file.condField})

� For a group triggered by a date or Boolean condition: 
Action({file.field}, {file.dateField}, “Condi-
tion”)

" In order to use a group field in a formula, you must have already entered a 
group field in your report with identical parameters: same field, same sort 
and group by field, same condition (if applicable), and same action.
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Including Comments with Formulas       

Comments are notes that you include with a formula to explain its design and 
operation. They can be invaluable for understanding the interaction of the vari-
ous formula components when memory of your initial inspiration fades, or 
when someone else is editing the formula in your absence.

Comments don't print and they don't affect the formula, but they appear with 
the formula whenever you call the formula up for editing. It is always a good 
idea to include comments with complex formulas, especially those formulas 
that will be used again and again over time. 

To include comments with formulas

Type your comments in the Formula Text box in the Formula Editor, the same 
box you use for creating the formula. The comment can be above or below the 
formula, or it can even follow the formula on the same line if it is preceded by 
two slashes. Any of the following placements are acceptable:

/ /This is an acceptable
//position for a comment.
//Note that when we force
//the line break, we have to
//begin each new line with
//double slashes.

if ({file.Amount} in (100.00 to 250.00)) then  //This too 
is an                                      //acceptable 

(.10 * {file.Amount})                //position 
for a                                      //comment.
else

0

//This is also an acceptable position for a comment.
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Comment considerations

The following are considerations when including comments with formulas:

� The proper syntax for a comment is two slashes // followed by the com-
ment. When Crystal Reports sees the two slashes, it realizes that the text 
that follows for the rest of the line is comment only and not to be included 
as part of the formula itself.

� Crystal Reports treats everything that follows the slashes on the same line 
as the slashes as a comment.

� If your comment is long and automatically wraps to the next line, no addi-
tional slashes are necessary; Crystal Reports treats it as one continuous 
comment.

� If you break your comment into two or more lines using the ENTER key, you 
must begin each new line with two slashes. If you don't, Crystal Reports 
treats each unslashed line as part of the formula itself and displays an error 
message when you check the formula syntax.
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Deleting Formulas from your Report       

When you create a formula and enter it in your report, Crystal Reports does 
two things:

� It stores the specification for creating that report using the name you 
assigned it

� It places a working copy of that specification at the point you specify in the 
report.

In order to delete formulas, you can delete:

� Individual working copies of the formula

or

� The specification and all working copies of the formula.

" You cannot delete the specification without deleting all working copies of 
the formula.

Deleting individual formulas

To delete individual working copies of the formula, select the formula you want 
to delete and then:

� Click the right mouse button and select Delete Field from the pop-up menu 
that appears

or

� Press the DELETE key on your computer's numeric keypad

or

� Select Edit/Clear .   
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" Even after you have deleted all of the working copies of a formula from 
your report, the formula specification remains unchanged. The specifica-
tion is listed in the Insert Formula dialog box, and it is available for immedi-
ate use should you wish to enter the formula again in your report. To delete 
the formula specification, follow the steps below.

Deleting the specification

To delete the specification (after you have deleted all working copies of the for-
mula) follow the procedure below.

Step Action

1. Once you have deleted all working copies of the formula, select Insert/
Formula Field . 

Response : The Insert Formula dialog box appears.

2. Select the formula specification you want to delete from the Formula 
name list. 

Response : Crystal Reports activates the Delete button.

3. Click the Delete button, and Crystal Reports deletes the formula speci-
fication.

" If you haven't deleted all working copies of the selected formula, the pro-
gram displays the following message: Please delete all uses of the for-
mula in the report first .
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Copying Formulas from Crystal Report Help       

Windows 3.0 and 3.1 allow you to copy text from help topics to the Clipboard. 
You can then paste this text wherever it is needed. Since the formulas you 
develop using the Formula Editor are simply text, you can save yourself a lot of 
time by copying useful formulas directly into the Formula Editor and then modi-
fying it to fit your needs. Follow the procedure below to copy formulas from 
Help.

Step Action

1. With the Formula Editor active, call up the Crystal Reports Help facility 
in any of the standard ways (Help menu, Help button, F1 function key).

2. Regardless of the topic that first appears, use Search to find the topic 
that contains the formula of interest.

3. Call up the topic and select Edit/Copy . 

Response : The Copy dialog box appears with the topic text displayed 
in a scrolling edit window.

" Windows 95 and NT allow you to select text directly from the Help 
window.

4. Scroll down through the topic until you locate the formula you want to 
copy. 

5. Select the formula by dragging the I-beam cursor over it, and click the 
Copy button when finished. 

Response : Windows puts a copy of the selected text into the Windows 
Clipboard.

"  In Windows 95 and NT, simply select the text you wish to copy 
and then press CTRL-C to copy.

6. Place the insertion point where you want the text to appear in the For-
mula Editor and press SHIFT-INS to paste the text from the Clipboard.

7. Modify the formula to fit your needs.
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Help topic titles containing useful formulas

� All topics for individual functions and operators. (Locate by function/opera-
tor name or click the Contents button and call up the Functions or Opera-
tors index from the Reference Information section of Index to Crystal 
Reports Help.)

Other Help topics that contain useful example formulas are:

� How to assign a value to a variable contains example assignment state-
ments for a variety of assignment scenarios. 

� How to create aging reports contains a number of if-then-else formulas that 
can be modified and used to create aging reports.

� Formulas in Action leads you to a number of complex formulas for solving 
a variety of real world reporting problems.
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If-then-else Formulas       

If-then-else formulas are conditional formulas: if a condition is met, then a cer-
tain consequence, an action, takes place. If the condition is not met, some 
other action takes place. For example:

� If a sales rep has already earned the maximum allowable bonus, print the 
amount of the maximum bonus allowed; if he has not yet earned the maxi-
mum, calculate the bonus actually earned and print it.

� If the value in the title field is “Mr.”, print “Dear Mr.” as the beginning of the 
salutation; if it is not “Mr.”, print “Dear Ms.” as the salutation.

� If the quantity on hand of a part is equal to or less than the reorder amount, 
reorder according to the reorder instructions; if the quantity is greater than 
the reorder amount, do nothing.

These are just a few of the kinds of conditional formulas you can create using 
the If-then-else operator.

When using the If-then-else operator, remember that there must be three sepa-
rate parts to any if-then-else formula:

� The if  part
This part sets the condition. 

� The then  part
This part sets the action that takes place if the if condition is met.

� The else  part
This part sets the action that takes place if the if condition is not met.   

"  The data types (text, number, dollar amount, date, or boolean) for the then 
part and the else part must be the same. 

Thus, if the action that takes place if the condition is met (then) is to print a text 
string, the action that takes place if the condition is not met (else) must also be 
to print a text string, even if that text string is empty.
User’s Guide 190



Using Formulas
Multi-condition if-then-else Formulas5
Multi-condition if-then-else Formulas       

Crystal Reports allows you to create powerful multi-condition formulas using 
the If-then-else operator. 

Multi-condition and nested if-then-else formulas can be set up in this general 
pattern: if the red (first) condition is met, then, go to the blue (second) condi-
tion. If the blue condition is met, then perform the blue action; if the blue condi-
tion is not met (else), perform the blue alternative. If the red condition is not met 
(else), perform the red alternative. Thus:

if {file.Color1} = “Red” then 
if {file.Color2} = “Blue” then 

“Blue Action” 
else 

“Blue Alternative” 
else 

“Red Alternative”

This formula checks the field Color1. 

� If the value of that field is “Red,” it then checks the field Color2. 

� If the value of that field is “Blue,” it prints “Blue Action.” 

� If the value of Color2 is not “Blue,” it prints “Blue Alternative.”

� If the value of Color1 is not “Red,” it prints “Red Alternative.”

While multi-condition formulas look complex at first, after you've worked 
through one or two you'll find that they are not as intimidating as they seem, 
especially given the work they perform.
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Concatenated Text Strings with Formulas       

Concatenated text strings are simply strings of text that are tied together via a 
formula. Typically the first string exists in one field and the second string exists 
in another. Alternately, the first string exists in one field and it is combined with 
text that is typed directly into the formula.

One typical use of a concatenated text string is in the salutation of a form letter. 
The word “Dear” is typed directly into the formula and it is to be combined with 
the title from the Title field and the last name from the Lname field. The concat-
enation operator can be used to tie all three strings together.

When concatenating, there are a few simple things to keep in mind:

� All text that's typed directly into a formula must be enclosed in quotation 
marks.

� Text that's a value in a field doesn't require quotation marks; referencing 
the field is sufficient.

� Finally, if a space is to appear between two concatenated strings, the 
space must be entered within the quotation marks, either at the end of the 
first string or at the beginning of the second.
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Formatting Text with Formulas       

You can use formulas and functions to format text. Crystal Reports includes 
functions for removing unnecessary spaces from text strings, for converting 
text entirely to upper or lower case, etc. It also allows: 

� The use of operators to join text from two different text fields

{file.FNAME} + “ ” + {file.LNAME} 

«where the expression “ ” is a space to be inserted between the first and 
last name». 

or to join text from a text field with text entered directly into the formula 

“Dear ” + {file.FNAME} + “,”

«where Dear, the space that follows Dear, and the comma that follows 
FNAME are text entered directly in the formula».

� It also includes functions to convert numbers to text so they can then be 
joined to other text strings

ToText({file.Quantity}) + “ on hand” 

«where Quantity is a numeric value and ToText is the function that con-
verts the value of quantity to text. If Quantity = 5, this expression would 
read 5 on hand».
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Stacking Formulas and Fields       

When you use an if-then-else formula, the data type of the then consequence 
must match the data type of the else consequence. In other words, you cannot 
have a formula like this:

if {file.AMOUNT} <> 0 then
{file.AMOUNT}

else
“Zero”

«where file.Amount is a numeric field». 

� The data type of the then consequence file.Amount is a number. 

� The data type of the else consequence field must be a number as well. 

But in this formula, the else consequence is a string, “Zero”. 

Since the data types don't match, the program will not allow the formula and 
you will get an error message.

The formula above is trying to solve a real world reporting problem, i.e., to print 
a string instead of the number 0 to call particular attention to zero values. For-
tunately, there is a way to get the results wanted, and that is by stacking fields 
and formulas (multiple fields and/or formula fields stacked on top of one 
another).

" A stack of formulas is not a vertical stack of formula fields (vertical on the 
screen). When you stack formulas, the stack seems to build out from the 
screen, towards you (theoretically, not visually). A stack of formulas looks 
essentially like one formula, but the text inside the top formula box is gar-
bled because the text from formula boxes lower in the stack is showing 
through as well.
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Reproducing the effect using a stack

Creating the effect from the formula above using stacked fields and/or formula 
fields follows the procedure below.

Step Action

1. Insert the file.Amount field in the Details section of your report.

2. Format the file.Amount field so that nothing prints if the value in the 
field is zero. To do this, you format the field using the Suppress if Zero 
option in the Format Number dialog box (Page). At this point, the value 
in the file.Amount field will print only if it is something other than zero.

3. Create an if-then-else formula that prints the word “Zero” if the value in 
the file.Amount field is zero and that prints nothing (an empty string) if 
the value in that field is something other than zero. (Search for if-then-
else formulas in Crystal Help.)

if {file.AMOUNT} = 0 then
“Zero”
else
“”

4. Stack the formula field directly on top of the file.Amount field.

� Both stacked items (the file.Amount field and the formula field) are 
mutually exclusive. 

� Each one prints something only when the other one doesn't print. 

� By restricting our stack to mutually exclusive fields and formulas, we 
never run into a situation where two or more values print at the same 
time, thus putting unreadable and unsightly printing in your report. 

� As long as we restrict our stack to mutually exclusive items, we can put 
many items in the stack and still get only one value printing at a time.

With this understanding of stacking theory and some careful planning and 
experimenting, you can create some very intelligent reports.    

" When fields are stacked in such a way that you can select more than one 
field, the field selected becomes the top field in the stack.
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Using Variables in Formulas       

Crystal Reports allows you to use variables in formulas. While programmers 
need no introduction to variables, non-programmers may find the following dis-
cussion helpful.

Variables are a special kind of value that you can use in a formula. Unlike a 
constant value which is fixed and unchanging, a variable holds a value that 
may change from time to time.

A variable is like a container that can hold one value at a time. You assign a 
value to a variable, and the variable maintains that value until you later assign 
a new value. Then the variable maintains the new value until you later assign a 
newer value, etc.

When you use a variable in a formula, the formula looks to the variable and 
uses its current value in calculating the formula result. If the variable value 
changes, the formula looks to the new value and uses that to calculate a new 
result.

If you have a digital alarm clock, you're already familiar with a practical use of 
variables, even though you may not know what a variable is or that it is 
involved in the wake-up process. You set a time to get up, and the alarm goes 
off at the time set. You set a new time to get up and the alarm goes off at the 
new time. The time the alarm goes off depends on the value assigned to a vari-
able in the clock's programming code. Here's how it works.

You set a time to get up, and the alarm clock stores that time in a variable we'll 
call WakeUpTime. If you set the alarm to get up at 7:00, for example, the clock 
stores 7:00 in WakeUpTime. The alarm goes off whenever the time of day (a 
variable we'll call TimeOfDay) matches the variable value. Thus, at 7:00, Tim-
eOfDay matches the value stored in WakeUpTime and the alarm goes off.

A simple formula that shows this action is as follows:

If TimeOfDay = WakeUpTime then
“Alarm”

else
“”
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This formula uses two variables because the time of day is changing con-
stantly, and the wake up time can change to meet the user's needs.

Now if the alarm goes off and you decide to sleep a little longer, you may reset 
the alarm to 7:30. When you do this, you are, in effect, assigning a new value 
to the variable WakeUpTime. The clock replaces the WakeUpTime value 7:00 
with the new value 7:30. This time the alarm goes off when the time of day 
matches the new variable value. 

The alarm clock uses a variable to store the wake up time because the manu-
facturer knows that the wake up time will vary from person to person, and for a 
given person it may vary from day to day. Were the manufacturer to have used 
a constant for the wake up time instead of a variable, the alarm would go off at 
the same time every day for every person using it, a most inflexible situation.

Uses for variables   

Variables can be used to solve many formula problems, but they have two pri-
mary uses:

� Streamlining formulas

� Expanding formula capabilities.

Using variables to streamline formulas 

Variables allow you to write certain formulas much more efficiently than you 
can without using variables. For example, without using variables it takes this 
kind of formula to evaluate the {customer.Telephone} field to determine if the 
area code is for Washington (206, 509) or British Columbia, Canada (604):

if {customer.Telephone}[1 to 3] = “604" then
”BC”

else
if {customer.Telephone}[1 to 3] = “206" or

{customer.Telephone}[1 to 3] = ”509” then
“WA”

else
“”
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You have to write out the instructions for extracting the area code from the tele-
phone number field ({customer.Telephone} [1 to 3]) every time you want the 
formula to use the area code from the current record.

But using a variable (we'll call it AreaCode), you write those instructions one 
time. Crystal Reports uses those instructions, automatically extracts the area 
code from the {customer.Telephone} field, and stores it in the variable each 
time it reads a new record. You simply reference the variable (AreaCode) 
whenever you want to use the area code from the current record in your for-
mula. Here's an example of the formula using a variable:

StringVar AreaCode := {customer.Telephone}[1 to 3];
if AreaCode = “604" then

”BC”
else

if AreaCode = “206" or AreaCode = ”509” then
“WA”

else
“”

Not only does the streamlined version take less time to write, but it takes less 
time to process by Crystal Reports as well, so your report prints more quickly.

A word about semicolons in formulas    

In a formula with multiple statements, the result of the final statement is the 
result that is returned (gets printed). When you have multiple statements in a 
formula, you must separate the statements using a semicolon so that Crystal 
Reports knows where one statement ends and the next begins. Without semi-
colons, Crystal Reports treats the entire formula as a single statement. In a 
multiple statement formula, this can result in an incorrect result or an error 
message.

The general rule that best describes the use of semicolons in multiple state-
ment formulas is this:

� Every statement needs to end in a semicolon with two exceptions:

� The last statement in a formula doesn't need one

� The last statement before an “else” (when there are multiple state-
ments before an else) doesn't need one. 
User’s Guide 198



Using Formulas
Using Variables in Formulas5
Using variables to expand formula capabilities 

Besides their impact on streamlining formulas, variables allow you to expand 
your formula writing capabilities. Before discussing the specifics of using vari-
ables in formulas, it is important to understand some things about the way the 
Formula Editor reads formulas.

How the Formula Editor reads formulas 

Crystal Reports uses a sophisticated programming language in the Formula 
Editor. Because you can build formulas by picking fields, operators, and func-
tions from lists of options, and because Crystal Reports supplies the required 
syntax elements when you build a formula by picking items from the list, that 
language is almost transparent for the most part (that is, there is not a lot of the 
language you have to remember). 

Because of their special capabilities, however, variables:

� Come with a set of special requirements

� Require you to have a better understanding of the programming language 
than you might need if you didn't use variables in your formulas.

Special requirements for using variables in formulas 

Until now, we've worked with formula elements that were pretty narrowly 
defined:

� A given operator only works in certain situations and with certain kinds of 
text and/or data

� A function only works with a specific number of arguments, and each argu-
ment must be a specific data type

� If-then-else formulas work only if the data type of the else part of the for-
mula matches the data type of the then part.

Such narrow definition allows you to create formulas, in many cases, simply by 
filling in the blanks, with the formula checker pointing out any mistakes you 
make.
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Variables, however, are not narrowly defined. They are extremely flexible; you 
make them what you want them to be. You create them at will, and you include 
them in formulas as needed. 

Because of this flexibility, it is necessary for you to define (declare) the vari-
ables before you use them so that Crystal Reports:

� Is aware of them

� Understands how you intend to use them

� Can set aside and set up the memory space they require.

You also need to assign values to the variables so Crystal Reports knows what 
value they are to return.

Crystal Reports knows only what you tell it about the variables. The fail-safe 
formula-checker routines that work automatically with the other formula ele-
ments work with variables only after you define them.

To use a variable in a formula, you must do three things:

� Declare the variable

� Set the value of the variable

� Enter the variable in the formula.

Declaring the variable       

Crystal Reports requires you to declare all variables prior to using them. When 
you declare a variable, you tell the program:

� The name you intend to use for the variable

� The type of data you want the variable to hold. 

The program uses this information to set aside a piece of memory for receiving 
and storing the values that are assigned to the variable.

" If you declare a variable with the same name and data type in two or more 
formulas, the formulas share the same variable. Thus, if one formula sets 
the value of the variable, the variable in the second (and additional formu-
las) reflects the change.
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Name

You can nam the variable anything you wish with the following qualifications:

� The variable name must not exceed 254 characters.

� It can't have the same name as a Crystal Reports operator or built-in func-
tion.    

"  As a general rule, you're probably better off if you keep the variable name 
short, easy to remember, and unique (not so close to the name of another 
variable as to cause confusion).

Data type   

The data type of a variable determines the type of data that can be stored as a 
value in that variable. With Crystal Reports, you can create a variable with one 
of five data types:

� Number

� Currency

� Boolean

� Date

� String.

The data types correspond to the data types used throughout Crystal Reports. 
(Search for data types in Crystal Reports Help.)

How to declare a variable   

You declare a variable at the beginning of the formula that uses the variable.

" If you are using a variable that was declared in another formula, it is neces-
sary for you to declare it again. 

You declare the variable with a declaration statement that lists the data type, a 
space, the name you want to use for the variable, and a semicolon. 

For example, to declare a number variable named Amount, you enter the fol-
lowing declaration statement:
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NumberVar Amount;

If you want to declare a Boolean variable named Outstanding, you enter this for 
a declaration statement:

BooleanVar Outstanding;

If you want to declare both variables (or three, four, or more variables), you 
simply chain them together (making certain that each variable declaration 
statement ends in a semicolon). For example:

NumberVar Amount;
BooleanVar Outstanding;
DateVar MonthEnd;

Crystal Reports uses your declaration statement to set aside a block of mem-
ory to hold each of the variable values, and to assign a default value to each 
memory block. The default value assigned depends on the data type you 
declared for the variable. The default values assigned are as follow:

How to assign a value to a variable   

You assign a value to a variable using an assignment statement. The assign-
ment statement consists of:

� The variable name

� The assignment operator

� The value you want to assign to the variable.

Variable Default Values

Data type To declare Default value

number NumberVar 0

currency CurrencyVar 0

Boolean BooleanVar False (No, 0)

date DateVar null date 
(Date(0,0,0))

string StringVar empty string (“”)
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Variable name

The variable name is the name you used to declare the variable.

Assignment operator

The assignment operator is a colon followed by an equal sign (:=).

Variable value   

The variable value is any value you want to assign to the variable. A variable 
value can be a constant, an expression, or a sequence of expressions. 

Example assignment statement      

Here are the assignment statements for assigning different kinds of values to 
variables:

Amount:= 0

«Initializes (zero's out) the Amount variable.»

Amount:= 100

«Assigns the value 100 to the Amount variable.»

Amount:= Amount + {detail.QTY}

«Assigns the result of a calculation to the Amount variable. The calculation 
adds the value of the quantity field {detail.QTY} to the current value of the 
Amount variable. This expression is useful in running total situations where 
each running total consists of the current amount plus an additional value.»

Amount:= {detail.QTY1} + {detail.QTY2} + {detail.QTY3}

«Totals the three quantity fields and assigns the total to the variable named 
Amount.»

Customer:= “Westside Motors”
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«Assigns the string “Westside Motors” to the variable named Customer.»

Customer:= {file.FNAME} + {file.LNAME}

«Concatenates two fields and assigns the concatenated value of both fields to 
the Customer variable.»

Customer:= TrimRight({file.FNAME}) + {file.LNAME}

«Trims the trailing blanks from the first name field ({file.FNAME}), concatenates 
that field to the last name field ({file.LNAME}), and assigns the concatenated 
value of both fields to the variable named Customer.»

Customer:= “Mr. ” + {file.LNAME}

«Concatenates the string “Mr.” with the value of the last name field 
{file.LNAME}, and assigns the concatenated value to the variable named Cus-
tomer.»

Amount:= 100; Customer:= “Westside Motors”

«Assigns the constant 100 to the number variable named Amount, and assigns 
the string “Westside Motors” to the Customer variable. You can assign values 
to multiple variables by separating the assignment statements with semico-
lons.»

Combining a variable declaration    

For efficiency, Crystal Reports gives you the ability to declare a variable and 
assign it a value in a single line of formula code. To do this, simply declare the 
variable, allow a blank space, enter the assignment operator, and assign the 
value. For example, to declare a currency variable SellPrice and assign it the 
value of the Cost field ({file.Cost}) times two (a 100% markup), you would use 
this expression:

CurrencyVar SellPrice := {file.Cost} * 2;

To declare a Boolean variable OverQuota and assign it the result of the com-
parison {file.Sales}>{file.Quota}, you would use this expression:

BooleanVar OverQuota := {file.Sales}>{file.Quota};
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To declare and assign values to multiple variables   

In the previous section, you learned how to declare a variable and assign a 
value to it in a single step. There may be times, however, that you want to 
declare multiple variables and assign values to each of them in the most effi-
cient manner possible. To do this, you simply chain the declaration/assignment 
expressions together, separating them with semicolons. For example, to 
declare two variables (a number variable Quantity, and a currency variable 
SellPrice) and then to assign values to each variable (the number 5 to the vari-
able Quantity, and {file.Cost} * 2 to the variable SellPrice), you use chained 
expressions similar to the following:

NumberVar   Quantity := 5;
CurrencyVar SellPrice := {file.Cost} * 2;

Conditionally assigning values to variables   

Crystal Reports' formula language gives you the ability to assign different val-
ues to variables based on conditions being met or not met. Consider the follow-
ing formula:

NumberVar Total;
NumberVar Result;

Total:= Total + {invoices.ITOTAL};

If Next ({invoices.CNO})<>{invoices.CNO} then
(Result:= Total;Total:= 0)

else
Result:= 0;

Result

� The if-then-else part of this formula says that if the if condition is met (if the 
customer numbers [{invoices.CNO}] are not equal), Crystal Reports is to 
do two separate things:

� Assign the value stored in the variable Total (the running total) to the 
variable Result, and

� Reset the value in the variable Total to 0.

� If the if condition is not met (if the customer numbers are equal), Crystal 
Reports is to assign the value 0 to the variable Result.
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Understanding the programming language 

The Crystal Reports programming language has been developed as an 
expression language (in contrast to most programming languages which are 
statement languages). 

Expressions

An expression is a calculation:

� That involves fields, constants, variables, and/or functions

� That is tied together by operators

� That results in a value.

For example, the calculation:

1 + 1

is a simple expression that results in the value 2.

The calculation:

{file.Cost} < 10.00

is another expression, this one resulting in the value Yes (for values in the 
{file.Cost} field of 9.99 and lower, and No for values in the {file.Cost} field of 
10.00 or higher).

Expressions can contain subexpressions   

Expressions can contain subexpressions. For example, the calculation:

Sum ({file.Qty1}, {file.Qty2}, {file.Qty3})
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is an expression that results in the sum of the values found in the {file.Qty1}, 
{file.Qty2}, and {file.Qty3} fields. The expression, taken as a whole, results in a 
single value, which is the sum of the quantity fields. This expression, however 
includes three arguments ({file.Qty1}, {file.Qty2}, and {file.Qty3}), each of which 
is an expression in its own right. For example, {file.Qty1} can stand alone as a 
complete formula because it returns (results in) the value of the {file.Qty1} field. 
The other arguments can stand alone for the same reason.

Expressions can be joined in sequence   

A sequence of expressions can be joined by semicolons. For example, the 
expression:

1 + 1

can be joined to the expression:

“abc”

with a semicolon:

1 + 1; “abc”

When expressions are joined in sequence by semicolons, Crystal Reports 
evaluates each expression in order, but the result of the last expression 
becomes the result for the entire sequence.

The semicolon is of critical importance when working with variables in multi 
expression formulas. (Search for semicolons in formulas in Crystal Reports 
Help.)
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Example # 1

Formula

StringVar AreaCode := {customer.Telephone}
[1 to 3];

if AreaCode = “604" then
”BC”

else
if AreaCode = “206" or AreaCode = ”509” then

“WA”
else

“”

Purpose

For a database of Washington and British Columbia customers, you want Crys-
tal Reports to determine and print a state or province abbreviation for each 
record based on the area code portion (the first three characters) of the tele-
phone number field.

Explanation

StringVar AreaCode := {customer.Telephone} [1 to 3];

«Declares a string variable, names it AreaCode, and assigns to that variable 
the value of the first three characters ([1 to 3]) of the telephone number field 
({customer.Telephone}). This tells Crystal Reports:

� To set aside a block of memory to hold variable number values

� To name that memory block AreaCode, and, as it reads each record

� To store the first three characters of the telephone number field in the 
AreaCode variable.» 

" Note the difference from the earlier examples in which the variables were 
declared but left with no value assigned until later in the formula. In this 
case the variable is declared and a value is assigned in a single line of for-
mula code.
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With this arrangement, when the word AreaCode is used in the formula, Crystal 
Reports is to use the value stored in the AreaCode memory block (the area 
code for the current record) in place of the word AreaCode.

if AreaCode = “604" then
”BC”

else
if AreaCode = “206" or AreaCode = ”509” then

“WA”
else

“”

This is a fairly standard If-then-else formula. It references the variable Area-
Code instead of a database field from which the area code can be extracted.

The first line:

if AreaCode = “604" then

The first line (the first if condition) says that if the value of the AreaCode vari-
able is “604" (the BC area code), the first then part of the formula should be 
triggered.

The second line:

“BC”

«Indicates what is to happen if the first if condition is met (if the area code is 
604). When the first if condition is met, the formula is to print the characters 
“BC”.»

The third and fourth lines:

else
if AreaCode = “206" or AreaCode = ”509” then

«Indicate what is to happen if the first if condition is not met (if the area code is 
not 604). This circumstance triggers the first else part of the formula. The else 
action is a second if condition. The formula is to evaluate the AreaCode vari-
able and determine if the value of that variable is either “206" (Washington) or 
”509” (also Washington). If it is, then the second then part of the formula should 
be triggered.»
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The fifth line:

“WA”

«Indicates what is to happen if the second if condition is met (if the area code is 
either 206 or 509). When the second if condition is met, the formula is to print 
the characters “WA”.»

The sixth and seventh lines:

else
“”

«Indicates what is to happen if the second if condition is not met (if the area 
code is not 206 or 509). If the second if condition is not met, the formula is to 
print the empty string “” (that is, print nothing). This would happen in the rare 
case that the area code was typed into the telephone number incorrectly, that it 
was left out of the telephone number entirely, or that a record with a telephone 
number outside BC and Washington was inadvertently entered into the data-
base.» 

Notes to consider

In this formula, the entire if-then-else part of the formula follows the only semi-
colon (the semicolon at the end of the variable declaration/assignment state-
ment). Since it follows the last (only) semicolon, the if-then-else formula, taken 
as a whole, becomes the final statement in the formula, and the result of that if-
then-else formula (“BC”, “WA”, or “”) is what gets printed.

While this formula can be done without variables, the formula takes less time to 
write, consumes less memory, and prints more quickly than a similar formula 
without the use of variables.
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Example # 2

Formula

NumberVar  Runtotal;

If Previous({detail.INO})<>{detail.INO} then
Runtotal:= 0

else
0;

Runtotal:= Runtotal + {detail.LTOTAL}

Purpose

Crystal Reports may be used to prepare invoices. Each invoice is made up of 
one or more line items drawn from a database of invoice details. You want 
Crystal Reports:

� To keep a running total of the line items for each invoice,

� To print the running total as it processes each record,

� To print the invoice total when the invoice number changes, and

� To reset the running total calculator to 0 prior to reading the first record for 
the next invoice.

Explanation

NumberVar  Runtotal;

«Declares a number variable and names it Runtotal. This tells Crystal Reports 
to set aside a block of memory to hold variable number values, and to name 
that memory block Runtotal. With this arrangement, if the word Runtotal is 
used in a formula, Crystal Reports is to use the value stored in the Runtotal 
memory block in place of the word Runtotal.»
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If Previous({detail.INO})<>{detail.INO} then
Runtotal:= 0;

else
0;

«This is the heart of the formula. It performs important side events (sets vari-
able values) that impact the formula output (the result of the last statement in 
the formula).»

The first line:

If Previous({detail.INO})<>{detail.INO} then

is the if part of the formula. It uses the Previous function to evaluate the value 
of the invoice number field ({detail.INO}) for the previous record. It then com-
pares that value to the value of the invoice number field for the current record. 

� When the two values are equal, the invoice numbers are the same indicat-
ing that the next record belongs to the same invoice. 

� When the two numbers are not equal, the invoice number changes signal-
ing the start of a new invoice.

The then part of the formula triggers when the numbers are not equal, that is, it 
triggers whenever the invoice number (and hence the invoice) changes.

The second line:

Runtotal:= 0; 

«Tells what is to happen if the if condition is met (if the invoice number 
changes). When that condition is met, the formula is to reset the value of the 
variable Runtotal to 0 (Runtotal:= 0). It resets the value so that the calculations 
for the current invoice begin with 0 rather than with a residual value from the 
previous invoice.»

The third and fourth lines:

else
0;
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«Tell what is to happen if the condition is not met (if the invoice numbers are 
equal, indicating that the invoice number has not changed). When the if condi-
tion is not met, the formula is to return the value 0 for the current record.»

The final line of the formula:

Runtotal:= Runtotal + {detail.LTOTAL}
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«Uses the assignment operator (:=) to assign a value to the variable named 
Runtotal. In this case, the value assigned is the result of a calculation. That cal-
culation is the current value of the variable Runtotal plus the line total 
({detail.LTOTAL}) for the current invoice. This line is used to track a running 
total for the invoice. For example, if the records indicate line totals of 100, 200, 
and 450 respectively, the value of the variable Runtotal (the running total for 
the current invoice) changes as follows:

Since this is the final statement in the formula, the result of this statement is the 
formula output (what gets printed).

Changes in value of the variable Runtotal

detail.INO#
 (Invoice 
Number)

Runtotal
Line 
Total 

(LTOTAL)

Calculation 
(Runtotal + 

LTOTAL)

Invoice 
Total

1001 0 100 0 +100 0

1001 100 200 100+200 0

1001 300 450 300+450 0

750 750

1002 0 375 0+375 0

1002 375 100 375+100 0

475 475

1003 0 200 0+200 0

1003 200 240 200+240 0

1003 440 150 440+150 0

590 590

1004 0 100 0+100 100
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Example # 3

Formula

NumberVar Total;
NumberVar Result;

Total:= Total + {invoices.ITOTAL};

If Next ({invoices.CNO})<>{invoices.CNO} then
(Result:= Total;
Total:=0)

else
Result:= 0;

Result

Purpose

This formula is designed to keep a running total of the invoices for each cus-
tomer, and to print the total of all invoices for the customer once the final record 
for that customer is processed. 

The formula is set to print a zero (0) for each record that it processes that is not 
the final record for the customer. (Since the if part of the formula results in a 
number, the else part must result in a number too. The number zero satisfies 
that formula requirement.) If you format the formula field using the Format 
Number/Suppress if Zero option (search for Format Number dialog box in 
Crystal Help). Crystal Reports hides all the zero values, and the net effect is to 
show customer totals only. 

Explanation

NumberVar  Total;

«Declares a number variable and names it Total. This tells Crystal Reports to 
set aside a block of memory to hold variable number values, and to name that 
memory block Total. With this arrangement, if the word Total is used in a for-
mula, Crystal Reports is to use the value stored in the Total memory block in 
place of the word Total.»
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NumberVar Result;

«Declares a number variable and names it Result. This tells Crystal Reports to 
set aside another block of memory to hold variable number values, and to 
name that memory block Result. With this arrangement, if the word Result is 
used in a formula, Crystal Reports is to use the value stored in the Result 
memory block in place of the word Result.»

Total:= Total + {invoices.ITOTAL};

«Uses the assignment operator (:=) to assign a value to the Total variable. In 
this case, the value assigned is the result of a calculation. That calculation is 
the current value of the variable Total plus the invoice total ({invoice.ITOTAL}) 
for the current invoice. As further lines of the formula will reveal, this line is 
used to total the value of invoices for a given customer. For example, if the 
records indicate invoice totals of 100, 200, and 450 respectively, the value of 
the variable Total (the total value of invoices for a given customer) changes as 
follows:»

 Table shows how Total’s value is changed by the formula line
 Total :=Total+{invoices.ITOTAL}

If Next ({invoices.CNO}) <> {invoices.CNO} then
(Result:= Total;
Total:=0)

else
Result:= 0;

Changes in the value of the variable Total

Total
Invoice Total 

(ITOTAL)
Calculation (Total + ITOTAL = 

new Total)

0 100 0+100

100 200 100+200

300 450 300+450

750
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«This is the heart of the formula. It performs important side events (sets vari-
able values) that impact the formula output (the result of the last statement in 
the formula).»

The first line:

If Next({invoices.CNO})<>{invoices.CNO} then 

«is the if part of the formula. It uses the Next function to evaluate the value of 
the customer number field ({invoices.CNO}) for the next record. It then com-
pares that value to the value of the customer number field for the current 
record.

When the two values are equal, the customer numbers are the same indicating 
that the next record belongs to the same invoice. 

When the two numbers are not equal, the customer number changes signaling 
the start of a new invoice.

The then part of the formula triggers when the numbers are not equal, that is, it 
triggers whenever the customer number (and hence the invoice) changes.»

The second and third lines:

(Result:= Total;
Total:=0)

«Tell what is to happen if the if condition is met (if the customer number 
changes). When that condition is met, the formula is to assign the value of the 
variable Total to the variable Result (Result:= Total;) and then reset the value 
of the variable Total to 0 (Total:= 0). It resets the value so that the calculations 
for the next invoice begin with 0 rather than with a residual value from the cur-
rent invoice.»
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The final line:

The final line of the if-then-else formula (Result:= 0;) is the else part of the for-
mula, the action that is to take place when the if condition is not met (if the cus-
tomer number does not change). When that condition is not met, the formula is 
to assign the value 0 to the variable Result.

Result

«This line says to print the value of the variable Result. The value printed is 
determined by the outcome of the if-then-else formula that precedes it. 

� If the if condition is met (if the customer number changes), the value of the 
variable Result is the value of the variable Total before it was reset to 0. 

Thus, if Total had begun at 0 and the invoice totals (values of the 
{invoices.ITOTAL} field for each record with the same customer number) had 
been added to it, the value of the variable Total that is assigned to the variable 
Result (and is printed) is the total of all invoices for the customer.

� If the if condition is not met (if the customer number does not change), the 
value of the variable Result is set to 0, and the formula prints the value 0.»

The following data shows the interrelationship between the variables and the 
output from this formula:

Interrelationship between variables and output

Cust# Total
InvoiceTotal 

(ITOTAL)

Calculation 
(Total + 
ITOTAL)

Result

1001 0 100 0 +100 0

1001 100 200 100+200 0

1001 300 450 300+450 0

750 750

1002 0 375 0+375 0

1002 375 100 375+100 0
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" You can achieve the same results as you do with this formula by subtotal-
ing the invoice total field {invoices.ITOTAL} every time the value changes 
in the customer number field {invoices.CNO}, and by placing the subtotal 
on the same line in the Details section as the invoice total field.

475 475

1003 0 200 0+200 0

1003 200 240 200+240 0

1003 440 150 440+150 0

590 590

1004 0 100 0+100 0

Interrelationship between variables and output

Cust# Total
InvoiceTotal 

(ITOTAL)

Calculation 
(Total + 
ITOTAL)

Result
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Order of Precedence       

When entering formulas that contain different kinds of operators, it is important 
to consider order of precedence, the order in which Crystal Reports performs 
the operations in your formula. 

You learned simple order of precedence in high school math: when performing 
calculations, do multiplication and division first, then addition and subtraction. 
Thus:

5 + 10 x 3 = 35

The calculation 10 x 3 is performed first to get 30. 30 is then added to 5 to 
arrive at the final answer.

Now if your intention is to add 5 to 10 and then multiply the sum by 3, you have 
to modify the order of precedence with parentheses. You can do that thus:

(5 + 10) x 3 = 45

It's clear that parentheses have a higher precedence than the add, subtract, 
multiply, and divide operators. They redirect the order of calculation.

You learned all of this in school and Crystal Reports follows the same rules of 
precedence. But Crystal Reports uses many additional operators, and it's 
important for you to understand the precedence the program assigns to each 
so you can write your formulas to perform as expected.

� In the following list, Crystal Reports performs the top level operations first, 
then the second level, then the third, and so forth.

� When it encounters two or more operations that are on the same level, it 
performs them left to right.   

Level 1 Parentheses, Arrays, If Then Else

Level 2 Functions, Subscript

Level 3 + sign in front of value, Negate, Dollar, Not

Level 4 Multiply, Divide, Percent

Level 5 Add, Subtract
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Precedence examples 

Example 1

If 24 in [(7-1) *4, 7- 1*4 ] then 

“Hit” 

else 

“Miss”

This formula consists of the following components: 

� The calculation in the parentheses is done first. That redirects the order of 
calculation so that 
(7-1)*4 = 24 while 7-1*4 = 3.

Level 6 To

Level 7 Less than, Greater than, Greater than or equal, 
Less than or equal, In

Level 8 Equal, Not equal

Level 9 And

Level 10 Or

Precedence Example No. 1

Order of appearance Order of precedence

If-then-else operator Parentheses

In array operator Make array operator

Make array operator If-then-else operator

Parentheses Multiply operator

Subtract operator Subtract operator

Multiply operator In array operator
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� Crystal Reports makes the array next. The array consists of two values: 24 
and 3.

� Finally, the If then else operator uses the calculated values in the array as 
the If condition.

Example 2

Average([ToNumber(“12345"[3 to 4]), ToNumber(”2468”[2 to 
3])])

This formula consists of the following components:

Precedence Example No. 2

� This calculation uses the function ToNumber to convert the strings “12345" 
and ”2468” to numbers. 

� Once converted, it uses the Subscript operator to pull out the 3rd and 4th 
digits in the first number (34) and the 2nd and 3rd digits in the second (46).

� These two numbers are then averaged to arrive at the number 40 (80/2 = 
40).

� The Average function is on hold to the very end because the rest of the cal-
culations take place within parentheses which gives them primary prece-
dence.

Order of appearance Order of precedence

Average Parentheses

Parentheses ToNumber

ToNumber Subscript

Subscript Average
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Example 3

 ToText(Abs({file.quota}-{file.sales})/
{file.quota} * 100) + “%”

This formula consists of the following components:

� The work inside the parentheses is done first. If there are parentheses 
inside parentheses, the work in the innermost parentheses is done first. 
Thus the subtraction of {file.sales} from {file.quota} is performed first.

� The Abs function is performed next because it is inside the primary paren-
theses and because it takes precedence over the divide and the multiply 
operators that are also inside the parentheses.

� Once the absolute value of the difference between {file.quota} and 
{file.sales} is calculated, that value is divided by {file.quota} and the result 
is multiplied by 100. (The divide and multiply operators have equal prece-
dence so they are used in the order they appear from left to right.)

� The result of this calculation is then converted to text using the ToText 
function. Now we're outside the parentheses so the ToText function takes 
precedence over the Concatenate operator (+).

� Finally, the percentage character “%” is concatenated to the calculated 
value which has been converted to text. This creates one continuous text 
string.

Precedence Example No. 3

Order of appearance Order of precedence

ToText function Parentheses

Parentheses Abs function

Abs function Divide operator

Divide operator Multiply operator

Multiply operator ToText function

Concatenate operator Concatenate operator
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Formula Evaluation Time Considerations      

Crystal Reports evaluates different formulas at different times, depending on 
formula content.

� If no database or group field is included in the formula, the formula is eval-
uated before the program reads database records. This is because nothing 
in the formula is dependent on data drawn from database records or 
assigned only at print time.

� If a database field is included in the formula, the formula is evaluated while 
the program reads database records. This is because the database field 
information must be drawn from the database records before it can be 
used in the formula.

� If a group field, page number field, subtotal, etc. is included in the formula, 
the formula is evaluated after database records are read and while the 
data from the records is being printed in the report. This is because the 
value of one or more of the elements in the formula won't be assigned until 
the report is organized and formatted for printing.

" A formula is always evaluated based on the element in the formula with the 
latest evaluation time. Thus, if a database record and a page number field 
are used in the same formula, the page number field (the field with the lat-
est evaluation time) will force the formula to be evaluated while printing 
records.

In most cases, evaluation time won't be an important consideration as you 
develop formulas. But in certain cases, standard evaluation times will generate 
unsatisfactory results. In such cases you will need to force a later evaluation 
time than usual for the problem formulas. Crystal Reports includes two evalua-
tion time functions you can use in your formulas for this purpose: WhileReadin-
gRecords, and WhilePrintingRecords. It includes a third evaluation time 
function, BeforeReadingRecords, that you can use in your formulas to clarify 
the evaluation time relationships between the various formulas.   

" You can only force a later evaluation time, never an earlier one. Hence, 
BeforeReadingRecords (the function with the earliest evaluation time) can 
never be used to force a non-standard evaluation time on a formula.

The following example illustrates a typical evaluation time problem and its solu-
tion using one of the evaluation time functions.
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Example using an evaluation time function   

This example illustrates the use of an evaluation time function to take a formula 
that would normally be evaluated while reading records and force it instead to 
be evaluated while printing records. 

Scenario

You want to create an order detail report that:

� Shows the extended price for each line item

� Calculates a running total for each line

� Resets itself to 0 for each new order.

Unless you disabled the Samples and Examples option during installation, the 
report, called EVALTIME.RPT, is one of the sample reports that was installed 
on your system. An example showing partial data from that report follows:

Order Detail Report

Order# Item# Qty Price Extension RunTotal

2203

2203 1002 3 276.00 828.00 828.00

2203 1102 1 1230.00 1230.00 2058.00

Total for order 2203 2058.00

2204

2204 1001 7 192.00 1344.00 1344.00

2204 1002 3 276.00 828.00 2172.00

2204 1003 1 484.00 484.00 2656.00

2204 1102 3 1230.00 3690.00 6346.00

Total for order 2204 6346.00
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   The report uses four database fields:

It uses three formulas:

@extend

{detail.QTY} * {detail.PRICE}

«@extend simply calculates the extended price for a line item (quantity ordered 
times price per item). This provides the values in the Extension column.»

@initialize

NumberVar Runtotal;
If {detail.ORDERNUM} <> Previous ({detail.ORDERNUM}) then

Runtotal := 0
else

Runtotal := Runtotal

«@initialize resets the variable Runtotal each time the order number changes 
so the running total for each order begins at 0.»

@running

WhilePrintingRecords;
NumberVar Runtotal;
Runtotal:= Runtotal + {@extend}

«@running calculates the running total for each order by adding the extended 
price for each line item to the existing running total for the order. This provides 
the values in the Running Total column.»

And it includes one subtotal:

Sum of @extend

Order# {detail.ORDERNUM}

Item# {detail.ITEMNUM}

Qty {detail.QTY}

Price {detail.PRICE}
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Group footer #1: detail.ORDER
Sum of @extend

«It subtotals the extended price each time the order number changes, thus pro-
viding the Total for order nnnn order total.»

The evaluation time problem in this report

The evaluation time problem which is solved with one of the evaluation time 
functions involves the relative evaluation time of two formulas, @initialize and 
@running.

� @initialize includes the Previous function which is evaluated while records 
are printed. Any formula that includes the Previous function, therefore, will 
be evaluated while the records are printing as well.

� @running, on the other hand, is normally evaluated while records are read.

If we leave both formulas to be evaluated at their normal times, 

� @running is evaluated first (during record read time) and it outputs running 
totals for each line item. 

� Then, after it is finished calculating the running totals, @initialize is evalu-
ated (during record print time). This formula initializes (sets to 0) the Runto-
tal variable each time the order number changes.

By this time it's too late. The running totals have already been calculated 
without being initialized between orders. The final printed report shows run-
ning totals getting bigger with each line item; they are not reset from order 
to order.
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Your report comes out looking like this:

� @Running doesn’t include evaluation time function

To solve this problem, you must make certain that @initialize is evaluated at 
the same time as @running. You can't force a print time evaluation formula 
(@initialize) to evaluate at read time (forcing it to be evaluated before the 
required data is available), but you can force a read time evaluation formula 
(@running) to evaluate later, at print time. You do this by starting the formula 
(as we did) with the function WhilePrintingRecords;

WhilePrintingRecords;
NumberVar Runtotal;
Runtotal:= Runtotal + {@extend}

Order Detail Report

Order# Item# Qty Price Extension RunTotal

Order 
#2203

2203 1002 3 276.00 828.00 828.00

2203 1102 1 1230.00 1230.00 2058.00

Total for order 2203 2058.00

Order 
#2204

2204 1001 7 192.00 1344.00 1344.00

2204 1002 3 276.00 828.00 2172.00

2204 1003 1 484.00 484.00 2656.00

2204 1102 3 1230.00 3690.00 6346.00

Total for order 2204 6346.00
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When you do this, your report comes out looking like you want it, like this:

Copying Formulas from one Report to Another     You may find yourself wishing 
to copy a formula created in one report for use in a new (or different) report. 
Copying formulas from one report to another is a simple procedure, but it 
requires careful attention to detail.

Since formulas are stored as text, it is a simple matter to copy the text formula 
from one report to another via the Windows Clipboard. Once the formula is 
copied however, you need to consider the following points:

� All fields, formulas, and group fields referenced in the formula copy must 
actually exist in the new report. This means that any database referenced 
in the original formula (or a database with the same structure, field names, 
and alias) must be active in the new report.

If such a database isn't active, you must change the field, formula, and 
group field references in the formula copy to correspond to elements in 
your.

Order# Item# Qty Price Extension RunTotal

Order 
#2203

2203 1002 3 276.00 828.00 828.00

2203 1102 1 1230.00 1230.00 2058.00

Total for order 2203 2058.00

Order 
#2204

2204 1001 7 192.00 1344.00 1344.00

2204 1002 3 276.00 828.00 2172.00

2204 1003 1 484.00 484.00 2656.00

2204 1102 3 1230.00 3690.00 6346.00

Total for order 2204 6346.00
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� If your formula contains conditional elements, make certain that the condi-
tions apply to the data in the new report. For example, if the formula in your 
old report performed an action when the quantity was greater than 100, 
make sure that the greater than 100 condition makes sense in the new for-
mula. When modifying a formula, you may find that greater than 10 or 
greater than 2000 makes more sense with your new data.

� If you are using the formula with new data, and if your report contains 
statements similar to this: 

if{file.value} = “text string” 

make certain that the text strings used in the formula match values that 
actually exist in the new data.

Follow the procedure below to copy a formula from one report to another.

Step Action

1. Call up the Formula Editor with the formula that you want to copy. You 
can do this by clicking the formula in your report and then:

� Selecting Edit/Formula , or 

� Selecting Edit Formula from the right mouse button menu.

2. Highlight the formula in the Formula Editor by dragging the I-beam cur-
sor over it while keeping the left mouse button depressed. Release the 
mouse button when you're finished.

3. Press CTRL-INS (the Windows Copy command). 

Response : Windows sends a copy of the formula to the Clipboard.

4. Close the dialog box, close the existing report, and open the report to 
which you want to copy the formula.

5. Select Insert/Formula  Field. 

Response : The Insert Formula dialog box appears. 
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6. Enter the name under which you want to save the copied formula and 
click OK when finished. 

Response : The Formula Editor appears with the insertion point flash-
ing.

7. Press SHIFT-INS (the Windows Paste command). Windows pastes the 
formula copy at the insertion point.

8. Change the fields, formulas, group fields, conditional statements, and 
text strings if necessary for use with the data used in the new report. 

" To make these changes (if necessary), delete the old values and 
type in the new values, or select them from the Fields, Functions, 
and/or Operators lists.

9. Click Accept when finished. The rectangular placement cursor 
appears.

10. Position the cursor where you want the formula to appear, and click the 
left mouse button to place it.
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6 6Using Crystal Reports with
SQL and ODBC
How Crystal Reports Works with SQL and ODBC

With Crystal Reports, you can create reports with data from a variety of SQL 
and non-SQL data sources. While the files for using SQL databases are only 
available in the Professional Edition of Crystal Reports, the Standard Edition 
includes a number of SQL-oriented features. These features are in the pro-
gram because the Standard Edition supports the use of Excel, ACCESS, and 
ASCII files via ODBC which uses the SQL language.

This chapter shows you how to use Crystal Reports with data from SQL data-
bases and databases that utilize ODBC.

" Throughout this chapter, the term SQL refers to both SQL and ODBC data 
sources unless otherwise specified.

Logging onto a SQL server 

Crystal Reports provides three ways of logging on to a SQL server:

� Logging on as part of the report creation process

� Logging on outside the report creation process

� Logging on using the Query Expert.
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Logging on while creating a report

You can log onto a server as part of the process of activating a SQL table for 
use in a report.

Whenever you select File/New/Report , File/New/Mailing Label , File/New/
Cross-Tab  or Database/Add File to Report , the Choose Database File dialog 
box appears.

" If you use the Report Gallery and select SQL Table as your from: source, 
you go directly to the Log On Server dialog box, bypassing the Choose 
Database File dialog box. 

You can use this dialog box to select a non-SQL database file for use in your 
report, but you can also use it as a gateway for logging on to a SQL server and 
activating a database and table for use in your report. 

Activating a SQL database/table

Follow the procedure below to activate a SQL database/table during the report 
creation process.

Step Action

1. To begin the report creation process, do one of the following:

� If you want to select the first SQL table for use in a report (and no 
other non-SQL databases or tables are active), select File/New/
Report .

� If you want to select the first SQL table for use in a mailing labels 
report (and no other non-SQL databases or tables are active), 
select File/New/Mailing Label .

� If you want to select the first SQL table for use in a Cross-tab 
report (and no other non-SQL databases or tables are active), 
select File/New/Cross-tab .
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� If you want to select the first SQL table for use in a report (and 
other non-SQL databases are already active), select Database/
Add File to Report . The Choose Database File dialog box 
appears.

" If you have it activated, the Report Gallery appears at this time 
unless you have set your SQL Options (via File/Options ) to 
go directly to a specific server. Once in the Report Gallery, 
select SQL Table as your from: source and you'll go directly to 
the Log On To Server dialog box.

2. Click the SQL Server button. 

Response : The Log On to Server dialog box appears listing the vari-
ous SQL server types available on your system. 

3. Select the server type that you want to log on to and click OK when fin-
ished.

Response : A dialog box appears requesting server-specific login infor-
mation. use this dialog box to identify yourself and to specify the data-
base you want to activate.

" If you want to activate multiple databases from the same server, 
you will need to log on to the server each time you want to activate 
a database. 

Some of the following items will be in the dialog box (depending on the 
server type requested).

� SQL Server
Enter the name of the SQL server you want to log on to. 

" For ODBC users, SQL Server name is the ODBC Datasource 
name.

� Database
Enter the name of the database you want to activate in the speci-
fied SQL server.

� User ID
Enter the name you use to log on to the specified server.
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� Password
Enter the password you use to log on to the specified server.

� Dict Path
When using Netware SQL, enter the path for the data dictionary 
(.dbf) files.

� Data Path
When using Netware SQL, enter the path for the data files. Enter 
the requested login information and click OK when finished. Crys-
tal Reports logs you onto the specified server and takes you to the 
Choose SQL Table dialog box. 

Action : The Choose SQL Table dialog box works in a similar manner 
to the Choose Database File dialog box. You use the Choose SQL 
Table dialog box to select the table you want to activate for use in your 
report.

The dialog box contains three smaller boxes and two buttons (in addi-
tion to the OK, Cancel, and Help buttons).

� SQL Tables box
The SQL Tables box lists all of the tables in the active database. 
Select the table you want to include in your report.

� SQL Databases box
The SQL Databases box lists all of the databases you have acti-
vated. Select the database that contains the table you want to use 
in your report.

� Server Info box
The Server Info box identifies the active server, the active data-
base, and the user who activated them.

� Log On Server button
The Log On Server button returns you to the Log On To Server 
dialog box. You can use this button when you want to activate 
another database. When you return to the Log On To Server dia-
log box, select the server type and Click OK, and then enter the 
name of the database you want to activate and the other 
requested login information in the Server Login dialog box when it 
appears.
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� Database File button
The Database File button takes you to the Choose Database File 
dialog box. Once in that dialog box you can activate non-SQL 
databases for use in your report.

Logging on outside the report creation process

You can log onto a SQL server using the Database|Log On Server command 
when you first call up Crystal Reports (or at any other time while using the pro-
gram). The Log On Server command was created for those times you want to 
log onto a SQL server to have the server and database activated and standing 
by for later use in a report. For example, if you want to review or revise an 
existing report and then create a new report using a SQL table, you might log 
on to the SQL server and activate a database when you first call up Crystal 
Reports. Then, when you're finished revising the existing report, you can select 
a SQL table from the active server/database and create your new report. 

To log on, use the Database/Log On Server  command below.

Activating additional tables from a SQL database

When you have already activated one table in a SQL database and you want to 
activate an additional table from that database, use the following procedure.

Step Action

1. Select Database/Add File to Report . 

Response : The Choose SQL Table dialog box appears.

2. Select the table you want to activate and click OK when finished. 

Response : The Choose Tables To Use In Graphical Linking dialog 
box appears. All the tables you have selected appear in the Invisible 
Tables box in the Unlinked Tables section of the dialog box. 

Action : To set up graphical linking between the tables, click the All 
button. The program moves all the table names to the Visible Tables 
box.
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3. Make sure the Perform Smart Linking switch is active if you want the 
program to suggest link fields for you.

4. Click OK when finished.

Response : The Graphical Linking dialog box appears with graphical 
representations of each of your selected tables. If you activated the 
Perform Smart Linking switch, there will be a line between the fields 
the program suggests for linking the tables. 

Action : Do one of the following:

� If there is a suggested link and you want to accept it, click OK.

� If there is a suggested link and you don’t want to accept it, select 
the linking line for the link you want to change. The program high-
lights the linked fields when you select the linking line. Click the 
right mouse button and select Delete Linking from the menu or 
click the Delete Linking button to remove the link. 

� To create a new link, drag the link field in one table to the link field 
in another table. Repeat the process for each additional link you 
need to make and click OK when finished.

� If you want to specify the kind of join the program makes, click the 
Link Options button. The Link Options dialog box appears with only 
the join options active. Since different SQL servers offer different 
join options, the options that appear in the scroll list will vary from 
server to server. For an explanation of each of the join options that 
appear on your list, please see the SQL manual.

5. Once your links are satisfactory, click OK and the program activates 
the selected table and returns you to the Design window.

6. Repeat Steps 1-6 for each additional table you want to activate from 
the active SQL database. 

" If you have logged on to a SQL database and you want to activate a new 
table but from a different SQL database, click the Log On Server button in 
the Choose SQL Table dialog box. This returns you to the Log On To 
Server dialog box where you can select the server type for the next data-
base you want to activate.
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SQL Menu Commands

The following three commands appear on the Crystal Reports Database menu. 

� Log On Server

� Log Off Server

� Show SQL Query.

Log On Server (I)   

Figure 6-1. Log On Server dialog

Use Database/Log On Server  to log onto a SQL database server.

Using Database/Log On Server

Follow the procedure below to use Database/Log On Server .

Step Action

1. Select Database/Log On Server . 

Response : The Log On To Server dialog box appears.

2. In that dialog box, the SQL Types box lists the various SQL server 
types that are available to your system. Select the server type that you 
want to log on to and click OK when finished.

Response : A dialog box appears requesting server-specific login infor-
mation. 
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3. You use this dialog box to identify yourself and to specify the database 
you want to activate. 

" If you want to activate multiple databases from the same server, 
you will need to log on to the server each time you want to activate 
a database. 

Some of the following items will be in the dialog box (depending on the server 
type requested).

� SQL Server
Enter the name of the SQL server you want to log on to.

" For ODBC users, SQL Server name is the ODBC Datasource name.

� Database
Enter the name of the database you want to activate in the specified SQL 
server.

� User ID
Enter the name you use to log on to the specified server.

� Password
Enter the password you use to log on to the specified server.

� Dict Path
When using Netware SQL, enter the path for the data dictionary (.dbf) files.

� Data Path
When using Netware SQL, enter the path for the data files. Enter the 
requested login information and click OK when finished. Crystal Reports 
logs you onto the specified server and returns you to the Crystal Reports 
Window (or to the Design window if you were in the Design window when 
you chose the Database/Log On Server  command). 
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Log Off Server (I)   

Figure 6-2. Log Off Server dialog

Use the Log Off Server command to log off of an active SQL database.

Using Log Off Server

Follow the procedure below to use Log Off Server.

Step Action

1. Select Database/Log Off Server . 

Response : The Log Off Server dialog box appears. The Opened SQL 
Servers box lists the SQL servers that are currently activated.

2. Select the server from which you want to log off and click the Log Off 
button.

Response : The program logs you off the selected SQL server.

3. If you want to log off additional servers, repeat Step 2 as many times 
as necessary.

4. Click OK when finished and the program returns you to the Crystal 
Reports Window (or the Design window if you were in the Design win-
dow when you chose the Database/Log Off Server  command).
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Show SQL Query (Q)   

Use the Show SQL Query command to view the SQL query Crystal Reports 
sends to your SQL server. 

Using SQL Query

Follow the procedure below to use Show SQL Query.

Step Action

1. Click Database/Show SQL Query .

Response : The Show SQL Query dialog box appears:

Figure 6-3. Show SQL Query dialog

The Show SQL Query dialog box displays the SQL query Crystal 
Reports is sending to your SQL server and allows you to edit that 
query. The query is displayed in three parts:

� Select.  Select lists all of the fields used in the report, including fields used 
in formulas, totals, the sort order, the selection formula, and ranges. For 
example:

SELECT
  DIV_INFO.DIVISION_ID, DIV_INFO.DIVISION_NAME,
  DEP_INF O.DEPARTMENT_ID, DEP_INFO.DEPARTMENT_NAME
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shows that the report is using the DIVISION_ID, DIVISION_NAME, 
DEPARTMENT_ID, and DEPARTMENT_NAME fields.

� From.  From lists all the tables used in the report, and each table name is 
followed by an alias name. For example, 

FROM 
  SYSADM.DIV_INFO DIV_INFO,
  SYSADM.DEP_INFO DEP_INFO

shows that the report is using the DIV_INFO and DEP_INFO tables from 
the SYSADM database, and in each case, the alias name is the same as 
the table name.

� Where.  Where specifies any links between tables and field ranges for the 
report. For example

WHERE
  ION_ID=DEP_INFO.DIVISION_ID

shows that the DIV_INFO and DEP_INFO tables are linked via the 
DIVISION_ID fields.

� Order By.  Order By sorts the data in alphabetic or numeric ascending or 
descending order. This is useful to display data differently than the default 
sort order of the database. For example

ORDER BY
  DIV_INFO.DIVISION_ID ASC

sorts the records in ascending order by the values that appear in the 
DIV_INFO.DIVISION_ID field.

2. Click the OK button when you're finished viewing the query.

Editing the query

When you are using a SQL data source and you use the Report/Select 
Records  command, Crystal Reports automatically generates a query to send 
to your server. Crystal Reports Professional enables you to edit this query.
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If you want to edit the query for performance reasons, or if you want to create a 
more complex query than you can create using Select Records, you can edit 
the From and Where parts of the query via the Show SQL Query dialog box.

" You can also build queries using the Report/Edit Record Selection For-
mula  command. If those queries get too complex, however, you may have 
to edit the queries the program generates.

To edit the query you can delete, type over, or append to existing text. While all 
of these capabilities are available to you, you will achieve the best results if you 
follow these suggestions:

1. Edit the query as much as you can via the Report/Select Records  com-
mand.

2. Then, if the query doesn't meet your needs, append your changes to the 
end of the query if possible. If you append your changes, the program will 
remember them.

If you return to Select Records and make additional changes, the program will 
generate a new query based on the changes you made in Select Records. It 
will then append your original changes to the new query it generates.

Notes:

� If you overwrite the query, you also overwrite the existing selection formula 
in the report. Your modified SQL query remains but the selection formula in 
the report reverts to blank. If you then use Select Records to modify your 
SQL query, the new query the program generates will overwrite the 
changes you made earlier in the Show SQL Query dialog box. You will, of 
course, be given the option to cancel the changes and avoid the overwrite.

� If you plan to override links in the SQL query, leave them defined in the 
report anyway. The program has to know about all of the tables that are to 
be used in the report so it can pass all sets of fields to the query. If all of the 
fields are passed and you then change the links via this dialog box, the 
program will use the links the way you've defined them in the query. 
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How SQL Queries are Handled

Crystal Reports is a two-pass report writer. When you use SQL data for your 
reports, the program off-loads as much of the first pass as possible to the SQL 
server to reduce processing time and network traffic. The following table shows 
which part of the first pass are pushed down to your SQL Server and which 
parts are being handled by Crystal Reports itself. 

The following section describes in more detail how tasks off-loaded to the SQL 
Server appear in the SQL query generated by Crystal Reports.

Design Process Handled by 

Selecting tables for the report SQL Server

Selecting fields from the tables SQL Server

Alias naming SQL Server

Linking fields between tables SQL Server

Grouping-Sorting records to be grouped SQL Server

Grouping-Grouping sorted records Crystal Reports

Sorting records SQL Server

Sorting groups Crystal Reports

Selecting records SQL Server

Selecting Groups Crystal Reports
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Selecting tables and fields

Selecting the tables and fields to be included in your report is the most basic 
function of generating the report. Gathering large amounts of data, however, 
can be time consuming and require a large number of system resources. To 
speed up the task and free up your workstation, Crystal Reports off-loads this 
process to your SQL Server with code similar to the following:

SELECT
 table1.field1, table1.field2,
 table2.fieldx, table2.fieldy
FROM
 database.table1 table1,
 database.table2 table2

The SELECT clause indicates which fields are required, while the FROM 
clause indicate which tables in the SQL database are to be used.

Alias naming

The SQL query declares alias names in the FROM section of the query:

FROM
 databasename.table1 myalias

Note how this affects the rest of the SQL query in the following code:

SELECT
 myalias.field1, myalias.field2,
 table2.fieldx
FROM
 database.table1 myalias,
 database.table2 table2
WHERE
 myalias.field1 = table2.fieldy

The alias name for Table 1 is used in the query in place of the table name itself.
User’s Guide 245



Using Crystal Reports with SQL and ODBC
How SQL Queries are Handled6
Linking fields between tables

Linking tables with fields that contain the same or similar data is also handled 
by the SQL query. The following example links three tables in a SQL database:

SELECT
 orders.ordernum, orders.orderamount,
 detail.ordernum, detail.customernum
 customer.customernum, customer.name
FROM
 database.orders orders,
 database.detail detail,
 database.customer customer
WHERE
 orders.ordernum = detail.ordernum AND
 customer.customernum = detail.customernum

Information that follows the WHERE clause sets conditions on how information 
in the tables is retrieved. In this case, fields are linked between tables to assure 
that information drawn from one table matches information drawn from 
another.

Grouping/summarizing records

Crystal Reports requires two steps to group or summarize records: sorting the 
records and grouping the records once they’ve been sorted. Each task is han-
dled separately so that it can be taken care of quickly and efficiently by the tool 
best suited for the task.

Sorting records is a process easily handled by your SQL Server. For this rea-
son, Crystal Reports dumps the first half of the grouping process to the Server. 
The Server quickly sorts the records and returns the sort results to Crystal 
Reports.
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Once records are sorted, CRW can quickly group the sorted information before 
displaying the final report. For this reason, you will never see anything in your 
SQL queries corresponding to the grouping process. If you have created a 
group in your report using Insert/Group Section , Insert/Summary , or Insert/
Subtotal , your SQL query will contain code that sorts the records for that 
group, but it will not contain code that groups the records. For example, if your 
report groups records by the value of the state field in the table mytable, you 
will see code similar to the following in your SQL query:

SELECT
 mytable.state
FROM
 database.mytable mytable
ORDER BY
 mytable.state

The code ORDER BY mytable.state sorts the values in the state field but does 
not group them. When the SQL Server is finished sorting the records, they are 
returned to Crystal Reports where they are actually grouped.

Sorting

Records

Crystal Reports uses the following code to have your SQL Server sort records:

SELECT
 atable.state
FROM
 database.atable
ORDER BY
 atable.state

The ORDER BY clause sorts the data in a particular field.

Groups

Your Crystal Reports does not off-load group sorting to the SQL Server. Crystal 
Reports handles this task itself. You will not see any code in your SQL query to 
sort groups in your report.
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Selection queries

Selecting records

As the SQL Server selects which tables to include in your report and which 
fields to include from those tables, it can also select which records are 
included. If your report includes a record selection formula, Crystal Reports will 
add information to the SQL query to indicate which records are to be included. 
For example, if your record selection formula (as it appears in the Formula Edi-
tor) looks like this:

{atable.state} = “CA”

your SQL query will look like this:

SELECT
...
FROM
...
WHERE
 atable.state = ‘CA’

Selecting records with “Like”

When the Like function is used to select records to be included in your report, 
Crystal Reports translates the Like function into a SQL LIKE clause. For exam-
ple, if your record selection formula looks like this:

{atable.name} like “Smith?*”

your SQL query will look like this:

SELECT
...
FROM
...
WHERE
 atable.name LIKE ‘Smith_%’
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Selecting groups

Crystal Reports must select groups according to any Group Selection formulas. 
Since grouping is handled by Crystal Reports during the second pass, select-
ing groups must also be handled by Crystal Reports. Your SQL queries will 
never reflect any Group Selection formulas in your reports.

" For more information regarding the SQL language, refer to the documenta-
tion that was provided with your SQL Server.
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Setting SQL Defaults

Crystal Reports enables you to speed up the SQL table selection process by 
setting SQL defaults via the File|Options command. Once your defaults are set, 
you can bypass one or more dialog boxes on the way to selecting a SQL table 
for use in a report. You have the following options available to you:

� Server Type scroll box
Use the Server Type scroll box to preselect a server type. Use the scroll 
arrow and select a server from the scroll list. If you want to log onto that 
server, all you have to do is click OK, or press enter.

� Skip Server Type dialog
This checkbox is a toggle. When you toggle the check mark on, Crystal 
Reports will bypass the Log On Server dialog box altogether. By default, 
the checkbox is toggled on.

" When you bypass the Log On Server dialog box, you no longer have 
the option to activate a non-SQL database for the report, or to activate 
a server other than the default server. Activate this option only if you 
plan to create all of your reports from a single server.

� Server Name edit box
Use this box to enter the name of the SQL server you want to log on to.

� Database edit box
Use this box to enter the name of the database you want to activate in the 
specified SQL server.

� User ID edit box
Use this box to enter the name you use to log on to the specified server.

� Dict Path edit box
When using Netware SQL, use this box to enter the path for the data dictio-
nary.

� Data Path edit box
When using Netware SQL, use this box to enter the path for the data files. 
Enter the requested login information and click OK when finished. Crystal 
Reports logs you onto the specified server and takes you to the Choose 
SQL Table dialog box.
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� Allow Reporting On
Use the options in this section to select the data you want to allow report-
ing on. The six reporting options are activated by checkbox toggle 
switches.

� Tables
When you toggle the check mark on, the program will report on user 
base tables. By default, the Tables checkbox is toggled on.

� Views
When you toggle the check mark on, the program will report on virtual 
tables. By default, the Views checkbox is toggled on.

� System Tables
When you toggle the check mark on, the program will report on system 
tables. These tables are typically used by the system administrator 
only but are available for use if you have the appropriate permissions. 
By default, the System Tables checkbox is toggled off.

� Synonyms
When you toggle the check mark on, the report will allow reporting on 
virtual tables that are available on some hosts. By default, the Syn-
onyms checkbox is toggled off.

� Stored Procedures
When you toggle the checkmark on, the program will allow reporting on 
the result sets from stored procedures if you are using SQL systems 
that support stored procedures.

� Prompt On Every Table
When you toggle the check mark on, the program will display the Allow 
Report On dialog box before it displays the Choose SQL Table dialog 
box. The Allow Reporting On dialog box enables you to specify the 
kinds of data you want to appear in the Choose SQL Table dialog box. 
All of the “Allow Reporting On” options from the SQL tab appear in the 
Allow Reporting On dialog box.
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� Table name Like
This option enables you to use the SQL LIKE function to specify the 
kinds of table names you want to appear in the Choose SQL Table dia-
log box You can use the underscore character (_) or the percent sign 
character (%) as wildcards with this function. The underscore charac-
ter specifies any single character while the percent sign signifies any 
character string. For example, DAV_ matches DAVE only, while DAV% 
matches DAVE and DAVID.

Table name Like C% would display only those tables that have a table 
name beginning with the letter C (state.Companies but not com-
pany.Employee).

� Owner Like
This option works exactly like Table name Like except you use the LIKE 
function to select the Owner (or Creator or Alias) of the table, not the table 
name itself. For example Owner Like C%  would display only those 
tables that had an owner beginning with the letter C (company.Employee 
but not state.Companies).

Set the SQL options that best fit the way you work.
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Product Support

Crystal Reports is a very powerful report writer for the Windows environment. 
Crystal Services is proud of the quality of the product and has spent a great 
deal of time trying to make it intuitive to use. If, however, there is something 
you can't figure out how to do, we suggest you consult the extensive Crystal 
Reports on-line Help System. The Help System can be accessed by Clicking 
on any Help Button, by depressing the F1 key, or by choosing help from the 
main Crystal Reports menu. The help system contains most of the information 
from your User's Guide and includes numerous examples. If you still cannot 
find an answer to your question, we suggest you consult your User's Guide. 
That guide includes an extensive index to help you find the topic of interest. 
Should you have questions that cannot be answered through the use of help or 
the users Guide, the following alternatives are available for contacting Crystal 
Services directly.

Free online bulletin board support

Crystal has been supporting Crystal Reports and its predecessor products for 
many years. In the process, it has developed a number of support resources 
that are available on a free bulletin board system (BBS).

The BBS offers solid support of Crystal Reports for Windows. In addition, the 
BBS provides easy access to other related information and a direct line to 
Crystal for various requests you might have.
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The power of BBS support is in its ability to accept, via the phone lines, the 
very files you are seeking support for. You can upload your report definition 
files (*.RPT) onto the BBS along with the description of your problems. One of 
our Customer Support Reps will address the problem and send back the solu-
tion through the BBS system. your message will be dealt with as quickly as 
possible. All you need is a modem to get started with this valuable service.

Crystal Bulletin Board (604)681-9516

Document fax back

If you have a fax machine, you can get technical and marketing documents 
from Crystal Services by calling (604)681-3450. Listen to the menu, select the 
documents you would like to receive, and enter your fax number. Crystal Ser-
vices will fax the documents to you automatically.

Crystal Document FAX Back (604) 681-3450

FAX support - FREE

Another efficient way to receive support on Crystal Reports is to FAX in your 
technical support request. To do this, first fill in the bottom part of the Technical 
Support Request form in the product. This form appears when you select 
Help|Technical Support Request from the Crystal Reports menu. When you 
have completed the form, click the Print button to print it.

FAX the completed form to us 24 hours a day, Monday through Saturday. After 
Crystal Support has had a chance to review your FAX, one of our support rep-
resentatives will respond to you by return FAX.

Crystal FAX Support (604) 681-7163
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Mail-in support - FREE

If you would prefer, you can also contact us by mail with written questions or 
comments, and we will respond by return mail.

If you believe that your questions are such that we should review all of your 
related files (such as databases, etc.) to help solve your problem, then copy all 
of the related files and the Crystal Reports Report file (FILENAME.RPT) onto a 
diskette of any PC compatible format and send it to us. We will investigate the 
problem and mail back a response to you as soon as possible with your original 
diskette. Our mailing address is:

Crystal Services
4th Floor - 1095 West Pender Street
Vancouver, BC, Canada V6E 2M6

Telephone support

Registered users of Crystal Reports are entitled to free telephone support (sub-
ject to availability) for 60 days from the time of their purchase. Crystal tele-
phone support is available from 8 to 5, P.S.T. Before you call technical support, 
make sure you have done the following:

� Check the manual

� Check help.

Please have the following information available:

� Serial number

� Product name and version number

� Operating system you are using, i.e. Windows 95 or Windows 3.1 and 
whether you have a 16-bit or 32-bit version of Crystal Reports

� Version of other software (if required) - btrieve, sybase, paradox, etc.

� Technical Support Request form from product

� Network information if you are on a network

� Contents of autoexec.bat and config.sys files

� List of steps necessary to recreate the problem.

Telephone Number (604) 669-8379
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Extended technical support policy

Registered users may purchase an extended support policy which entitles the 
user to unlimited support from Crystal Services for a one year period. Support 
plan members will receive a special phone number which they can use to get 
directly through to the Technical Support team. Call for detailed information 
about this plan.
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Product Registration

When you use Crystal Reports for the first time, it will ask for your name, 
address, and related information. Then the product will suggest that you regis-
ter Crystal Reports with us to receive your product Serial Number. The pro-
gram will ask for the Serial Number the next time you run Crystal Reports. 
When you enter the Serial Number when the program prompts you to do so, 
you have completed the registration process.

You can register Crystal Reports using three different methods:

1. Fill out the Registration form that is built into Crystal Reports and then reg-
ister by modem using the Crystal Reports communications program. The 
procedure will register your copy of the program, assign a serial number, 
and enter that number automatically into your system.

2. Print the Registration Form that is built into Crystal Reports and then FAX it 
to us at (604) 681-5147. We will then FAX back to you a Serial Number 
that can be entered into the product the next time it asks for it.

3. Fill out the enclosed Registration Form and mail it to us. We will mail a 
Serial Number back to you so you can enter it into the product.

Registering Crystal Reports will ensure that you are kept up to date with all 
product advancements, and it will allow us to provide quality technical support 
to people that are properly registered with Crystal Services.

Registration FAX (604) 681-5147

Crystal Reports upgrade plan

If you would like to automatically receive upgrades to Crystal Reports, then 
purchase our Crystal Reports Upgrade plan. This will entitle you to receive free 
upgrades for one year for only $150.00 per year. You will automatically get 
upgrades shipped by UPS ground. (You can receive them by air, if you wish, at 
an additional expense.) This upgrade plan includes all product upgrades as 
well as any documentation changes during the year. If you want worry free 
software maintenance, then this is the plan for you.

Order Phone Line (604) 681-3435
Order FAX line (604) 681-2934
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Product RegistrationA
Product return policy

If you are not satisfied with Crystal Reports for any reason, you can return it to 
the original place of purchase for a refund within 30 days of the purchase date.

Product replacement policy

If the Crystal Reports diskettes or documentation are defective, then please 
contact Crystal Services within 30 days of the purchase date. FAX the descrip-
tion of the problem and we will solve it as quickly as possible. Please FAX the 
description of the defect to (604) 681-2934.
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License Agreement and Limited WarrantyA
License Agreement and Limited Warranty

This is a legal agreement between you the purchaser and Crystal Computer 
Services, Inc., herein referred to as Crystal. By opening the sealed software 
package and/or by using the software, you agree to be bound by the terms of 
this agreement. If you do not agree, promptly return the software diskette(s) 
and documentation and accompanying items in resalable condition to the place 
you obtained them for a full refund.

1. Limited License .

� You are purchasing only a single copy of the software, and are acquir-
ing no rights to the software itself except the limited license granted 
herein. 

� Except as stated in 1(c), Crystal grants you a limited license to use one 
copy of the software on a single computer. You may access the soft-
ware from a hard disk, over a network or by any other method you 
choose, strictly according to the terms hereof. 

� For additional users to use the software on the network you must 
acquire network packs, which will allow additional designated users in 
numbers and on terms specified by the documentation accompanying 
the software. You may have as many copies of the software in use on 
the network as is specifically authorized in the documentation. If you 
are acquiring the Crystal Server, 5 designated users may be set up to 
use the software. To configure additional users you must acquire addi-
tional Crystal Report Managers, each of which allows the addition of 
users as authorized in the accompanying documentation. 

2. Copyright.  Crystal owns all title to the software and its copyright, which 
are protected by copyright law and international treaty provisions. There-
fore, you must treat the software like a book or musical recording or like 
any other copyrighted material and make no copies except that you may 
make one archival copy of the software as a backup or transfer it onto a 
computer to be used.
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License Agreement and Limited WarrantyA
3. Other Restrictions. You may not rent or lease the software. Unless this is 
a “Not for Resale” product, you may transfer the software and accompany-
ing materials provided you retain no copies and the recipient agrees to the 
terms of this agreement. If the software is an upgrade you may use or 
transfer it only in conjunction with the prior version of the software. Any 
export of the software or its technical data from the United States may be 
restricted by U.S. export control laws, and accordingly you must comply 
with such laws before engaging in any such export. 

4. Limited Warranty.

� Crystal warrants the physical diskette(s) and physical documentation 
to be free of defects in materials and workmanship for a period of 60 
days from the purchase date. If Crystal receives notification within this 
warranty period of any such defects and such notification is deter-
mined to be correct, Crystal will replace the diskette(s) or documenta-
tion.

� Crystal’s entire liability for any breach of this limited warranty is limited 
to replacement of defective diskette(s) or documentation and does not 
include or extend to claims for any other damages, including but not 
limited to loss of profits, data or use of the software, or special, inciden-
tal, or consequential damages or other similar claims, even if Crystal 
has been specifically advised of the possibility of such damages. In no 
event will Crystal’s liability for any damages to you or any other person 
ever exceed the lower of suggested list price or the actual price paid 
for the software, regardless of the form of the claim.

� CRYSTAL SPECIFICALLY DISCLAIMS ALL OTHER WARRANTIES, 
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO, ANY 
IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE.                                                  
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License Agreement and Limited WarrantyA
5. Runtime Software. If this software includes a Runtime package, Crystal 
also grants you a limited license to reproduce and distribute exact copies 
of the Runtime software, and to modify, reproduce and distribute the sam-
ple applications made from the original disks in this package (or a set of 
backup copies made directly from them), but only if all of the following con-
ditions are satisfied: (a) you may distribute such copies solely for the pur-
pose of executing specific-purpose application programs written using an 
authorized copy of Crystal Reports; (b) you remain solely responsible to 
anyone receiving such copies for any support, service, upgrades, and 
technical or other assistance; (c) you may not use Crystal’s name, logo, or 
trademark to distribute your product; (d) you may not alter, disassemble, 
decompile or reverse-engineer the Runtime software; (e) Crystal makes no 
warranty other than the limited warranty provided in this agreement to the 
original purchaser; and (f) you will indemnify Crystal against any claims or 
liabilities arising out of its use, reproduction or distribution, and the use by 
the recipients of copies made thereunder. You may not include the Runt-
ime software or custom applications in any general-purpose report writing 
and/or database querying product, or any other product that is generally 
competitive with Crystal Reports. If you wish to distribute copies of the 
Runtime software or custom application on other terms, please contact 
Crystal directly. NOTE: Please check the manual of your development 
tools to see if there are additional tool-specific requirements. If this is a 
“Not for Resale” product, there is no runtime license included , and you 
may not distribute the Crystal Reports’ Report Engine Runtime, including 
but not limited to CRPE.DLL and CRW.EXE files. 

6. Governing Law.  If you acquired this product in Canada, this Agreement is 
governed by the laws of the Province of British Columbia, Canada and 
each party irrevocably attorns to the exclusive jurisdiction of the courts of 
the Province of British Columbia. If you acquired this product in the United 
States or elsewhere other than Canada, this Agreement is governed by the 
laws of the State of California and each party irrevocably submits to the 
exclusive jurisdiction of the courts of the State of California.

Restricted rights legend

Use, duplication, or disclosure by the U.S. Government is subject to restrictions 
as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Com-
puter Software clause at DFARS 252.227-7013. Crystal Computer Services 
Inc., 1095 West Pender St., 4th Floor, Vancouver, B.C., Canada V6E 2M6. 
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